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Installation and maintenance of licenses

Online activation of  a license
O n l i n e  a c t i v a t i o n  o f   a  l i c e n s e

In order to use EasySIGN software, you need to obtain at least one license. Licenses can be bought from a reseller
and at our web shop.  A license is provided as a ticket. A ticket is a 29 character long string consisting of 5 groups of
alphanumerical characters separated by hyphens, for example: "ABC01- ABC01- ABC01- ABC01- ABC01".

Your computer needs to have an internet connection in order to activate the license.

If you plan to activate a license offline (so your system is not connected to the internet), please consult "Offline
activation" first.

Once you have acquired a ticket, you can activate it by means of the license manager wizard. The license manager
wizard is shown the first time you start EasySIGN. You can also bring it up by selecting the menu "Help > Licensing
options". This will bring up a dialog showing all available licenses.

From here you can bring up the wizard by clicking the button "License Manager...":
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Press "Next" in order to start the activation process.

Here you have two options

1 I have a Product Voucher.
If you bought the license from a reseller your software box could contain a Product Voucher that will
look like the image below.
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You can use the number on this Product Voucher to obtain the ticket for the license you have bought.
You would use this option if you haven't got a ticket yet. If you want to use this option, select it and
press 'Next' to continue.

2 I have a ticket.
If you already have a ticket you would use this option. If you want to use this option, select it and press
'Next' to continue.

I have a Product Voucher

Press the button 'Activate Product Voucher' (1). This will open a browser and the web page where you can activate
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your Product Voucher.
When you have activated your 'Product Voucher' and received your ticket (by email), press next to continue.

I have a ticket

Ticket based license activations are supported by (1) and (2). Offline activation is possible with (3) the latter is
described in section "Offline activation". The two choices in (1) and (2) tell EasySIGN how the newly installed
license will be bound. 

1 The license will be bound to your pc. This means that you can only use the software on that pc.

2 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

Pick the choice that is appropriate for you and press "Next".
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Here you can enter the ticket. By default the full textbox is selected allowing you to simply cut and paste the ticket.
Be careful to avoid leading and trailing white space characters.

Once you have verified that the ticket has been entered correctly, press "Next".
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The installation of a new license can take a while, so please be patient. Upon success you will see the above depicted
message. When you restart EasySIGN your newly added license will be activated. If your license could not be
installed consult section "Troubleshooting" for help.

Offline activation
O f f l i n e  a c t i v a t i o n

If the computer on which you want to use EasySIGN is not connected to the internet, you can choose for an offline
activation. Please be aware that an additional cost may be involved in an offline activation process. 
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On page 2 of the license manager choose "Offline activation (not recommended)" (3) and press "Next".

Choose the second option "I don’t have a license file yet" and press "Next".
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The choice between (1) and (2) tells EasySIGN how the newly installed license will be bound. 

1 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

2 The license will be bound to your pc. This means that you can only use the software on that pc.

In addition to the mentioned choice, you also need to specify a filename. This filename will be used by the license
manager in order to generate a file that will contain information with respect to the choice you made on this page. The
filename will typically be called "context.WibuCmRaC". Once you have made your choice, and provided a valid
filename, press "Next".
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You need to send the file generated to EasySIGN. This can be done by email, for example on another computer that
has an internet connection and e-mail, or by sending us an USB stick containing the generated file. Together with this
file, you need to specify which license you require. If you are not sure which license would be best for your purposes,
you can contact us trough the contact page on our website. Make sure you provide us with a return address.

When we receive the context file in good order we will generate a so-called license file and ship it back to you. The
license file will typically be called "update.WibuCmRaU". In order to install this file, you need to start the license
manager again.



15EasySIGN

Select "Offline activation (not recommended)" (1) and press "Next". 

Select "I already have a license file" (1) and press "Next".  

Here you need to provide a filename. This is the name of the file that EasySIGN shipped to you. Select it and press
"Next".
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Upon success you will see the above displayed message. When you restart EasySIGN your newly added license will
be activated. If your license could not be installed consult section "Troubleshooting" for help.

Understanding and using the License dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  L i c e n s e  d i a l o g

The license dialog provides an overview of all valid licenses (with the possible exception of the build license) on your
system. Select the menu "Help > Licensing options" to show this dialog.

Each entry in the listbox (1) window represents a license visible on your system. If a license is visible in this dialog, it
means it is considered to be valid. One exception to this rule is the build license:

A build license limits the build version of the software that can be used.  This is done by comparing the build date of
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the software with the expiration date of the build license. If the build date is too new, so it is newer than the expiration
date of the build license, then the build license is said to be invalid. The user will be informed of this fact at startup
after which all licenses will be disabled. Do not confuse a build date with the current date: A build license with an
expiration date in the past is still valid as long as the build date is in the past of the expiration date of the build
license. 
A build license is derived from a support license. All web shop products come with some support. The expiration date
of the support license is identical to the expiration date of the build license. In the example above the build license is
visible as the first entry in the listbox. It is valid since its expiration date of June 26 2010 is more recent than the build
date of May 1sth 2010.

The license dialog has 4 buttons

2 Close. With this you can simply dismiss the license dialog.

3 License manager wizard. With this you can bring up the license manager wizard as described in previous
sections.

4 Ticket manager. This dialog is used to extend subscriptions as will be described in the next section.

5 Web shop. This will open a web browser with a link to our web shop for your convenience.

In the lower left corner a checkbox (6) is visible. Licenses that are invalid will be collected and shown to you at
startup by an invalid license dialog (see "Understanding and using the expired license dialog"). Uncheck this
box if you do not wish to be informed of expired licenses.

Understanding and using  the Ticket Manager
U n d e r s t a n d i n g  a n d  u s i n g   t h e  T i c k e t  M a n a g e r

Licenses are said to have recently expired if their expiration date is within 30 days of the current date. These licenses,
although technically invalid, are still considered to be valid by the software: they are in a so-called grace period of 30
days. A grace period of 30 days will provide you with ample time to continue any subscription you might have without
losing the functionality of the software. 

The ticket manager presents you with a list of licenses that are within a grace period of their expiration date. If these
licenses are part of a running subscription, then they can be extended by means of this manager.
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In listbox (1) you will see an overview of all licenses that recently expired. In the above shown example we see that
two licenses have expired: "Support complimentary" and "Master subscription".  In listbox (2) you are presented with
a list of tickets that have been installed in the past. Selecting one or more licenses in listbox (1) results in the
selection of all relevant tickets in listbox (2). Textboxes (3) and (4) provide you with more information with respect to
a selected license and ticket respectively. Once you are confident that the right ticket(s) has/have been selected, you
can extend your subscription by pressing "Renew" (6). In textbox (5) you will be notified whether the extension was
successful or not. The next example shows a successful extension:

Notice that the licenses in listbox (1) are updated to reflect the new status after the successful extension. You do not
need to restart the software in this case.

The button "Remove" (7) can be used to remove tickets from listbox (2). You can use this to remove old tickets that
you will not extend. It is perfectly safe to remove a ticket. Removing a ticket does not result in the loss of licenses,
nor does it result in the cancellation of any subscriptions you might have. If you remove a ticket of a running
subscription by accident, you can use the license wizard to enter it again. The license wizard itself can be activated
from this dialog by pressing the button "License wizard" (8). You can also enter the web shop by pressing the button
"Online webshop" (9).

Understanding and using the expired license dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  e x p i r e d  l i c e n s e  d i a l o g

Licenses that are expired, and which are no longer within a grace period of the current date, will no longer be
considered to be valid by the software. The software will collect these licenses and report them to you in an expired
license dialog.
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Each entry in listbox (1) of this dialog represents an invalid license. If you do not intend to extend the expired license
and you also do not want to see this dialog each time you start the software, you can suppress it by one of the
following two methods:

1 Notice that there is a checkbox (2) in the lower left corner of the dialog. By checking this checkbox you
prevent the software from reporting expired licenses to you. You can turn this checkbox off again by
selecting the appropriate checkbox on the "License dialog".

2 (recommended) You can select the license that is expired and explicitly hide it by pressing button
"Hide" (3).  This will make sure that the tool will no longer  warn you about this specific license. The hide
action is license and date specific: if you install a newer license that also expires, the tool will once more
warn you about this expired license until you hide this license as well.

Troubleshooting
T r o u b l e s h o o t i n g

In this section you will find the most common issues that can occur during activation of your license.

EasySIGN does not start. I just see a dialog with an error message
EasySIGN software is protected by an anti-piracy shield. This shield will only start EasySIGN if certain conditions are
met. The error message you see is most likely generated by this shield. Here are the most common failures you
might encounter:

EasySIGN communicates with a separate license server that runs locally on each machine on which EasySIGN
software is installed. This license server, named CodeMeter server, must be running as a service. If the CodeMeter
server somehow got terminated, it will not restart automatically as a service. Rebooting your system should restart
the CodeMeter server as a service.
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The version of the CodeMeter server running  on your system is outdated. This could happen if you e.g.  install
software that is using an older version of CodeMeter. Re-installing EasySIGN should fix this problem.

Axprotector itself requires a license. This license is shipped with the software. It is installed the first time you start the
software. The license itself is persistent to uninstalling and re-installing EasySIGN. So, losing this license is very
unlikely. However, if this license does somehow get deleted, it cannot be installed a second time. Therefore, in
addition to the original license, we ship one backup license with our software in case the original license gets deleted.
If this license also gets deleted you need to contact us in order to acquire a new one.

The shield itself was not able to provide more information about the problem. If you contact EasySIGN have the
following information available: The serial number of your software "Windows Start button > EasySIGN VX > Tools >
ContainerID" or in the software itself select the menu "Help > Container ID". We will also ask you to email us the
resulting file generated by a tool called VersionInfo ("Windows Start button > EasySIGN VX > Tools > VersionInfo"):
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If you see this message, or a message similar to this, your installation of EasySIGN software is corrupt due to missing
DLL files. Reinstall the software.

I cannot bring up the license manager
The license manager is a standalone executable that resides in the same directory in which EasySIGN is installed. It is
named "LicenseManager.exe". If this executable is missing, you need to re-install EasySIGN.

The license manager generates the following error:

Could  no t conta ct the  e x te rna l lice nse  se rv e r
Make sure your computer is connected to the internet. If your computer is connected to a proxy, make sure that the
default (login) credentials allow access to this proxy. Contact your IT department to make sure that this is set up
correctly.

Com m unica tion with  the  e x te rna l lice nse  se rv e r  fa ile d
This is caused by a communication failure between the license server and the license manager. Make sure your
internet connection is setup properly.

Your  ticke t is  no t v a lid
Make sure that your ticket is correct. It is easy to make a mistake if you are manually typing in the ticket. If possible,
try to cut and paste the ticket in order to avoid mistakes.

T he  products  in  th is  ticke t a re  no t com pa tib le  with  y our  ins ta lla tion. T he  m ost like ly  ca use  is  tha t y our
insta lla tion a lre a dy  conta ins  a ll the  products  cov e re d  by  th is  ticke t.
EasySIGN does not allow you to install the same product (license) twice or more on the same computer, or the same
dongle. This is done for your protection. Installing a license twice does not add any additional functionality, nor does it
allow you to start the software multiple times. Make sure that you are installing the ticket on the appropriate
computer, or on the appropriate dongle.

Your  ticke t ha s  a lre a dy  be e n a ctiv a te d
The ticket has already been activated before. You cannot activate it again, unless it is part of a subscription. If case of
the latter, you are trying to activate it too soon; you have to wait until the licenses contained by the ticket enter their
grace periods. The ticket manager (see "Understanding and using the Ticket Manager") will warn you when this
happens.

Unknown e rro r
This is most likely caused by an intermittent communication failure between the license server and the license
manager. Make sure your internet connection is setup properly.
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Could  no t find  a ny  dong le . Ple a se  v e r ify  tha t y our  dong le  is  conne cte d .
You must have selected "I have a ticket and a dongle" on page 2 of the license wizard. The license wizard could not
detect any dongle on this computer.
Important:
Please be aware that you cannot reuse the dongle of version 5 and earlier.

T he re  a re  m ultip le  dong le s  a tta che d  to  y our  sy ste m . T he  lice nse  m a na ge r  re quire s  tha t only  one  dong le
is  a tta che d  to  y our  sy ste m . R e m ov e  a ll dong le s , e x ce pt fo r  the  dong le  on which y ou wish to  ins ta ll the
lice nse .
You cannot have more than one dongle connected to the system during the installation of a new license. You can have
multiple dongles connected during normal operations, but only if at most one of these dongles contains EasySIGN
licenses.

Som e  file s  a re  m iss ing: <lis t o f m iss ing  file s>.
Please reinstall the application.
The license manager detected a corrupt installation of your software. Please re-install EasySIGN.

T he re  is  a  prob le m  with  y our  Code Me te r  se rv ice . Ple a se  re boot y our  com pute r .
The license manager detected a problem with your local CodeMeter license service. Please reboot your computer in
order to reset this service.

EasySIGN starts, but I get a warning/error message.
T he  re le a se  da te  o f the  progra m : <da te 1> is  ne we r  tha n the  e x p ira tion da te  o f y our  build   lice nse :
<da te 2> [E200]
The build date of the executable is too new. You do not have the rights to run this executable. You can either revert to
an older version of the software, or you can buy additional maintenance in the web shop. The setup of our software
normally prevents you from running into this problem, since it verifies that your build license (derived from
maintenance) allows you to run the software. However there are a couple of scenarios in which you can still manage
to trigger this problem. For example, you might have  installed a TryBuy license, after which you upgraded to a newer
version of the software. The TryBuy licenses are only temporarily available to you, and at the end of the TryBuy
period these licenses are deleted.

Only  one  dong le  ca n be  bound  to  the  Ea sy SIGN so ftwa re  on th is  com pute r . Ple a se  re m ov e  the  e x tra
dong le  (s).
You can have multiple dongles connected to your computer, but only one of these dongles may contains EasySIGN
licenses.

I just installed a new license by means of a ticket, and now all my licenses are gone.
Unless you installed a Move license, your licenses are most likely still available on your computer. Reboot your
computer. If the problem persists, contact EasySIGN and have your serial number readily available.

EasySIGN

Introducción

Bienvenido a EasySIGN.

Convenciones de EasySIGN
C o n v e n c i o n e s  d e  E a s y S I G N  

Antes de empezar a trabajar con EasySIGN es importante que conozca la terminología utilizada en este manual.

Menú
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 La barra horizontal en la parte superior de la pantalla es el menú y contiene comandos como “Archivo” y “Editar”.  Si
hace clic en algunos de estos comandos, aparecerá lo que se conoce como un “menú desplegable” a partir del cual
podrá seleccionar otras opciones como “Nuevo”, “Guardar”, etc. Haciendo clic en uno de estos comandos se activará
la opción elegida.

Menú desplegable oculto

 De hecho es el mismo que el menú normal, sólo que el menú desplegable oculto no se hace visible hasta que se
utiliza el botón derecho del ratón haciendo clic sobre un objeto u hoja de trabajo.

Cursor

 El cursor es la “Flecha” visible en pantalla que se mueve al mover el ratón.

Cuadro de Diálogo

 Un cuadro de diálogo es una ventana que permite modificar parámetros.

Hoja de Trabajo
 La hoja de trabajo es la parte central del programa en la que se realizan los diseños o dibujos.

Ventana Activa
 Es la zona completa en la ventana que queda dentro de las reglas y barras deslizantes. Esto incluye la hoja de
trabajo y la zona que la rodea.
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Botones

 Cuando aparece el siguiente texto “ Haga clic en el botón Aceptar”, se le está pidiendo que utilice el botón izquierdo
del ratón para hacer clic en “Aceptar”.

Opciones

 Una opción es un cuadro de diálogo activado si el cuadro frente a la opción está marcado o si el círculo frente a la
opción está en negro.

Teclado

 Si utiliza el teclado para ejecutar comandos, “Ctrl+S" significa que debe pulsar y mantener pulsada la tecla Control y
pulsar la tecla “S”.

Ratón

 EasySIGN utiliza ambos botones del ratón, siendo el botón izquierdo el botón principal del ratón.

Soporte del producto
S o p o r t e  d e l  p r o d u c t o

 Si tiene alguna pregunta sobre EasySIGN, por favor consulte este manual. Si aún así no puede solucionar el
problema, póngase en contacto con el proveedor. 

 Al llamar al proveedor, asegúrese de estar cerca del ordenador y tener toda la documentación importante a mano.
Asegúrese también de poder responder a las siguientes preguntas:
 ¿Cuál es el número de serie de su versión de EasySIGN?
 ¿Qué versión de programa tiene?
 Apunte cualquier mensaje de error que aparezca en pantalla o utilice la combinación del teclado “Alt+Imprimir
Pantalla” para imprimir un mapa de bits del diálogo que contiene el mensaje de error.
 ¿Qué ha ocurrido y que estaba haciendo cuando ocurrió el problema?
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 ¿Ha intentado solucionar el problema?, si es así ¿Cómo?
 ¿Qué versión del programa tiene?
 ¿Qué equipo de impresión tiene conectado al sistema?
 ¿Tiene instalada alguna tarjeta especial en el ordenador?, si es así ¿Qué tarjeta?

La pantalla de EasySIGN
 L a  p a n t a l l a  d e  E a s y S I G N  

Cuando haya puesto en marcha el programa se mostrará la siguiente pantalla. Las zonas de la pantalla más
importantes se explicarán en detalle más adelante.

1 Barra de títulos
En la barra de títulos encontrará el nombre del programa seguido del nombre del archivo que acaba de abrir.
También hay varios botones en la barra de títulos. 

2 Barra de Menú
 En la barra de menú encontrará los nombres de los diversos menús. Cada menú a su vez contiene varios

submenús con los comandos del programa.

3 Barra de herramientas
 Esta barra contiene los comandos del menú utilizados con mayor frecuencia; estos pueden controlarse

haciendo clic en el botón correspondiente. La barra (como todas las barras a este nivel) puede ser pegada o
arrastrada del menú.
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El programa contiene muchas de estas “barras de herramientas flotantes”. Estas barras de herramientas se
llaman “flotantes” porque cuando las utiliza podrá continuar editando la hoja de trabajo, a diferencia de los
diálogos.

4 Caja de herramientas
 La caja de herramientas contiene las operaciones utilizadas con mayor frecuencia. Sólo tendrá que hacer clic

en el botón de la herramienta para activar la operación. La tecla TAB es una tecla de atajo que le permite
cambiar entre la barra seleccionada por última vez y la herramienta de selección (La flecha).

5 Reglas 
 Las reglas están localizadas a la izquierda y en la parte superior de la hoja de trabajo del programa. Estas

reglas proporcionan una idea de la localización y tamaño de los objetos contenidos en la hoja de trabajo.

6 Barras de desplazamiento
En la parte inferior y derecha de la hoja de trabajo verá dos barras de desplazamiento. Estas barras le
permiten desplazarse por la hoja de trabajo horizontalmente y verticalmente en pantalla. 
Si desea mover la pantalla puede también pulsar la barra espaciadora, el cursor del ratón cambiará como se
indica a continuación.

Moviendo el ratón (con la barra espaciadora pulsada y haciendo clic y manteniendo pulsado el botón izquierdo
del ratón) podrá mover también la hoja de trabajo.

7 Barra de estado
La barra de estado está localizada en la parte inferior de la pantalla y da información sobre el objeto
seleccionado.

8 Hoja de trabajo
La zona blanca de la pantalla es la hoja de trabajo. La hoja de trabajo está representada por un cuadrado con
una tira de papel perforado a ambos lados. Las tiras de papel perforado se utilizan para indicar la orientación
del dispositivo de salida. 

Trabajando con EasySIGN

Instalación de EasySIGN

Incluso para el usuario más inexperto la instalación de EasySIGN es un procedimiento sencillo y sin complicaciones.
Consulte el manual de instalación.

Desinstalación de EasySIGN

Para eliminar EasySIGN del ordenador elija el comando “Desinstalar EasySIGN” del grupo de programas EasySIGN
(en el menú “Inicio”, “Programas”, “ EasySIGN” de Windows).

Puesta en marcha de EasySIGN
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Cuando haya ejecutado el programa de configuración (Setup), se mostrará el grupo de programas “EasySIGN" en el
menú “Inicio” de Windows, “Programas”. Éste grupo de programa contiene además el icono de EasySIGN. Haciendo
clic en el icono se pone en marcha el programa EasySIGN .

Interface

EasySIGN Application Look
E a s y S I G N  A p p l i c a t i o n  L o o k

The first time you run the software it will be using the default Application look. This look is highly optimized to be as
less distractive as possible. It uses a neutral color and easy to recognize icons. 

If however you feel more comfortable with a different look this is very easy to change.
Select the menu 'Vie w > App lica tion Look > x x x' where 'xxx' stands for a long list of different looks to choose
from. No restart is necessary so just select them one by one until you find the one you like best.
 
The last selected look is the one the software will be using with each new session until you change the look again.   

MDI tabs
M D I  t a b s

The first time you run the software it will be using MDI tabs.

MDI tabs have several advantages over old style MDI windows.
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1 Very easy navigation between documents.

2 Preview of every worksheet in the Windows 7 taskbar. 

3 Context menu with several useful options.

Manage the MDI tabs
To manage the MDI tabs right click on an empty space of the worksheet and select the command 'Interface'.

This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.



29EasySIGN

1 Switch the tabs on or off.

2 Choose if and where you want a close button on the tabs.
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3 Choose the style of the tabs.

4 Tabs on top or on bottom.

5 Every tab its own color.
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6 Document icons displayed on tabs.

7 Document menu.

8 Drag tabs to a different location.

9 Each tab has its own context menu.

Customize toolbars
C u s t o m i z e  t o o l b a r s

You can customize existing toolbars and even create your own.

Right click on the menu and select from the context menu the command 'Customize'.
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This will open the following dialog.

1 Make sure that you have the 'Toolbars' tab selected.

2 Existing toolbars.

3 Reset the selected toolbar to its original state.

4 Reset all toolbars to their original state. this will also delete any custom toolbar.

5 Create a new toolbar.

6 Rename a toolbar. Only possible on your own toolbars.

7 Delete a toolbar. Only possible on your own toolbars.

Click on 'New...' (5).

Give the new toolbar a name
and click on 'OK'.
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This will create a small empty
new toolbar.

Click on the tab
'Commands' (1). From the
'Categories' list (2) on the left
select the menu you want to
use. From the 'Commands'
list (3).

On the right drag the
commands you want to use to
the new toolbar.

When you are done close this
dialog.

Your new toolbar is ready to
use.
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Create tools
C r e a t e  t o o l s

You can create links to other software (tools) which are automatically displayed in a menu.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.

Make sure that you have the 'Tools' (1) tab selected and click on the button for a new entry (2). 
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Enter 'Notepad' in the field that appears (3).

Enter the path and name of the executable in the 'Command' field (4), or use the browse button (5) to browse to the
executable. When you are done click on 'Close' (6).
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Select the menu 'File  > T oo ls  > x x x' where 'xxx' stands for the tool you have added.

Customize shortcut keys
C u s t o m i z e  s h o r t c u t  k e y s

You can create your own Shortcut Keys and they will even appear in the menus.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Keyboard' tab selected.

2 Category, here is where you select the menu.

3 Accelerator, make sure this is set to default.

4 Commands, the commands in the menu you have selected under 'category' (1).

5 Current keys, the current assigned key (if any) to the command you have selected under
'Commands' (4).

6 Assign the shortcut Key you have typed in the field 'Press new Shortcut Key' (9).

7 Remove a Shortcut Key.

8 Reset all shortcut Keys to their default values.

9 Type/Press the Shortcut Key as you will use it.

Example
Let's add a Shortcut Key to the command 'Quick connect' from the 'Arrange' menu.

As you can see in the menu, there is no Shortcut Key assigned to this
command.

Select from 'Category' (2) the menu 'Arrange'.
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Select from 'Commands' (4) the command 'Quick Connect'.

Set your cursor in the field 'Press new Shortcut Key' (9). Press and hold on
your keyboard the Control key and then the '1'.

The button 'Assign' is now enabled, click on it to assign the new Shortcut
Key.

The new Shortcut Key is now assigned to 'Quick Connect'. Press 'C lose' to
close this dialog.

If you now go to the command 'Quick connect' from the 'Arrange' menu
you can see that the new Shortcut Key is also added to the menu.

Menu behavior
M e n u  b e h a v i o r

You can customize the menu behavior to your liking.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Menu' tab selected.

2 Make sure that 'Design doc' is selected.

3 Select the menu animation you want.

4 Check this if you want the menu to have shadows.

5 Use the 'Reset' button to reset all menu's to their original state.

Manage menu items
M a n a g e  m e n u  i t e m s

You can add or remove new commands to the existing menus, rearrange them and even create new menus.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.



40 EasySIGN

Make sure that you have the 'Commands' tab (1) selected.

Rearrange menu items
Now that this dialog is open you can start rearranging the menus. 

The image shows the current order of the top level menu items. Click on the 'File' menu and drag it behind the 'Help'
menu. 

The menu looks now like above. Drag every menu item to a different position.

Let's stop here and try something else.

Click on the 'Text' menu to open it and
select the command 'Case'.
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Drag the command 'Case' to the menu
'Arrange' and hold it above the menu
'Arrange' until this menu opens (don't let
go of your mouse button yet).

When the menu 'Arrange' opens drag the
command 'Case' just above the
command 'Group'. As you can see you
can even move commands from one
menu to another.

You can also drag commands from the dialog to the menus.

Under 'Categories' select
'Arrange' and under
'Commands' select and drag
'Group' to the 'Text' menu.

Create your own menu
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In the dialog select under
'Categories' the item 'New
menu' (1).
 

Under 'Commands' select and
drag the command 'New
menu' (1) to the right of the
main menu, just after
'Text' (remember, we have
rearranged all the menu
items).
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Right click on the new menu
item and select the command
'Button Appearance...' (1).

In the field 'Button text' enter
a name for the menu item.

Start selecting menus in the
Categories (1) list and drag
commands from the
'Commands' (2) list to the
new menu.
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In no time you have created
your own 'Favorites' menu.

If you want to reset the
menus to their original state
just select the tab 'Menu' (1)
and press the button 'Reset' (
2).

Associate mouse double-click
A s s o c i a t e  m o u s e  d o u b l e - c l i c k

You can associate a mouse double-click on an empty space on the worksheet to a certain menu command.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Mouse' tab selected.

2 Make sure 'Worksheet' is selected.

3 Check the option 'Associate double-click event with'.

4 Choose the command of your liking (in our case this is 'FileOpen').

5 Click on 'Close' to close the dialog.

If you now double click on an empty space of the worksheet the File Open dialog will open.

Large icons
L a r g e  i c o n s

If desired you can change the size of the icons from all the toolbars.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Options' tab selected.

2 Check the option 'Large icons'.

3 Click on 'Close' to close the dialog.

On top the toolbox with standard
icons and on the bottom the
toolbox with large icons.

Arrange Interface
A r r a n g e  I n t e r f a c e

You can arrange the interface completely to your liking. Menu, Toolbars, Dockers etc. can be made floating, dragged
to a different docking location, closed or put in 'Auto hide' mode.
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If you for example want the Object manager and Color docker both visible at the same time just drag one of them
into the other. An advanced docker helper Wil help you getting them on the right place.

If you want the dockers hidden but instantly
accessible when you hover the mouse over
them, just put them in auto hide mode. Click on
the 'Auto hide button' (1).
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The dockers will hide themselves on the side
they were docked.

If you want to make them visible again, just
hover your mouse over the icons. If your mouse
leaves the dockers they will hide themselves
again.

Just play around to get comfortable with all the possibilities with the interface, you will be pleasant surprised.

Ribbon
R i b b o n

The first time you run the software it will be using menus. If you are a user that likes Ribbons like e.g. in Microsoft
Word™ you can easily change the interface to a Ribbon interface.

To change to the Ribbon interface right click on an empty space of the worksheet and select the command 'Interface'.

This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.
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Make sure that the tab 'Interface' (1) is selected and check the option 'use Ribbon interface (needs restart)' (2).

Click on 'OK' to accept the changes and restart the software.

The interface of EasySIGN is now a Ribbon interface that basically works the same as the Microsoft Word™ Ribbon.
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If for example you select the 'Effects' tab you have all the effects instantly at your disposal.

The same goes for the tab 'Text'.

Selecting the tab 'Create' gives you access to the drawing tools, import, export, Compatibility, insert objects etc.
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Just have a good look around and see what works for you, the Menu interface or the Ribbon interface.

Inicio y finalización del trabajo
I n i c i o  y  f i n a l i z a c i ó n  d e l  t r a b a j o

Hoja de trabajo nueva
Cuando se pone en marcha el programa éste siempre abre una hoja de trabajo nueva. Puesto que el programa es de
tipo MDI (Interface de Documentos Múltiples) podrá tener varias hojas de trabajo abiertas al mismo tiempo. 

Cómo abrir hojas de trabajo existentes

Para abrir una hoja de trabajo existente seleccione la opción “Abrir” en el menú “Archivo”. Aparece un cuadro de
diálogo en el que podrá buscar y seleccionar la hoja de trabajo.

Comandos deshacer

El programa recuerda qué tareas ha realizado en una determinada sesión. Si comete un error o si desea cambiar un
comando reciente, puede deshacerlo utilizando la opción “Recuperar” en el menú “Editar”. Los siguientes comandos
no pueden ser recuperados:

 Algunas operaciones con archivos, como “Abrir” y “Guardar”.
 La selección de un objeto.
 Los cambios en la visualización (aumentos, etc.).
 La colocación de líneas de construcción y el cambio de determinados parámetros.
 Las operaciones con las líneas de mosaico.
 El movimiento de marcas de registro especiales.

Al ir a “Archivo, Parámetros Generales” en el tabulador “General”, puede especificar el número deseado de
operaciones de “Deshacer”.

Inmediatamente después del comando “Deshacer”, se activa el comando “Cancelar Deshacer”. De esta forma podrá
deshacer los cambios nuevamente.

Deshacer

Tecla de atajo "CTRL+Z"

Rehacer

Tecla de atajo "CTRL+A"

Configuración de las preferencias 

Puede utilizar el comando “Parámetros Generales” en el menú “ Archivo” y el comando “Parámetros “ en el menú
“Ver” para registrar un determinado número de parámetros generales. Estos comandos permiten modificar las
propiedades de una hoja de trabajo, restablecer las propiedades de la rejilla y determinar las unidades de medidas
globales que desea que el programa utilice así como muchas otras cosas.

Cómo cerrar EasySIGN

Utilice el comando “Cerrar” en el menú “Archivo” para finalizar la sesión actual de EasySIGN. 

Visualización de la hoja de trabajo

EasySIGN tiene tres modos distintos de visualizar el trabajo.

Gráfico de líneas de dibujo 
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Esta opción muestra todos los objetos en la hoja de trabajo como gráficos de líneas de dibujo. Ningún objeto se
rellena y los objetos sólo pueden seleccionarse haciendo clic en los bordes de los mismos.  

Rellenado

Todos los objetos que tienen relleno se mostrarán como tales.

Alta calidad

Esta opción muestra todos los objetos con la máxima calidad posible.

Ventana redibujar

Si quedan recordatorios de las operaciones anteriores en pantalla, podrá redibujar la pantalla seleccionando la opción
“Actualizar” en el menú “Ventana”.

Tecla de atajo "F5"

 

Desplazamiento de la ventana activa 

Barras de desplazamiento 
Utilizando las barras de desplazamiento horizontal y vertical ubicadas en los laterales de la pantalla podrá ver zonas
de su dibujo que quedan fuera de la ventana activa.

Flechas de la barra de desplazamiento
Haga clic en la flecha de la barra de desplazamiento para mover la ventana en pasos pequeños, en la dirección
deseada. 

Barras
Haga clic en la barra para mover la ventana en pasos rápidos en la dirección deseada.

Bloque de la barra de desplazamiento
El bloque que aparece en la barra de desplazamiento puede ser arrastrado en dos direcciones. 

Arrastrar
Una forma diferente de desplazar la hoja de trabajo por la pantalla consisite en pulsar y mantener pulsada la barra
espaciadora. El cursor cambia como se indica a continuación:

Mantenga pulsada la barra espaciadora y haga clic en la hoja de trabajo. Mueva la hoja de trabajo hacia el lugar
deseado y a continuación suelte la barra espaciadora primero y a continuación el botón del ratón.

Herramientas de aumento
H e r r a m i e n t a s  d e  a u m e n t o

Si desea utilizar alguna de las opciones de aumento disponibles, haga clic en el siguiente botón de la barra de
herramientas.

Aparecerá un submenú con las siguientes opciones.
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Aumentar 
Cuando seleccione esta opción, el cursor cambiará como se indica a continuación. 

Ahora puede aumentar haciendo clic una vez o dibujando un rectángulo alrededor de la zona que desea aumentar. 

Reducir
Cuando seleccione esta opción el cursor cambia como se indica a continuación.

Puede reducir haciendo clic una vez en la hoja de trabajo. La posición sobre la que haga clic se moverá hacia el
centro de la ventana. 

Todo
Esta opción aumenta todos los objetos de la hoja de trabajo, al margen de que los objetos esten seleccionados o no.

Selección 
Esta opción aumenta solamente los objetos seleccionados.

Pagina
Esta opción sólo aumenta la hoja de trabajo.

Atrás 
Esta opción regresa a la última lista.

Organización y transformación de objetos

Datos Generales
D a t o s  G e n e r a l e s

El movimiento, duplicación y eliminación de objetos son las funciones básicas de cualquier programa. Como ocurre
con la mayoría de comandos de EasySIGN, se pueden ejecutar de dos formas. Arrastrando con el ratón o
introduciendo valores numéricos en un cuadro de diálogo. Algunos comandos pueden ejecutarse utilizando un atajo
con el teclado, por ejemplo el borrado de objetos con la tecla SUPR o la duplicación con el atajo de teclado
“CTRL+D”.

La opción “Duplicar” en el menú “Editar” se puede utilizar para copiar objetos. Esto le permitirá hacer una copia
exacta de un objeto. También puede utilizar el ratón para arrastrar el objeto, pero antes de soltar el botón izquierdo
del ratón se debe hacer clic una vez con el botón derecho. El programa duplicará entonces el objeto. Puede utilizar el
método anterior para dejar un duplicado de una línea guía.

Utilizando las características magnéticas de las líneas guía, puntos de anclaje en una grilla, podrá posicionar objetos
de manera rápida y precisa. Esta función exacta elimina la necesidad de aumentar mucho un objeto para obtener una
colocación exacta. 

Para reunir ilustraciones complicadas hay muchas otras formas de organizar objetos, como por ejemplo: centrado,
apilamiento y agrupación de objetos. 
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Movimiento de objetos
M o v i m i e n t o  d e  o b j e t o s

Movimiento con el ratón
El movimiento de objetos utilizando el ratón funciona de la misma forma que cuando se trabaja en un gráfico de
líneas de dibujo o color, con sólo una pequeña diferencia entre ambos modos de pantalla. Si está trabajando con
gráficos de líneas de dibujo deberá seleccionar siempre el objeto por alguno de sus bordes; Cuando trabaje en color
puede hacer clic en cualquier parte del objeto para seleccionarlo. De ahora en adelante sólo utilizaremos el término
selección del objeto y dejaremos que decida si prefiere trabajar con gráficos de líneas de dibujo o en color. En ambos
modos de pantalla se aplica lo siguiente: Cuando se posicione sobre un punto de anclaje con el ratón aparecerá un
cuadrado rojo indicando que puede seleccionar el objeto mediante este punto de anclaje (sólo si ha activado la opción
“Anclaje de puntos Magnético”).

Elija alguna de las herramientas de selección del objeto que desea mover.

Haga clic en el objeto para seleccionarlo y mantenga pulsado el botón del ratón.

Mueva el ratón a donde desea colocar el objeto. Con independencia de la forma del objeto cuando lo arrastre,
cambiará a un borde amarillo que muestra las líneas del borde del objeto subyacente. El cursor del ratón cambia a
una cruz que muestra las direcciones en las que puede moverse el objeto.
Cuando suelte el botón del ratón el objeto se habrá movido.

Si pulsa y mantiene pulsada la tecla Control durante el movimiento, el objeto podrá moverse en una línea horizontal
o vertical (dependiendo de la dirección en que se mueva).

Movimiento con valores numéricos

Atajo del teclado "ALT+F7"

Seleccione el objeto que desea mover de forma numérica.

Cuando el objeto haya sido seleccionado, haga clic una vez con el botón derecho del ratón. Aparecerá un menú
desplegable oculto.
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En el menú desplegable oculto seleccione la opción “Transformaciones”. Aparecerá un submenú. Seleccione la opción
“Posición”.

El diálogo de movimiento tiene varias posibilidades de introducción de datos.

Posición (1)
En este cuadro encontrará la posición horizontal, X y vertical, Y del objeto seleccionado.

Origen (2)
Los botones en este cuadro muestran el origen del objeto. En el diálogo anterior se pulsó el botón en la parte inferior
izquierda y en los campos X e Y aparecen los valores 100, 100. Esto significa que en la esquina inferior izquierda del
objeto está colocada a 100 unidades del borde izquierdo de la hoja de trabajo y a 100 unidades de la parte inferior de
la hoja de trabajo.

Salir del original (3)
Cuando se activa esta opción se mueve el objeto, dejando el original detrás.

Movimiento relativo (4)
Si selecciona esta opción, cambiarán los valores que hay en los campos X e Y. En el ejemplo siguiente suponemos
que el objeto tiene una anchura de 50 unidades y una altura de 50 unidades y está colocado en la parte inferior
izquierda de la página, en el punto cero.

 Seleccione las opciones “Salir del original” y “Movimiento relativo”.
2 Haga clic en el botón “Superior derecho” en el grupo “Origen”.

3 Para X e Y ponga los valores “50”.
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4 Haga clic en el botón “Aplicar”.
5 El resultado es el que se muestra a continuación.

 El objeto se ha movido un total de 50 unidades hacia arriba y a la derecha, dejando un original detrás.

Cerrar
Este botón cierra el cuadro de diálogo.

Aplicar
Cuando este botón está activo podrá utilizarlo para ejecutar los parámetros introducidos.

Movimiento con las teclas de flecha
En el menú “Archivo”, “Parámetros”, podrá utilizar el cuadro de diálogo correspondiente en el tabulador “General”
para determinar la distancia a la que desea que se muevan los objetos al utilizar alguna de las teclas de flecha. Ésta
opción es conocida como “Distancia Nudge”.

 

Sugerencias
S u g e r e n c i a s

Movimientos a tirones cuando se mueve el ratón
Cuando esto ocurre es probable que la característica magnética de la rejilla esté activada. Desactívela para evitar los
tirones.

Movimientos sólo vertical u horizontalmente
Mantenga pulsada la tecla Control durante el movimiento. Pulse y manténgala pulsada cuando mueva el objeto con el
ratón. Puesto que ésta es una tecla de limitación deberá soltar primero el botón del ratón y a continuación la tecla
Control al moverse por una línea horizontal o vertical. 

Movimiento con los puntos de anclaje seleccionados
Cuando el cursor del ratón está sobre el punto de anclaje de un objeto, podrá seleccionarlo. Si la opción “Puntos de
anclaje magnéticos” está activada, podrá colocar de forma sencilla objetos directamente unos sobre otros sin
intervención de las líneas guía magnéticas.

Rotación de objetos
R o t a c i ó n  d e  o b j e t o s

Rotación con el ratón
Seleccione un objeto haciendo clic sobre él una vez. Después de la selección aparecerán ocho manillas de selección
alrededor del objeto.

Haga clic en el objeto una vez más con el ratón.
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La selección de las manillas ha cambiado. Cuando haga rotaciones utilice solamente las manillas que hay en las
esquinas del objeto.

Haga la rotación pulsando y manteniendo pulsado el botón izquierdo del ratón y moviendo el ratón en la dirección que
desea rotar.

Cuando esté realizando la rotación el objeto seguirá visible y la nueva posición se mostrará mediante una línea azul
que representa el contorno del objeto.

Cuando suelte el botón del ratón el objeto habrá rotado.

Rotación del eje de los objetos
La rotación del eje de un objeto siempre se representa mediante el siguiente símbolo.

Este símbolo puede moverse con el ratón a cualquier lugar determinado en la hoja de trabajo. El eje de rotación
determina el punto alrededor del cual rotará el objeto. 

Movimiento del eje de rotación
Haga clic dos veces en un objeto no seleccionado para mostrar las manillas de rotación.

Lleve el cursor hacia el eje de rotación. Podrá iniciar el movimiento cuando el cursor haya cambiado su forma a una
cruz.

Ahora puede mover el eje de rotación a cualquier lugar determinado en la hoja de trabajo.



58 EasySIGN

Si inicia la rotación verá que el objeto rota alrededor del punto donde colocó el eje de rotación.

Arrastrando el eje de rotación con la tecla “Control” podrá volver al centro exacto del objeto.

Rotación con valores numéricos.

Atajo del teclado "ALT+F8"

 Seleccione el objeto que desea rotar numéricamente. 

 Cuando el objeto haya sido seleccionado haga clic una vez con el botón derecho del ratón. Aparecerá un menú
desplegable oculto.
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 Seleccione la opción “Transformar” del menú desplegable oculto. Aparecerá un submenú. Seleccione la opción
“Rotación”.

Rotación (1)
 Esta opción contiene un campo de entrada para el número de grados del movimiento de rotación.
 Además hay dos círculos de opciones en este campo. Con estos círculos de opciones podrá determinar la dirección
de la rotación del objeto. 

Origen (2)
 Los botones de esta caja indican el eje de rotación del objeto.

Salir del original (3)
 Cuando se activa esta opción, el objeto es rotado, dejando el original detrás.

Rotaciones especiales
Al colocar el eje de rotación en combinación con el diálogo de rotación tendrá un mayor control de la rotación. Si
reposiciona el eje de rotación y a continuación invoca el diálogo de rotación podrá colocar objetos en un patrón
repetitivo. 

Ejemplo
 Seleccione el objeto dos veces para mostrar las manillas de rotación.

 A continuación mueva el eje de rotación.
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 Utilice el menú desplegable oculto para invocar el diálogo de rotación.

 En “Origen” (2), donde normalmente encontraría los botones para reposicionar el eje de rotación en un vértice o
lateral del objeto, verá ahora el siguiente icono. 

 Donde indica rotación, rellene “30 grados” y active la opción “Salir del original” (3). Una vez hecho esto, haga clic en
el botón “Aplicar” doce veces.

De una forma simple ha creado ahora una imagen con un objeto en los lugares donde normalmente encontraría los
dígitos de un reloj.  
En vez de hacer clic en el botón “Aplicar” del cuadro de diálogo varias veces, también puede ejecutar una sola acción
de rotación con el diálogo o con el ratón y seleccionar la opción “Repetir” del menú ”Editar” o utilizar la tecla de atajo
“Control R”.

Movimiento de objetos diagonalmente
M o v i m i e n t o  d e  o b j e t o s  d i a g o n a l m e n t e

Movimiento diagonal con el ratón
Seleccione el objeto haciendo clic sobre él. Una vez seleccionado aparecerán ocho manillas de selección alrededor del
objeto.

Haga clic en el objeto una vez más con el ratón.

 

La selección de las manillas ha cambiado. Al mover diagonalmente utilice solamente las manillas que hay en los
laterales del objeto.
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Podrá mover un objeto diagonalmente moviendo el ratón en alguna de las direcciones indicadas por la manilla que
está sujetando en dicho momento.

 Movimiento diagonal con valores numéricos

Atajo del teclado "ALT+F11"

Seleccione el objeto que desea mover diagonalmente.

Cuando el objeto haya sido seleccionado, haga clic con el botón derecho del ratón una vez. Aparecerá un menú
desplegable oculto.

Seleccione la opción “Transformar” en el menú desplegable oculto. Aparecerá un submenú. Seleccione la opción
“Sesgar”.
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Ángulo (1)
Esta opción contiene un campo de entrada para el número de grados en los que desea ejecutar el movimiento
diagonal. También hay dos botones de radio en este campo. Estos botones de radio permiten especificar la dirección
de rotación del objeto. 

Origen (2)
Los botones de este cuadro indican el origen o eje utilizado como punto de anclaje para el movimiento diagonal. La
diferencia entre los diversos puntos de anclaje se muestra en las siguientes ilustraciones. 

Situación Inicial

Origen Resultado

  

  

  

Salir del original (3)
Cuando se activa esta opción, el objeto queda sesgado, dejando el original detrás.

Espejo de objetos
E s p e j o  d e  o b j e t o s

Utilización del ratón para hacer el espejo
Seleccione un objeto haciendo clic sobre él una vez. Una vez seleccionado, aparecen ocho manillas de selección
alrededor del objeto.
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Podrá utilizar cualquier manilla de selección para hacer el espejo del objeto.

Pulse y mantenga pulsado el botón izquierdo del ratón y mueva el cursor a la derecha. Para hacer el espejo del
objeto y no distorsionarlo, debe pulsar la tecla “Control”. La tecla “Control” es una limitación que asegura que el
movimiento quede limitado a pasos del 100% del tamaño del objeto.

Si hace clic con el botón derecho del ratón una vez durante la creación del espejo, dejará detrás un original del
objeto de forma automática.

Espejo con un diálogo

Atajo del teclado "ALT+F10"

Seleccione el objeto al que desea hacer el espejo.

Cuando el objeto ha sido seleccionado, haga clic con el botón derecho del ratón una vez. Aparecerá un menú
desplegable oculto.
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Seleccione la opción “Transformar” en el menú desplegable oculto. Aparecerá un submenú. Seleccione la opción
“Espejo”.

Espejo (1)
Aquí encontrará dos cuadros de marcación. Si activa el cuadro de marcación superior, se creará el objeto del espejo
a lo largo de su eje horizontal. Si selecciona la opción de la parte inferior, se creará el espejo del objeto a lo largo del
eje vertical. También se pueden utilizar ambas opciones al mismo tiempo.

Origen (2)
Los botones de este cuadro indican el origen o eje del objeto que se utiliza como punto de anclaje para realizar el
espejo. En las siguientes ilustraciones se muestra la diferencia entre los diversos puntos de anclaje. En los ejemplos
siguientes hemos activado ambas opciones “Horizontal” y “Vertical”. También hemos activado la opción “Salir del
original” (3). El objeto con las manillas de selección es el espejo del objeto. 

Situación inicial

Origen Resultado
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Modificación del tamaño y distorsión de objetos
M o d i f i c a c i ó n  d e l  t a m a ñ o  y  d i s t o r s i ó n  d e  o b j e t o s

Modificación del tamaño y distorsión con el ratón
Seleccione un objeto haciendo clic sobre él una vez.

La selección de las manillas rodeadas por círculos indican las que serán redimensionadas.

Puede ampliar el objeto alejándose del objeto con el cursor.
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Puede reducir el objeto moviéndose hacia el objeto con el cursor.

Si mantiene pulsada la tecla “Mayúsculas” durante la ampliación o reducción, el objeto cambiará su escala desde el
centro.

 

Si pulsa y mantiene pulsada la tecla “Control” durante el aumento, el objeto cambiará su tamaño duplicándose con
cada paso. 

 

La selección de las manillas que están rodeadas por círculos en la ilustración siguiente va a ser distorsionada.

Como ocurre con la variación de escala, si desea distorsionar el objeto desde el centro, utilice la tecla “Mayúsculas” y
si desea distorsionar el objeto por pasos de 100  por ciento, utilice la tecla “Control”.

Modificación de la escala y distorsión con valores numéricos

Atajo del teclado "ALT+F9"
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Seleccione el objeto cuya escala desea variar o distorsionar numéricamente.

Cuando el objeto ha sido seleccionado, haga clic con el botón derecho del ratón una vez. Aparecerá un menú
desplegable oculto.

Seleccione la opción “Transformar” del menú desplegable oculto. Aparecerá un submenú. Seleccione la opción
“Tamaño”. 

Tamaño (1)
En este cuadro encontrará los valores horizontal (X) y vertical (Y) del formato del objeto seleccionado.

Origen (2)
Los botones de este cuadro indican el origen del objeto.

Salir del original (3)
Cuando se activa esta opción el objeto cambia su escala o se distorsiona, dejando el original detrás.

Proporcional (4)
Cuando se activa esta opción el objeto sólo puede modificar su escala. Todos los valores introducidos para “X”, por

ejemplo, tendrán influencia en el valor de “Y” y viceversa.

Con valores (5)
Cuando se activa esta opción, se muestran los tamaños reales de los objetos en los campos “X” y “Y”.
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Ejemplos de modificación de escala
El objeto rodeado por las manillas de selección representa el resultado final.

Situación inicial

Origen Resultado
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Asistente de transformación
A s i s t e n t e  d e  t r a n s f o r m a c i ó n

El asistente de transformación le ayuda a aplicar las transformaciones que le proporciona el programa. Puede realizar
transformaciones como posición, rotación, etc. a través de este cuadro de diálogo flotante. Puede introducir el
número de la posición horizontal y aplicarlo presionando el botón "Entrar". Este cuadro de diálogo se puede mostrar u
ocultar en el menú "Ver", "Asistente de transformación":

Además puede cambiar la apariencia y forma de este cuadro de diálogo al arrastrar los bordes.

Partes del asistente de transformación

Posición

Horizontal

Vertical

Tamaño

Horizontal

Vertical

Inclinar

Horizontal

Vertical
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Rotar

Ambas
direcciones

Si introduce un valor positivo o negativo, puede rotar en ambas direcciones.

Espejo

Horizontal

Vertical

Punto de
anclaje

Si cambia el punto de anclaje, influye directamente en:
Posición
Tamaño
Inclinar
Rotar
Espejo
Si establece el punto de anclaje en la parte inferior izquierda, el asistente de transformación toma como referencia
este punto:

En el ejemplo anterior el punto de anclaje está situado en la parte inferior izquierda. La rotación se realiza alrededor
de los límites del objeto. Tenga en cuenta que después de una rotación, los límites del objeto cambian. Cuando aplica
una segunda rotación, el objeto puede ofrecer un aspecto muy diferente al que esperaba:

En el ejemplo anterior, el cuadro rojo representa la posición original del objeto. El cuadro azul representa los límites
del objeto y el punto amarillo el punto de rotación. Después de cada rotación, puede comprobar que los límites del
objeto cambian así como el punto de rotación. Consulte el capítulo "Rotar objeto" para ver cómo funciona el punto de
rotación. 

Proporcion
al

Con esta opción los campos siguientes están conectados de manera proporcional:
Posición horizontal y vertical
Tamaño horizontal y vertical

Porcentaj
e

Con esta opción los campos de "Tamaño" utilizan porcentajes del original en vez de los valores actuales.



72 EasySIGN

Relativ
o

Con esta opción, la posición se realiza en función de la posición actual.

Dejar
original

Al realizar cada transformación se crea un duplicado (excepto con la función "Orden").

Orden

Mover adelante

Traer al frente

Mover atrás  

Llevar al fondo

Duplicación de objetos
D u p l i c a c i ó n  d e  o b j e t o s

Podrá copiar objetos utilizando el comando “Duplicar” o mediante los comandos “Cortar”, “Copiar” y “Pegar”. Para
esto se utiliza el portapapeles interno del EasySIGN's.

Colocación de una copia del objeto en el portapapeles interno:

 Tecla de atajo "CTRL+C"

1 Seleccione el objeto que desea copiar.
2 Seleccione el comando “Copiar” del menú “Editar” (o utilice el botón de la “Barra de herramientas”).

Corte de un objeto y  colocación en el portapapeles interno:

 Tecla de atajo "CTRL+X"

1 Seleccione el objeto que desea cortar.
2 Seleccione el comando “Cortar” del menú “Editar” (o utilice el botón de la “Barra de herramientas”). El objeto

desaparecerá y será colocado en el portapapeles interno.

Movimiento de un objeto del portapapeles interno a la hoja de trabajo:

 Tecla de atajo "CTRL+V"

 Seleccione el comando “Pegar” del menú “Editar” (o utilice el botón de la “Barra de herramientas).

Duplicación

Tecla de atajo "CTRL+D"

Se utiliza el comando “Duplicar” del menú “Editar” para hacer una copia de los objetos seleccionados.

Duplicación en la parte superior

Tecla de atajo "Numérica+"

Este comando del menú “Editar” coloca una copia del objeto directamente sobre el original.

Eliminación de objetos
E l i m i n a c i ó n  d e  o b j e t o s

Tecla de atajo “SUPR”

Si desea eliminar un objeto de la hoja de trabajo, seleccione el comando “Eliminar” del menú “Editar” o utilice la tecla
de atajo “SUPR”.
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Alineación de objetos
A l i n e a c i ó n  d e  o b j e t o s

Mediante los diversos comandos de la barra de menú “Alinear objetos” permite poner en línea todos los objetos,
hacer que tengan el mismo tamaño o centrarlos en la página.

Importante
En todas las opciones de esta barra de menú (con excepción del centrado de página), el último objeto seleccionado
determina donde se alineará el otro objeto. En otras palabras, el último objeto seleccionado no cambia de lugar.

Colocación de dos objetos en la hoja de trabajo

Seleccione el primer objeto de la serie de objetos que desea alinear.

Seleccione el último objeto de la serie de objetos que desea alinear.

Haga clic en el botón “Alinear por la izquierda” en la barra de menú “Alinear objetos”. 

Haga clic en el botón “Aplicar” de la barra del menú “Alinear objetos”.

Verá que el objeto seleccionado primero ha sido alineado a la izquierda del último objeto seleccionado.
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Comandos de alineación
C o m a n d o s  d e  a l i n e a c i ó n

En la sección siguiente encontrará una descripción de los comandos de alineación separados, incluidas varias
combinaciones posibles de estos comandos.

Localización en la barra de menú

Comandos separados

A Alinear por la izquierda

B Centrar verticalmente 

C Alinear por la derecha

D Alinear por arriba

E Centrar horizontalmente 

F Alinear por abajo

G Alinear todos los objetos seleccionados al centro de la página. 

H Hacer que todos los objetos seleccionados tengan la misma
anchura

I Hacer que todos los objetos seleccionados tengan la misma
altura.

J Aplicar el (los) comando(s) seleccionado(s)

Combinación de comandos

Situación inicial

Combinación Resultado
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 Podrá utilizar todas las combinaciones anteriores conjuntamente con los siguientes comandos:

Hacer que todos los objetos seleccionados tengan la misma
anchura.

Hacer que todos los objetos seleccionados tengan la misma
altura.

Podrá utilizar ambos comandos de forma separada con los comandos de alineación o simultáneamente. Por ejemplo,
la siguiente combinación.

Distribuir (con la misma separación)
D i s t r i b u i r  ( c o n  l a  m i s m a  s e p a r a c i ó n )

Las opciones de distribución permiten colocar los objetos de manera que la distancia entre ellos sea la misma. Puede permitir que la aplicación

calcule la distancia entre los objetos, o puede especificar la distancia usted mismo.

Cálculo automático de la distancia
Encontrará estas opciones en la barra de herramientas para “alinear objetos”. Estas opciones, junto con la posibilidad de especificar la distancia,

también están disponibles mediante el menú “Organizar, Con la misma separación”.

A : Distribuir horizontalmente
Seleccione los objetos que desea distribuir, seguida de una opción de la barra de herramientas de alineación. Después de presionar el botón “Entrar”

en la barra de herramientas de alineación, los objetos se distribuirán horizontalmente. Los dos objetos exteriores permanecen fijos y se utilizarán

como anclaje. Esto significa que la colocación de los demás objetos es relativa a ellos. 

 

Opción Resultado

1
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2

3

4

B : Distribuir verticalmente
Esta opción funciona igual que “Distribuir horizontalmente”, excepto que ahora todo se distribuye verticalmente.

Puede utilizar las distribuciones horizontal y vertical a la vez. No obstante, se recomienda utilizarlas por separado. También puede combinar las

opciones de distribución con las opciones de alineación. Si combina las opciones de distribución con las opciones de alineación, el último objeto

seleccionado permanece fijo y actúa como anclaje.

C : Opciones de alineación de texto
En la barra de herramientas de alineación, presione el botón "C" para que se muestre el cuadro de diálogo “Parámetros de extensión de alineación

del texto”. Consulte el capítulo “Opciones de alineación de texto” para obtener una descripción detallada. 

Especificar distancia

Esta opción está disponible mediante el menú “Organizar, Con la misma separación, Espaciar uniformemente”.

1 Alinear horizontalmente
Opciones de  izquie rda  a  de recha:
No hace nada.
Distancia entre los laterales izquierdos.

Distancia entre los centros.

Distancia entre los laterales derechos.

Distancia entre el lateral derecho y el lateral izquierdo del siguiente objeto.

2 Especificar distancia
Si así lo desea, puede especificar una distancia horizontal definida por el usuario entre los objetos.

3 Distribuir verticalmente
Opciones de  izquie rda  a  de recha:
No hace nada.
Distancia entre las partes inferiores.

Distancia entre los centros.
Distancia entre las partes superiores.
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Distancia entre la parte superior y la parte inferior del siguiente objeto.

4 Especificar distancia
Si así lo desea, puede especificar una distancia vertical determinada automáticamente entre los objetos.

Opciones de alineación de texto
O p c i o n e s  d e  a l i n e a c i ó n  d e  t e x t o

Debido a la complejidad de los objetos de texto y las distintas opiniones respecto al método correcto para alinearlos, hay disponibles varias

opciones de alineación para texto. Seleccione “Ver, Parámetros” y, a continuación, la hoja de fichas “Texto” y el botón “Extensión de texto…”.

1 Alineación de texto con espacio en blanco 

2 Alineación de texto sin espacio en blanco 

3 Alineación de texto en línea de referencia

Puede seleccionar cualquier combinación de opciones. La configuración que establezca en este cuadro de diálogo se aplica a todo el paquete de

software.    

A Área de gris claro

Se trata del “espacio en blanco” de un texto.

B Área de gris oscuro
Se trata de la forma vectorial o la curva de un texto (opción: Sin espacio en blanco).
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C Nodos (cuadrados pequeños)
Puntos de origen de los distintos caracteres.

D Línea naranja
Línea de referencia que pasa por los puntos de origen de los distintos caracteres.

A continuación se muestran algunos ejemplos con distintos parámetros.

Si tiene pensado alinear el texto de forma tipográfica (y visualmente) correcta, active la siguiente combinación de opciones.

Si estaba satisfecho con la opción de alineación sencilla de texto de versiones anteriores a la versión 5, active la
siguiente combinación de opciones.

Reglas
R e g l a s

Las reglas horizontal y vertical de EasySIGN están localizadas en la esquina superior izquierda de la hoja de trabajo.
Las reglas se muestran en la unidad de medida elegida.
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Rejilla
R e j i l l a

La rejilla es una pantalla de puntos colocadas sobre la página. Con la opción “Rejilla magnética” activada, la rejilla
asegura que todos los movimientos del ratón queden restringidos a un múltiplo de la distancia de la rejilla.

 

Líneas guía
L í n e a s  g u í a  

Hay dos formas de añadir líneas guía a una hoja de trabajo que no tenga líneas guía.

Mueva el cursor del ratón sobre la regla y haga clic con el botón derecho del ratón.
Aparecerá un menú desplegable oculto.

En el menú desplegable oculto de las líneas guía encontrará los siguientes comandos:
Ocultar
Parámetros de la rejilla
Propiedades de las líneas guía 

Si hace clic con el ratón en “Propiedades de las líneas guía”, aparecerá un cuadro de diálogo.
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El diálogo está subdividido en tres “Tabuladores” (1). El primer tabulador se utiliza para las operaciones con las líneas
guía horizontales, el segundo con las verticales y el tercer tabulador con las líneas guía inclinadas.
A la izquierda del diálogo encontrará la ubicación de las líneas guía mostradas numéricamente (2). Si tiene varias
líneas guía ubicadas aquí, puede cambiar las propiedades de cada línea guía por separado haciendo clic en el valor
numérico de la línea guía. El valor de la línea guía seleccionada aparecerá en la ventana de texto al lado (3). 

Eliminación de líneas guía
Seleccione la línea guía en (2) y haga clic en el botón “Eliminar”(6).

Movimiento de líneas guía
Seleccione la línea guía en (2), ponga un nuevo valor (3) y haga clic en el botón “Mover” (5).

Adición de líneas guía
Rellene en (3) un valor y haga clic en el botón “Añadir”(4).

Mueva el cursor del ratón a la regla y arrastre la línea guía a la hoja de trabajo.

Edición de líneas guía
Si desea evitar las líneas guía en una hoja de trabajo, mueva el ratón a la línea guía que desea evitar, haga clic en
ella con el botón derecho del ratón y aparecerá un menú desplegable oculto.

En este menú desplegable oculto de las líneas guía encontrará los siguientes comandos:
Eliminar
Encajar en líneas guía
Traer al frente
Ocultar todo
Propiedades

Eliminar
Esta opción elimina la línea guía seleccionada. También se puede eliminar la línea guía arrastrándola de vuelta a la

regla.
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Encajar en líneas guía
Al activar o desactivar esta opción se pueden colocar objetos magnéticamente en las líneas guía.

Traer al frente
Esta opción asegura que las líneas guía estén en la parte superior o detrás de los objetos en la hoja de trabajo.

Ocultar todo
Esta opción oculta todas las líneas guía de la hoja de trabajo sin eliminarlas. Las líneas guía se harán visibles
nuevamente colocando el ratón en la regla e invocando el diálogo “Propiedades de las líneas guía”, con el botón
derecho del ratón. En este diálogo deberá activar la opción “Mostrar líneas guía”.

Propiedades
Esta opción activa el diálogo “Líneas guía”. 

Líneas guía inclinadas
Si desea inclinar una línea guía, puede hacerlo de dos formas:

1 Abra el diálogo “Líneas guía” y en el tabulador “Líneas guía inclinadas” rellene los valores horizontal, vertical y
angular de forma numérica.

2 Arrastre una línea guía desde una regla y colóquela en el lugar requerido. A continuación seleccione la línea
guía con el ratón y al mismo tiempo utilice la tecla Mayúsculas. Moviendo el ratón podrá determinar el ángulo
de la línea guía manualmente.

Propiedades magnéticas
La propiedad más importante de las líneas guía es que pueden ser magnéticas. Puesto que esto puede tener un
efecto no deseado durante el movimiento de objetos, podrá activar o desactivar las propiedades magnéticas. Esto se
consigue invocando un menú desplegable oculto con el botón derecho del ratón y activando o desactivando la opción
“Encajar en líneas guía”.

Encaje magnético
Cuando mueva todo un objeto, este objeto encajará en la selección de las manillas. 

Cuando tenga un objeto de forma irregular que desea colocar en una línea guía, también podrá utilizar un punto de
anclaje para encajar el objeto en las líneas guía.

El procedimiento es el siguiente:
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Mueva el cursor del ratón sobre un objeto. Cuando se haya encontrado el punto de anclaje aparecerá un cuadrado
rojo.

Cuando el cuadrado aparezca haga clic sobre él con el ratón; ahora podrá hacer que este punto encaje en una línea
guía o en una intersección de varias líneas guía.

Podrá hacer también que las líneas guía encajen por sí mismas en esta intersección de objetos. 

Ejemplo
Se tiene un objeto en una hoja de trabajo y desea alinear otros objetos a la izquierda del primero.

Arrastre una línea guía desde una regla.

Mueva esta línea guía sobre la parte izquierda del objeto hasta que aparezca un cuadrado rojo, a continuación suelte
la línea guía. La línea guía se habrá movido al lateral izquierdo del objeto exactamente.
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Sugerencias
S u g e r e n c i a s

Colocación de líneas guía dobles
Podrá arrastrar dos líneas guía que se intersectan al mismo tiempo desde la intersección de las reglas. Esto es muy
útil para colocar rápidamente líneas guía en una esquina de un objeto.

Agrupación y desagrupación de objetos
A g r u p a c i ó n  y  d e s a g r u p a c i ó n  d e  o b j e t o s

Agrupación

Tecla de atajo "CTRL+G"

Podrá utilizar el comando “Agrupar” del menú “Organizar” para bloquear la localización de objetos entre sí. 

Desagrupar

Tecla de atajo "CTRL+U"

Utilizando el comando “Desagrupar” del menú “Organizar”, podrá separar los objetos de un grupo nuevamente.

Desagrupamiento múltiple
D e s a g r u p a m i e n t o  m ú l t i p l e

Si existe más de un grupo o grupos que contienen grupos anidados en una selección, puede utilizar el comando
"Desagrupar" del menú "Organizar" o el método abreviado "CTRL+U", hasta que se hayan quitado todos los grupos
de la selección. De esta forma no es necesario desagrupar una selección y seleccionar un nuevo grupo para poder
volver a utilizar el comando "Desagrupar".

Combinación y ruptura de objetos
C o m b i n a c i ó n  y  r u p t u r a  d e  o b j e t o s

Combinación

Tecla de atajo  "CTRL+L"

Utilizando el comando “Combinar” del menú “Organizar” podrá combinar dos (o más) objetos del mismo tipo. 
La combinación es más drástica que la agrupación porque cambia los objetos separados en un solo objeto. 

Las letras suelen ser objetos combinados, de esta forma la letra “b” es una forma que consta de un contorno exterior
y otro interior. Puesto que los contornos están combinados, sólo se rellena la letra y la separación en la “b” es
transparente. 

Cuando se combinan objetos vectoriales de colores distintos y /o estilos de líneas, el objeto combinado final recibirá
el color del último objeto seleccionado.

Supongamos que desea crear una letra “b” a partir de los siguientes objetos. En este caso tendrá que hacer que la
barra que se muestra permanezca visible a través de la separación en la letra “b”.
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Cuando haya colocado el objeto a la izquierda, en la parte superior del contorno exterior de la letra “b” habrá
conseguido el siguiente resultado.

La letra “b” consta aún de dos objetos que pueden tener cada uno de ellos colores diferentes y la barra no es visible
a través del objeto.

Incluso si da al objeto en la parte superior el mismo color que el fondo, podría parecerse más a una letra “b”, pero la
letra “b” seguiría estando formada por dos objetos, cada uno de ellos con un color distinto. 

Después de la combinación el objeto tendrá la siguiente apariencia.

Ruptura

Tecla de atajo "CTRL+K"

La ruptura significa la cancelación de una combinación de objetos.

Descomposición por piezas
D e s c o m p o s i c i ó n  p o r  p i e z a s

Si se combinan múltiples objetos para formar uno solo, podrá descomponer este objeto para obtener de nuevo todos
sus objetos por separado mediante el comando "Descomponer por piezas".

Como muestra la ilustración, si descompone objetos como texto, previamente tendrá que haber combinado cada
objeto independiente de nuevo para mantener la forma visual de las letras. El programa ahora puede hacer esta
operación automáticamente mediante el comando "Descomponer por piezas" del menú "Organizar".

Original
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Después de aplicar el comando "Organizar", "Descomponer por piezas".

Después de aplicar el comando "Organizar", "Descomponer por piezas".

Secuencia apilada de objetos
S e c u e n c i a  a p i l a d a  d e  o b j e t o s

Utilizando los comandos del menú “Organizar, Ordenar”, podrá cambiar la secuencia de apilación de objetos. La
secuencia de apilación de objetos determina si un objeto queda por debajo o frente a otro objeto. 

  Movimiento hacia delante

Este comando mueve el objeto seleccionado un lugar delante en la secuencia de apilación.
 
 Traer al frente

 
Este comando mueve el objeto al primer plano de la secuencia de apilación.

 Mover hacia atrás 

Este comando mueve el objeto un lugar atrás en la secuencia de apilación.
 
 Poner detrás

 Este comando mueve el objeto a la parte posterior de la secuencia de apilación.
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Orden de solapado ampliado en la versión 4
O r d e n  d e  s o l a p a d o  a m p l i a d o  e n  l a  v e r s i ó n  4

A través de “Organizar, Orden, Invertir selección” puede invertir el orden de solapado de todos los objetos
seleccionados.

Puede colocar un objeto directamente en cualquier posición de un orden de solapado. Seleccione el objeto que desee
mover dentro del orden de solapado y, a continuación, seleccione “Organizar, Orden, Colocar delante o Colocar
detrás”. El cursor cambiará y, a continuación, seleccione el objeto delante o detrás del cual desea colocar el objeto
seleccionado.

Multiplicación de objetos
M u l t i p l i c a c i ó n  d e  o b j e t o s

Este comando permite crear varias copias a la vez. Podrá ajustar el número de copias a realizar en dirección
horizontal y vertical. También podrá indicar el espaciado (el espacio entre el contorno máximo de las copias a
producir).  
Para ello seleccione el comando “Multiplicar” del menú “Organizar”.
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En los campos próximos (1) podrá rellenar cuantas copias desea crear vertical y horizontalmente. En los campos
próximos (2) podrá establecer la cantidad de espacio entre copias.

Multiplicar círculo
M u l t i p l i c a r  c í r c u l o

Este comando permite hacer múltiples copias que se insertarán en el documento con forma circular. Seleccione uno o
varios objetos y, a continuación, elija “Multiplicar” en el menú “Organizar”. En el cuadro de diálogo, seleccione la ficha
“Círculo”. 

En este cuadro de diálogo, el centro actual del objeto seleccionado se muestra en el área "Centro" (1). Estos campos
representan la ubicación del objeto seleccionado en la hoja. En el área "Radio" (2), puede especificar el radio de la
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forma circular. Cuando se abra el cuadro de diálogo , se colocará en este campo un número basado en el tamaño del
objeto seleccionado. El radio se calcula desde el centro del objeto seleccionado al centro de los objetos de la forma
circular resultante después de la multiplicación.

El área "Ángulos" cuenta con las siguientes opciones.

Inicio:
Especifique aquí el punto inicial de la forma circular. Para obtener información sobre estos valores puede remitirse a
la ilustración ubicada en la esquina inferior izquierda del cuadro de diálogo.  

Fin:
Especifique aquí el punto final de la forma circular. Si escribe 0 grados en el campo "Inicio", 180 grados en el campo
"Fin" y 6 en el campo "Pasos", creará una forma circular compuesta por 7 objetos con una rotación de 30 grados
entre cada uno de ellos. 

Si escribe 0 grados en el campo "Inicio", 330 grados en el campo "Fin" y 11 en el campo "Pasos", creará una forma
circular formada por 12 objetos con una rotación de 30 grados entre cada uno de ellos.

En las dos imágenes anteriores, "A" es el objeto original y "B" es la copia de dicho objeto. El resto de objetos resultan
del número especificado en el campo "Pasos". El objeto original nunca se incluye en la forma circular resultante.

Pasos:
Especifique el número de pasos que desea utilizar en la forma circular resultante.

Cada paso:
Los campos "Fin" y "Pasos" se desactivan si este campo está activado. El número especificado previamente para "Fin"
se calculará de nuevo cada vez que se ajuste el campo "Cada paso".

Dirección:
Aquí puede establecer la dirección de rotación.

La opción "Rotar objeto" (4) permite especificar si el eje del objeto no debe cambiar durante la rotación o si, por el
contrario, debe rotar.
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En el ejemplo "A", la opción "Rotar objeto" estaba activada y en el ejemplo "B" no.

Bloqueo del punto de rotación

Para bloquear el punto de rotación de forma que el objeto original no sea el centro, sino una parte de la forma
circular, debe seleccionar el objeto de nuevo para poder tener acceso al modo de rotación. A continuación, puede
arrastrar el centro de rotación a la posición que desee. Ahora podrá tener acceso al cuadro de diálogo. En este
cuadro de diálogo las opciones "Centro" y "Radio" aparecerán desactivadas porque ya las ha establecido en la hoja.
Si prefiere este método de trabajo, el objeto original siempre será una parte de la forma circular en lugar del centro.
 

Multiplicar espiral
M u l t i p l i c a r  e s p i r a l

Este comando permite hacer múltiples copias que se insertarán en el documento con forma espiral. Seleccione uno o
varios objetos y, a continuación, elija “Multiplicar” en el menú “Organizar”. En el cuadro de diálogo, seleccione la ficha
“Espiral”. 
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En este cuadro de diálogo, el centro actual del objeto seleccionado se muestra en el área "Centro" (1). Estos campos
representan la ubicación del objeto seleccionado en la hoja. En el área "Radio" (2), puede especificar el radio inicial y
final de la forma espiral. Cuando el cuadro de diálogo se abra, se colocará en estos campos un número basado en el
tamaño del objeto seleccionado. El radio se calcula desde el centro del objeto seleccionado al centro de los objetos de
la forma espiral resultante después de la multiplicación.

El área "Ángulos" cuenta con las siguientes opciones.

Inicio:
Especifique aquí el punto inicial de la forma espiral.

Fin:
Especifique aquí el punto final de la forma espiral. Si escribe 0 grados en el campo "Inicio", 360 grados en el campo
"Fin" y 12 en el campo "Pasos", creará una forma espiral compuesta por 13 objetos y con una rotación de 30 grados
entre cada uno de ellos. 

Si escribe 0 grados en el campo "Inicio", 720 grados en el campo "Fin" y 24 en el campo "Pasos", creará una forma
espiral compuesta por 25 objetos con una rotación de 30 grados entre cada uno de ellos.
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En las dos imágenes anteriores, "A" es el objeto original y "B" es la copia de dicho objeto. El resto de objetos resultan
del número especificado en el campo "Pasos". El objeto original nunca se incluye en la forma espiral resultante.

Pasos:
Especifique el número de pasos que desea utilizar en la forma espiral resultante.

Cada paso:
Los campos "Fin" y "Pasos" se desactivan si este campo está activado. El número especificado previamente para
"Pasos" y “Fin” se calculará de nuevo cada vez que se ajuste el campo "Cada paso".

Dirección:
Aquí puede establecer la dirección de rotación.

La opción "Rotar objeto" (4) permite especificar si el eje del objeto no debe cambiar durante la rotación o si, por el
contrario, debe rotar.

En el ejemplo "A", la opción "Rotar objeto" estaba activada y en el ejemplo "B" no.

Bloqueo del punto de rotación

Para bloquear el punto de rotación de forma que el objeto original no sea el centro, sino una parte de la forma
espiral, debe seleccionar el objeto de nuevo para que pueda acceder al modo de rotación. A continuación, puede
arrastrar el centro de rotación a la posición que desee. Ahora podrá tener acceso al cuadro de diálogo. En este
cuadro de diálogo las opciones "Centro" y "Radio" aparecerán desactivadas porque ya las ha establecido en la hoja.
Si prefiere este método de trabajo, el objeto original siempre será una parte de la forma espiral en lugar del centro.  
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Multiplicación mejorada
M u l t i p l i c a c i ó n  m e j o r a d a

A partir de la versión 5, se ha mejorado la multiplicación para que las copias se puedan seguir editando, un proceso
también conocido como “pasos y repeticiones”. En EasySIGN, esto significa que las copias siguen siendo editables, y
no sólo durante la aplicación de esta opción. Cuando un hoja se guarda y se vuelve a abrir posteriormente, la
herramienta de arrastre todavía permite cambiar el número de copias. Mediante la comprobación de las opciones del
objeto, es posible cambiar otros parámetros, como la separación entre las copias.

Procedimiento
Seleccione el objeto o los objetos que desea multiplicar. Seleccione el menú “Organizar”, “Multiplicar”.

Ajuste los parámetros como desee y active la opción “Modificable”. A continuación, haga clic en "Aceptar".
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Ahora se encuentra en el modo de la herramienta de arrastre, y esta herramienta permite mover el controlador para crear más o menos copias.

Si desea editar la separación u otros parámetros mediante el cuadro de diálogo, elija la opción “Propiedades” en el menú contextual.

Herramienta de escala y medición
H e r r a m i e n t a  d e  e s c a l a  y  m e d i c i ó n

Con esta herramienta podrá medir y corregir distancias y ángulos en los objetos.

Si uno o más objetos deben ser modificados, primero seleccione estos objetos. A continuación elija el comando
“Escala y Medición” en el menú “Organizar”, “Transformaciones”.

Rotación utilizando la herramienta de escala y medición
Cuando un objeto ha sido escaneado y vectorizado, suele aparecer en pantalla ligeramente inclinado. Utilizando la
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herramienta de escala y medición el objeto puede ser colocado horizontalmente de forma sencilla, con un solo
movimiento. Lo primero seleccione el objeto y a continuación elija la herramienta de escala y medición. Encuentre
dos puntos en el objeto que deban estar horizontales. Pulse y mantenga pulsado el botón del ratón y dibuje una línea
punteada entre estos dos puntos. 

Cuando suelte el botón del ratón aparecerá el siguiente cuadro de diálogo:

Rellenando con “0” en “Ángulo” (2), los objetos se colocan horizontalmente de inmediato.

Utilizando este cuadro de diálogo podrá también modificar el factor de escala de los objetos (1). Esto es muy útil
cuando se tiene que modificar la longitud de una hipotenusa.  Si ha seleccionado varios objetos suele ser imposible
medirlos correctamente porque los objetos que están colocados más hacia el exterior no siempre están exactamente
en una línea. Este es el motivo por el que EasySIGN tiene "asas invisibles". Esto significa que hay algo dentro de los
puntos del asa dibujada en donde un ratón encaja automáticamente. Estos puntos indican exactamente la altura y
anchura máximas de los objetos.
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Ajuste rápido de tamaño
A j u s t e  r á p i d o  d e  t a m a ñ o

Puede guardar y aplicar tamaños utilizados con frecuencia en EasySIGN para otros usos posteriores. Seleccione el
comando "Organizar, Transformaciones, Ajuste rápido de tamaño".

1 Lista con los tamaños disponibles.
2 Agregar un nuevo tamaño.

3 Cambiar un tamaño seleccionado.
4 Eliminar un tamaño seleccionado.

Para aplicar un tamaño basta con seleccionarlo en la lista y hacer clic en “Aceptar”.

Colocar objetos sobre una trayectoria
C o l o c a r  o b j e t o s  s o b r e  u n a  t r a y e c t o r i a

Puede colocar cualquier objeto (incluidos grupos, efectos y mapas de bits) en una trayectoria vectorial abierta o
cerrada. 
Para ello, primero seleccione los objetos que desea colocar sobre una trayectoria.
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A continuación, seleccione el menú “Organizar, Objetos sobre la trayectoria” y, después, haga clic en la trayectoria.

Una vez los objetos estén colocados sobre una trayectoria, puede elegir la opción “Girar los objetos con la
trayectoria” en el menú contextual.

Con la combinación de teclas CTRL+CLICK, puede seleccionar objetos colocados sobre una trayectoria y
modificarlos. La propia trayectoria se puede adaptar; para ello, selecciónela en el Administrador de objetos y, a
continuación, modifíquela.

Ejemplo
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Funciones comunes

Area and Length
A r e a  a n d  L e n g t h

Usage:
Select one or more objects on the worksheet.
Select menu : View > Area and Length.

The following results are available in this dialog:

Area
Represents the area of the selected object. When more than one object is selected the silhouette of the objects
represents the area that will be calculated. 
Consider the following example.
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One object, width 100mm, height 100mm.
Result:

Two objects like the one above. 
Result:

The same objects as above but now overlapping. 
Result:

Area contour
Represents the area of the selected object ignoring any "holes". When more than one object is selected the outline of
the objects represents the area that will be calculated.
Consider the following example.

One object, width 100mm, height 100mm with a hole in it (width 50mm, height 50mm).
Result:

Two objects like the one above.
Result:
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The same objects as above but now overlapping. 
Result:

Area extends
Represents the area of the extends of the selected object(s). The extends of an object or objects is the smallest
rectangle that can enclose the object(s).
Consider the following example.

Two objects, the red rectangle around these objects represent the selection extend.  

Length
This is the length of all lines that are visible when viewing your worksheet in color mode. Layers, fills and no fills and
stacking order are considered when calculating the length. Using this method will make sure that non visible lines will
not be calculated. 
Consider the following example.

Two overlapping objects, both have a fill.
Result:

Same as above but the bottom object has no fill, the result will be the same as the result
above. 

Same as above but now the overlapping (top) object has no fill.
Result:
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Length wireframe
As the name already implies this is the length of the selected object(s) as you would view them in wireframe mode.
So all the visible lines in wireframe will be calculated.
Consider the following example.

Four overlapping objects which all have a fill. Below that the same objects but shown in
wireframe.
Result:

Options

Treat as one vinyl
color

This option is for clarity and will not trigger a recalculation. It just hides the "Area"
and "Area contour" values leaving only the "Area Extends".
  

Include line width. This option will recalculate the area but now including the line width.

Wireframe for length This option is for clarity and will not trigger a recalculation. It just hides the
"Length" leaving only the "Length Wireframe".

Cambiar a la última herramienta seleccionada
C a m b i a r  a  l a  ú l t i m a  h e r r a m i e n t a  s e l e c c i o n a d a

Anteriormente a la versión 4 de EasySIGN la tecla “Tab” se utilizaba para cambiar a la última herramienta
seleccionada. Este comportamiento se ha asignado a la tecla “Esc” ya que la tecla “Tab” ahora se utiliza en bloques
de texto. Asimismo, verá que el primer elemento del menú contextual de los objetos es la opción “Herramienta
anterior” que tiene la misma función que la tecla “Esc”. 
Ya no es necesario seleccionar en primer lugar la herramienta de selección antes de aplicar un efecto especial a un
objeto recién creado. Por ejemplo, puede crear un rectángulo y seguidamente aplicar un efecto sin tener que cambiar
de herramienta.
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Menú contextual (menú del botón secundario del ratón)
M e n ú  c o n t e x t u a l  ( m e n ú  d e l  b o t ó n  s e c u n d a r i o  d e l  r a t ó n )

El uso del menú contextual ha variado desde la versión 4 de EasySIGN. Ya no es necesario seleccionar en primer
lugar la herramienta de selección para poder tener acceso al menú contextual.

Pegar centrado
P e g a r  c e n t r a d o

Si pega en EasySIGN un objeto que haya copiado, siempre se pegará en las mismas coordenadas que tenía en el
lugar del que se copió. Ésta es una característica importante, sin embargo en algunos casos no es práctica, por
ejemplo cuando ha acercado una porción de un área distinta de aquella en que se copió el objeto.

La opción “Editar, Pegar centrado” (también presente en el menú contextual) pegará el objeto centrado en la vista
que se muestre actualmente.

Copiado especial
C o p i a d o  e s p e c i a l

Con esta función, puede copiar toda la hoja o parte de ella en el portapapeles. Posteriormente, puede pegar esta copia en una plantilla de correo

electrónico, una descripción de trabajo, una factura, etc.

Seleccione el menú “Editar, Copiado especial, Como mapa de bits en el portapapeles”. Este comando abre un cuadro de diálogo donde puede

especificar el espacio de color, el tamaño y la resolución del mapa de bits.

Trayectorias vectoriales en mapas de bits
T r a y e c t o r i a s  v e c t o r i a l e s  e n  m a p a s  d e  b i t s

Los archivos PSD (el formato nativo de Photoshop™) y otros archivos pueden contener trayectorias vectoriales. Cuando EasySIGN importa

este tipo de mapas de bits, las trayectorias vectoriales incluidas se agrupan con el mapa de bits. El DVD "LIBRARIES" contiene una carpeta llamada

"\BITMAP\Masked\Fonts\Chrome005\", en la que cada mapa de bits t iene una trayectoria vectorial. Puede utilizar esta trayectoria incluida como

forma de corte.

Canales alfa en mapas de bits
C a n a l e s  a l f a  e n  m a p a s  d e  b i t s

Entre otros tipos, los archivos PSD, PNG y TIFF pueden contener información de canales alfa junto a la información
normal de mapas de bits.El canal alfa consiste en una máscara en escala de grises que permite a EasySIGN procesar
este tipo de mapa de bits de forma transparente o enmascarada. Actualmente, EasySIGN sólo puede importar
archivos TIFF como CMYK con un canal alfa. Los archivos PSD y PNG deben ser archivos RGB. No obstante, después
de importarlos, puede convertirlos en CMYK. Consulte el tema sobre transparencia para obtener más información al
respecto y cómo aplicarla.

Previsualizaciones en el Explorador de Windows
P r e v i s u a l i z a c i o n e s  e n  e l  E x p l o r a d o r  d e  W i n d o w s

De cada formato de archivo, compatible con EasySIGN, se muestra una previsualización en el Explorador de Windows. No sólo se muestran

hojas, sino también archivos de imágenes y plantillas. 
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Resaltado (punto brillante) en rellenos de fuentes radiales
R e s a l t a d o  ( p u n t o  b r i l l a n t e )  e n  r e l l e n o s  d e  f u e n t e s  r a d i a l e s

Los rellenos de fuentes radiales en EasySIGN admiten lo que se denomina “resaltados”. 

A Seleccione un objeto y aplíquele un relleno de fuentes radial.

B Seleccione la herramienta para ajustar rellenos de fuentes y coloque el cursor encima del último nodo. 

C Presione el botón secundario del ratón y, en el menú contextual, seleccione la opción “Activar o
desactivar resaltado”.

D Aparecerá un nodo que indica la posición del punto brillante.

E Mueva este punto brillante como desee.

F Compare el relleno de fuentes con el que se menciona en "A" (el primer paso anterior).

Fusionar mapas de bits
F u s i o n a r  m a p a s  d e  b i t s  

A partir de la versión 5, también se pueden fusionar los mapas de bits. El procedimiento es el mismo que para los
objetos vectoriales. A modo de ilustración, proporcionamos un pequeño ejemplo.

Objetos originales, un mapa de bits y un texto.

Seleccione primero el mapa de bits y, a continuación, el texto. Después, seleccione la opción de menú “Editar,
Fusionado, Enmascarar la última selección”.
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Con la combinación de teclas CTRL+CLICK o el Administrador de objetos, todavía se puede editar el texto y el mapa
de bits.

También puede aplicar varias fusiones.

Si su licencia lo permite, pueden aplicarse efectos adicionales a las fusiones, así como al mapa de bits.

Trayectorias abiertas
T r a y e c t o r i a s  a b i e r t a s

Al importar archivos vectoriales (por ejemplo, hojas con la extensión .AI) a EasySIGN, a veces ocurre que no todas
las formas están cerradas donde deberían estarlo. Esto se produce especialmente cuando se utiliza una aplicación
que no tiene filtros de exportación actualizados. Puede resultar muy aburrido tener que corregir esto manualmente si
hay que comprobarlo forma a forma.

En EasySIGN se ha implementado un nuevo procedimiento para esto, muy preciso y que proporciona los máximos resultados.

Procedimiento
Seleccione todos los objetos que desea comprobar. A continuación, seleccione la opción de menú “Editar”,
“Seleccionar trayectorias abiertas”. Si no se selecciona nada, entonces todos los objetos de la hoja están cerrados. Si
queda una selección, puede elegir la opción “Organizar”, “Cerrar trayectorias abiertas”. Se cerrarán todas las
trayectorias abiertas en la selección activa. Esto proporciona un control total sobre el resultado final, frente a hacerlo
automáticamente durante la importación.
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Bloquear objetos

Seleccione el objeto u objetos que desee bloquear.

Seleccione “Organizar, Bloquear selección” (o la opción equivalente del menú contextual del objeto). Los
controladores de selección del objeto se convertirán en pequeños candados y el objeto quedará bloqueado. Cada vez
que seleccione este objeto se mostrarán estos controladores para indicarle que el objeto está bloqueado.

Cuando un objeto esté bloqueado no se podrá mover ni editar accidentalmente. Sobre todo si desea trazar un mapa
de bits será más fácil bloquear temporalmente el mapa de bits que trabajar con capas bloqueadas.

Puede desbloquear un objeto seleccionando “Organizar, Desbloquear selección” o la opción equivalente del menú
contextual. Asimismo, puede desbloquear todos los objetos de una hoja seleccionando “Organizar, Desbloquear todos
los objetos”.

Algunas propiedades de los objetos bloqueados
1 Si su hoja contiene objetos bloqueados el comando “Editar, Seleccionar todo” únicamente seleccionará los

objetos que no estén bloqueados.
2 Los objetos bloqueados se imprimirán o trazarán. Si no desea que se impriman o tracen los objetos tendrá que

emplear capas.
3 Los objetos bloqueados no pueden seleccionarse con una selección de área. Puede seleccionar varios objetos

bloqueados con la tecla “Mayús”.
4 No se pueden seleccionar juntos objetos bloqueados y no bloqueados.
5 No se puede aplicar transformaciones ni efectos especiales a los objetos bloqueados.
6 Puesto que se puede seleccionar un objeto bloqueado, se puede ejecutar un comando del tipo de “Insertar

marcas de recorte alrededor de la selección”.
7 Todas las transformaciones y características de edición están asimismo bloqueadas en el Administrador de

objetos, ya que bloqueó el objeto con todas sus consecuencias.

Seleccionar por tamaño

Puede eliminar de forma rápida objetos de su hoja que coincidan con determinados criterios de tamaño.
Habitualmente ésta es una tarea que requiere mucho tiempo pero es necesaria debido a que tras, por ejemplo, una
vectorización puede haber objetos que sean demasiado pequeños para ser trazados. En lugar de hacerlo
manualmente puede seleccionar “Editar, Seleccionar por, Tamaño...”.
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El cuadro de diálogo presenta dos modos: uno sencillo (ver imagen anterior) y otro avanzado (ver imagen inferior).

1 Aquí puede establecer el tamaño máximo de los objetos que se seleccionarán.
2 Si activa esta opción, se seleccionará una selección ya activa junto con la nueva.
3 Cierra el cuadro de diálogo.
4 Seleccione este botón si desea que se seleccione el resultado.
5 Seleccione este botón si desea que se elimine el resultado.
6 Si eliminó una selección mediante este cuadro de diálogo, puede deshacerse dicha acción aquí.
7 Esto sirve para abrir el modo avanzado.

1 Aquí puede establecer el tamaño mínimo y máximo de una anchura y una altura.
7 Esto sirve para regresar al modo normal.

Seleccionar objetos desde arriba

Esta característica selecciona objetos idénticos que se colocan de manera exacta uno encima de otro. Estos objetos
no pueden detectarse simplemente mirando la hoja. Situaciones como ésta se producen cuando ha pegado el mismo
objeto u objetos varias veces en la misma ubicación o importado un archivo en el que el estilo de relleno y de línea
de un objeto se exportaron como dos formas separadas.

Seleccione el comando “Editar, Seleccionar objetos desde arriba”.

Mapas de bits
M a p a s  d e  b i t s

Mapas de bits de un bit

Los mapas de bits de un bit (blanco y negro) ahora pueden colorearse mediante la paleta de colores. Estos colores
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también pueden imprimirse. 

A Mapa de bits original
B En la paleta de colores, haga clic en el color amarillo (color de relleno) y en el color rojo con el botón

secundario del ratón (color de contorno).
C En orden inverso a la descripción proporcionada en A.

También puede utilizar la herramienta de color para colores de relleno y de contorno con el fin de asignar un color a
un mapa de bits de un bit que no figure en la paleta de colores.

Algunas veces es más cómodo utilizar un mapa de bits de un bit digitalizado directamente como parte de una
impresión en lugar de vectorizarlo previamente. En el proceso de vectorización, puede ser más sencillo colocar un
duplicado en el mapa de bits vectorizado asignándole un color que contraste como referencia para optimizar la
vectorización.

Visualización de mapas de bits

Ahora dispone de cuatro opciones diferentes para los mapas de bits en la vista en marco.

A Borde
B Escala de grises simple
C Escala de grises
D Original

Para encontrar estas funciones seleccione "Calidad" en el menú "Ver".

Brillo y contraste

Este método funciona de la siguiente manera. Seleccione un mapa de bits y haga clic con el botón derecho del ratón.
Seleccione la opción "Ajustar brillo y contraste " del menú desplegable oculto.
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1 Brillo
 Utilice esta opción para retocar el brillo del mapa de bits. 

2 Contraste
 Cuando un mapa de bits aparece demasiado opaco, la diferencia entre los colores oscuros y luminosos puede

ser retocada aumentando este valor.
3 Gamma
 Esta barra de desplazamiento modifica el brillo de los colores en la parte central de la paleta.

4 Saturación
 La saturación es la fuerza o pureza del color.

5 Parámetros RGB
 Cuando un mapa de bits aparece demasiado rojo, demasiado verde, o demasiado azul, se puede utilizar esta

barra de desplazamiento para modificar los valores.
6 Cerrar
 Este botón cierra el cuadro de diálogo.

7 Aplicar
 Este botón aplica las modificaciones en el cuadro de diálogo al mapa de bits.

8 Restablecer
 Esta opción restablece todos los valores del cuadro de diálogo a sus valores iniciales. 

9 Variaciones
 Este botón abre el cuadro el diálogo de variaciones (consulte la descripción siguiente).

10 Gráfico
 Este gráfico muestra una ilustración de la curva de color modificada.

Variaciones

La opción "Variaciones" permite modificar visualmente el equilibrio de color, contraste, saturación, etc. de una mapa
de bits.
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1 Elección original/actual
 Estas dos ilustraciones miniaturizadas en la parte superior de la ventana de diálogo muestran el original y una

previsualización de las modificaciones.
2 Horizontal
 Aquí puede elegir qué posibilidad de filtro desearía mostrar y modificar horizontalmente en el diálogo.

3 Vertical
 Aquí puede elegir qué posibilidad de filtro desearía mostrar y modificar verticalmente en el diálogo.

4 Tamaño del paso
 Aquí puede fijar el tamaño de los pasos para las modificaciones. Cuanto mayor sea el valor, más visible será

cada cambio.
5 Presentación horizontal
 Aquí se presentan las barras de desplazamiento horizontales.

6 Presentación vertical
 Aquí se presentan las barras de desplazamiento verticales.

7 Mostrar recorte
 Active esta opción si desea ver una previsualización de las zonas de la ilustración que podrían perder color

después de la modificación.
8 Aceptar
 Este botón transfiere todas las modificaciones al mapa de bits original y cierra el cuadro de diálogo.

9 Cancelar
 Este botón cierra el cuadro de diálogo sin llevar a cabo ninguna modificación. 

10 Restablecer
 Este botón restablece todos los parámetros que se habían modificado.

El procedimiento es el siguiente 
Supongamos que en la opción "Horizontal" ha elegido "Brillo" y "Vertical" ha elegido "Contraste". Para aplicar una
modificación sólo tiene que hacer clic en una de las ilustraciones miniaturizadas que aparecen debajo.
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Efectos especiales

Es posible aplicar efectos especiales a todos los mapas de bits importados o escaneados. Active el menú del botón
derecho del ratón en un mapa de bits y seleccione la opción "Efectos especiales "; aparecerá un submenú y podrá
elegir cualquiera de los efectos especiales disponibles. 

En el diálogo de efectos especiales encontrará las siguientes opciones.

1 La ventana de la izquierda muestra siempre el original. Cuando el ratón se mueve sobre esta ventana, el
cursor cambia a una "mano"; podrá mover entonces la ilustración en esta ventana para ver otras partes del
mapa de bits.

2 La ventana de previsualización (ejemplo).
3 Este botón obliga al ejemplo.
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4 "Previsualización automática ", cuando esta opción está activada, se muestran de inmediato todas las
modificaciones en el cuadro de diálogo.

5 Utilizando la barra de desplazamiento o tecleando un valor en el cuadro que hay al lado, podrá aumentar o
minimizar el efecto en el original.

6 "Progreso", aquí se muestra el progreso de la aplicación del efecto.
7 "Aceptar", este botón aplica todos los parámetros que han sido modificados al mapa de bits y cierra el cuadro

de diálogo.
8 "Cerrar", este botón cierra el cuadro de diálogo.
9 "Aplicar", este botón aplica todos los parámetros que han sido modificados al mapa de bits y cierra el cuadro

de diálogo.

Convertir objetos a mapa de bits

Un comando directo y fácil de utilizar para convertir cualquier objeto seleccionado de una hoja en un mapa de bits.
Seleccione el objeto o los objetos y después el menú “Editar, Convertir en, Mapa de bits”.

1 Aquí puede establecer el espacio de color como RGB, de un bit, blanco y negro, etc.
2 Aquí puede establecer el tamaño.
3 Aquí puede establecer la resolución.

Después de aplicarlo, todos los objetos seleccionados de la hoja se convertirán en un único mapa de bits.

Modo de mapa de bits

Con este comando puede convertir el modo de mapa de bits en otro. Seleccione los mapas de bits, el comando “Mapa
de bits, Modo” y el espacio de color en el que desee convertir el mapa de bits. Por ejemplo, puede convertir un mapa
de bits RGB en CMYK, uno CMYK en RGB, etc.
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El trabajo con capas

¿Qué es una capa?
Cuando se abre un documento nuevo, se verá un fondo blanco con una zona delimitada llamada hoja de trabajo. En
esta hoja de trabajo se pueden importar varios mapas de bits. Se podrán utilizar estos mapas de bits para crear un
diseño o una imagen. Cuando se trabaja con diez o más mapas de bits, la utilización de las capas puede ahorrar
tiempo y esfuerzos.

Por ejemplo, si se trabaja con unos 60 mapas de bits, al margen de lo rápido que sea el programa, la composición en
pantalla de un mapa de bits llevará tiempo. Si se utilizan capas, se podrán ocultar partes de la composición para
obtener una composición de pantalla más rápida.

Configuración de las capas 
En el menú "Ver" seleccione el comando "Capas".

Al utilizarlo por primera vez se encontrará siempre que hay capas estándar en el diálogo de capas. Estas capas no
pueden ser borradas. Los nombres de estas capas son:

1 Capa principal
2 Capa de línea guía
3 Capa de marca de registro

Al abrir el diálogo, la capa principal siempre está seleccionada y activada. Podrá seleccionar la capa de línea guía y la
capa de marca de registro, cambiar sus niveles y llevar a cabo otras operaciones con las capas, pero no podrá hacer
que éstas sean la capa activa.

Botón Función

Abre un cuadro de diálogo para poder añadir una nueva
capa.

En este cuadro de diálogo se podrán rellenar los siguientes parámetros.

Nombre (1)
Rellene aquí el nombre que desea dar a la capa. Asegúrese de reconocer el nombre posteriormente.

Opciones de capas (2)

Visible (3)
Determina si la capa se mostrará o quedará oculta.
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Bloqueada (4)
No podrá moverse ningún objeto en la capa ni ser editado una vez que haya sido bloqueada.

Permitir impresión (5)
Esta opción determina si la capa puede ser impresa.

Permitir trazado (6)
Esta opción determina si la capa puede ser trazada.

Abre un cuadro de diálogo para poder configurar las propiedades de la capa
seleccionada.

Elimina la capa seleccionada.

 Mueve la capa seleccionada un nivel hacia arriba.

Mueve la capa seleccionada un nivel hacia abajo. 

Mueve los objetos seleccionados de una capa a la capa que ha sido seleccionada en el
cuadro de diálogo.

Copia los objetos seleccionados de una capa a la capa que ha sido seleccionada en el
cuadro de diálogo. 

¿Qué estado puede tener una capa?
Las siguientes ilustraciones explican cual puede ser el estado de una capa.

Seleccionada

Cuando se ha seleccionado una capa podrá utilizar los botones en el cuadro de diálogo para llevar a cabo
operaciones con las propiedades de la capa.

Se puede seleccionar una capa haciendo clic sobre ella.

Activa

Activa significa que cuando se importa una ilustración, por ejemplo, se colocará en la capa activa. Se puede ver que
una capa está activa por el símbolo que hay frente al nombre de la capa.

Una capa se activa haciendo doble clic sobre ella.

Activa y seleccionada
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Add a plotter

To add a plotter select the menu 'File > Device Setup > 'Add Plotter Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.
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Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.

How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.
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To finish the installation of your device, click 'Finish'.

Parámetros del trazador

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Plotter Settings' and click on 'Plot Setting 0'. On the right the available plotter settings will
become visible.
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A Clasificación y optimización

 

1 Sin clasificación
 El objeto será trazado en la misma secuencia en que está dibujado. 
2 Velocidad máxima
 Los distintos objetos se clasifican de forma que pueden ser trazados tan rápido como sea posible.
3 Movimiento del vinilo mínimo
 Los datos se clasifican de forma que se produzca un pequeño movimiento del vinilo durante el trazado. Esto

mejora la precisión del trazado, pero reduce la velocidad
4 Alimentación de papel perforado
 Si el trazador utiliza papel perforado, EasySIGN tiene en cuenta la imprecisión de este sistema.
5 Dentro primero
 Un objeto combinado, por ejemplo la letra "O", tiene el corte interior primero. Esto tiene dos ventajas:

aumenta la calidad del trazado de letras pequeñas y es esencial para obtener un buen acabado, evitando que
las formas se separen.

6 Cuchilla giratoria
 La formas se clasifican de tal forma que se produzca un daño e imprecisión mínimos por parte de la cuchilla

giratoria al alinearse con la hoja.
7 Extensión del borde
 Una forma cerrada se corta a una distancia ajustable desde el principio. Esto simplifica la separación del vinilo
8 Aceptar
 Aplica los parámetros configurados y cierra el cuadro de diálogo.
9 Cancelar
 Cierra el cuadro de diálogo sin aplicar los parámetros.

B Opciones de trazado
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1 Calidad
 La precisión del corte en arcos. Una precisión superior obviamente reduce la velocidad (la "calidad 80" suele

ser la mejor opción).
2 Corte de los bordes de pelado
 Si utiliza bordes de pelado en su hoja de trabajo, aquí podrá indicar si desea trazarlos de forma estándar o no.
3 Trazado relativo
 Coloca automáticamente todos los objetos que desea trazar en el punto cero del trazador.
4 Punto de arranque detrás del trazado
 Esta opción asegura que después de cada trabajo el trazador vuelva con la plumilla detrás de la zona trazada.

Aquí puede especificar el valor correspondiente a la distancia. Esta opción no está disponible en todos los
trazadores.

5 Copias adicionales
 Aquí puede indicar si desea obtener copias adicionales con cada trazado y cuántas.
6 Multicorte
 Aquí puede indicar si desea que el programa utilice cada línea de intersección varias veces y si es así cuántas.

Puede utilizar esta opción para materiales pesados que normalmente no podrían cortarse de una sola vez.
7 Corte del vinilo después del trazado
 Esta opción asegura que el trazador corte el material del rollo después de cada trabajo. Esta opción sólo está

disponible si el trazador la admite.
8 Aceptar
 Aplica los parámetros y cierra el cuadro de diálogo.
9 Cancelar
 Cierra el cuadro de diálogo sin aplicar los parámetros.

C Parámetros del trazador

 

1 Velocidad
 Aquí puede ajustar la velocidad del trazador. Esto tendría efecto principalmente en las líneas largas y rectas.
2 Aceleración
 Aumenta la velocidad del trazador. Aquí se determina la velocidad en las esquinas.
3 Desplazamiento de la cuchilla
 Este es un parámetro para un trazador de cuchilla giratoria. Aquí se configura la distancia del centro al centro

de la cuchilla giratoria.
4 Presión de la cuchilla
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 Es la presión que el trazador ejerce sobre el material.
5 Número de plumilla
 Si el trazador admite varios tipos de plumillas y cuchillas, aquí puede seleccionarlo. Esta opción le permite

elegir entre diversas opciones fijas, sólo podrá seleccionar aquí.
6 Aceptar
 Aplica los parámetros y cierra el cuadro de diálogo.
7 Cancelar
 Cierra el cuadro de diálogo sin aplicar los parámetros.

D Device Specific

 How this dialog will look is dependent on the selected plotter driver.

La mayoría de trazadores no admiten todos los parámetros mencionados aquí. Si algún parámetro queda en sombra,
indica que el trazador no lo admite. Es posible que pueda configurar el valor correcto en el trazador. Por favor
consulte el manual de su trazador para hacerlo.

Si retira la marca en la opción "Utilizar parámetros predefinidos", se utilizarán los parámetros estándar del trazador. 

CMS (Sistema de administración del color)

Información general de CMS
I n f o r m a c i ó n  g e n e r a l  d e  C M S

EasySIGN se proporciona junto con un CMS (Sistema de administración del color) avanzado. Después de la
instalación de EasySIGN se activa CMS de manera predeterminada.

¿Qué es CMS?
Cuando se trabaja con el color, es esencial una representación del color coherente en distintos dispositivos, como
monitores e impresoras. Dichos dispositivos deben ser capaces de intercambiar información colorimétrica para lograr
un resultado final predecible.

El color es una apreciación subjetiva del ojo humano. Cada dispositivo de un proceso de producción cuenta con una
gama de colores diferente. Es posible que un monitor pueda mostrar colores que su impresora no puede reproducir.
CMS se asegurará de que su monitor sólo muestra los colores reproducibles en su impresora.

La gama de colores que un dispositivo puede reproducir se llama espectro. Un monitor tiene un espectro distinto al de
una impresora en color. Esto significa que una hoja puede incluir colores que se muestren correctamente en un
monitor pero que no puedan reproducirse en un dispositivo de salida. Otro problema es que el espectro de color de
una impresora puede ser diferente al de otra. Incluso pueden existir diferencias en impresoras de la misma marca y
modelo. Sólo puede lograrse una representación correcta de los colores cuando se tienen en cuenta los diferentes
espectros de todos los dispositivos que utiliza.

El uso de CMS reduce al mínimo la diferencia entre los dispositivos de un proceso de producción.

¿Qué es un perfil?
Un perfil es un archivo que sirve para describir las propiedades colorimétricas de un dispositivo como una impresora
en color. Los perfiles de color suelen tener el formato de archivo ICC (Consorcio internacional del color) o ICM
(Coincidencia de color de imagen). EasySIGN admite ambos formatos además del suyo interno propio que funciona
sin problemas con los perfiles ICC e ICM. Con este formato interno puede ajustar los perfiles ICC e ICM como mejor
le convenga, un proceso que de otra forma requeriría el uso de software caro y complejo.

Cómo se instala un perfil
Cuando dispone de un perfil proporcionado por terceros puede instalarlo en EasySIGN copiándolo en la carpeta
“\EasySIGN\Shared\Profiles\”.  O bien, puede instalar le perfil para todas las aplicaciones haciendo clic con el botón

secundario en el archivo y eligiendo ‘Instalar’.

¿Qué es la "Opción de procesamiento"?
La opción de procesamiento le permite elegir el método que EasySIGN debe utilizar al convertir colores para
adaptarse al espectro de distintos dispositivos. El mayor problema que encontrará es que algunos colores pueden
mostrarse en un monitor pero no pueden reproducirse en la impresora. Puede elegir uno de estos cuatro métodos:
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1 Perceptual

Todos los colores del espectro de un dispositivo se escalarán al espectro siguiente,
manteniéndose así intacta la relación entre los colores. Se recomienda este método a la hora
de reproducir mapas de bits digitalizados o importados.

2 Colorimétrico relativo

Este método dejará intactos los colores que coinciden en ambos espectros. Se ajustarán los
colores que queden fuera del espectro del dispositivo de salida para que coincidan, con lo que
se mantendrá el brillo y el color a costa de la saturación. Este método es preferible si es
necesaria una representación del color precisa, por ejemplo a la hora de imprimir colores
planos.

3 Saturación

Escala el espectro de origen al espectro de destino pero conserva la saturación relativa en
lugar del matiz, de forma que al escalar a un espectro menor, el matiz puede variar. Esta
opción de procesamiento está diseñada fundamentalmente para gráficos empresariales, en los
que los colores brillantes saturados son más importantes que la relación exacta entre los
colores

4 Colorimétrico absoluto

El procesamiento colorimétrico absoluto reproduce los colores incluidos en el espectro con
exactitud, y adapta los colores que queden fuera del espectro al matiz reproducible más
próximo, con lo que se sacrifica la saturación y posiblemente la luminosidad. Este método tiene
en cuenta también el color del papel a la hora de imprimir.

Parámetros
En el menú, seleccione “Archivo, Parámetros” y haga clic en la ficha “Administración de color”.

1 Habilitar administración de color
Aquí puede establecer si cada nueva hoja que cree debe utilizar la administración de color.

2 Monitor
Aquí puede establecer si EasySIGN debe utilizar el perfil del monitor del sistema (establecido
en Windows) u otro perfil definido por el usuario.

3 Directiva de importación de mapa de bits
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Aquí puede establecer cómo debe administrarse el color de un mapa de bits cuando se
importe.

Preguntar al usuario
Cuando importe,  EasySIGN le preguntará la acción que desea realizar.

No administrar el color
Cuando importe el mapa de bits no podrá administrar el color, aunque el mapa de bits tenga
un perfil incrustado.

Usar valores predeterminados del documento
También se aplicarán a este mapa de bits los parámetros del documento.

Usar perfil incrustado
Si el mapa de bits tiene un perfil incrustado se utilizará éste, si no, se aplicarán los parámetros
del documento.

Parámetros
Seleccione el menú “Ver, Parámetros” y haga clic en la ficha “Administración de color”:

1 Habilitar administración de color
Esta opción activa o desactiva la administración de color.

2 Perfil de mapa de bits

RGB
Aquí puede elegir el perfil utilizado para mapas de bits RGB (de 24 bits).
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CMYK
Aquí puede elegir el perfil utilizado para mapas de bits CMYK.

Opción
Sirve para seleccionar la opción de procesamiento de los mapas de bits.

3 Perfil del vector

RGB
Aquí puede elegir el perfil utilizado para vectores con un estilo de relleno o de plumilla RGB.

CMYK
Aquí puede elegir el perfil utilizado para vectores con un estilo de relleno o de plumilla CMYK.

Opción
Sirve para seleccionar la opción de procesamiento de los datos vectoriales.

4 Establecer como predeterminada
Si se activa esta opción, también se utilizarán los parámetros actuales cuando se cree un
nuevo documento.

5 Restablecer
Restaura los valores predeterminados de este cuadro de diálogo.

Sugerencia importante
Si desea hacer coincidir los colores con el resultado final de la manera más precisa posible le aconsejamos que utilice
únicamente colores CMYK en el resultado final. El espectro de colores RGB es demasiado amplia para la mayoría de
las impresoras, por lo que hacer coincidir los colores se convierte en una tarea innecesariamente difícil.  Cuando su
cliente le proporcione un diseño, pídales también los colores CMYK.

Mapas de bits y perfiles

Cuando importe un mapa de bits en EasySIGN se utilizarán los perfiles incrustados. Puede ajustar el parámetro de
cada mapa de bits. Seleccione el mapa de bits y elija el menú “Mapa de bits”, “Administración del color”. 

1 No usar el perfil ICC
El mapa de bits no utilizará CMS.

2 Usar valores predeterminados del documento
El mapa de bits utilizará los parámetros CMS de la hoja.

3 Usar otro perfil
El mapa de bits utilizará el perfil seleccionado en lugar del seleccionado en la hoja.

4 Usar perfil incrustado
Si el mapa de bits tiene un perfil incrustado, puede seleccionarse esta opción. Así, el mapa de
bits utilizará el perfil que se importó junto con él.

5 Opción de procesamiento
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El mapa de bits utilizará otra opción de procesamiento diferente a la establecida en la hoja.

6 Exportar perfil
Cuando el mapa de bits tiene un perfil incrustado, éste puede exportarse. Así, también podrá
utilizar el perfil en el resto de la hoja.

Mostrar y exportar CMS
M o s t r a r  y  e x p o r t a r  C M S

El sistema de administración del color (CMS) de EasySIGN se ha mejorado para que su uso sea aún más intuitivo.

Parámetros de presentación
El cuadro de diálogo de parámetros para la administración del color (disponible mediante “Archivo”, “Parámetros” y, a
continuación, la ficha “Administración del color”) tiene ahora una nueva opción:

Administrar RGB como CMYK

Si activa esta opción, los colores RGB se mostrarán en la pantalla tal como se imprimen en, por ejemplo, una
impresora de escritorio. Esta opción estaba sólo disponible con una licencia de impresión en versiones anteriores
(Corrección de color).

Esta opción DESACTIVADA:

Esta opción ACTIVADA:
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Si se utiliza esta opción, la presentación en pantalla será evidentemente más lenta debido a que la aplicación debe
realizar varios cálculos adicionales.

Exportar CMS (administración del color)
Para que tenga un mayor control sobre la administración del color, el cuadro de diálogo de parámetros (disponible
mediante “Archivo”, “Parámetros”) tiene la ficha adicional “Administración del color: Salida”. En esta ficha encontrará
las siguientes opciones:

Al exportar

Exportar
colores
como:

Si esta opción está activa, todos los colores se exportarán como CMYK o RGB. Si no lo
está, los colores se exportarán sin cambios. Esta opción sólo afecta a la exportación a
formatos de vectores como .AI, .EPS y .PDF.

Si ha activado la opción “Administrar RGB como CMYK” en los parámetros de
administración del color, se recomienda activar también esta opción para la
coherencia, eligiendo CMYK.

En la conversión de RGB a CMYK, o viceversa, se administrará el color con los perfiles
elegidos. Si está desactivada la administración del color, se utilizará otra conversión.

Al imprimir en impresoras PostScript

Exportar
colores
como:

Si esta opción está activa, todos los colores se enviarán a la impresora como CMYK o
RGB. Si no lo está, todos los colores se enviarán tal cual están diseñados en la hoja.

Si ha activado la opción “Administrar RGB como CMYK” en los parámetros de
administración del color, se recomienda activar también esta opción para la
coherencia, eligiendo CMYK.

En la conversión de RGB a CMYK, o viceversa, se administrará el color con los perfiles
elegidos. Si está desactivada la administración del color, se utilizará otra conversión.

Al imprimir en 'EasySIGN Print Server'

Exportar
colores
como:

Si esta opción está activa, todos los colores se enviarán a EasySIGN Print Server

como CMYK o RGB. Si no lo está, todos los colores se enviarán tal cual están
diseñados en la hoja.

Dado que EasySIGN Print Server tiene un sistema de administración del color aún más

avanzado que EasySIGN, se recomienda no utilizar esta opción y dejar la

administración del color a EasySIGN Print Server.

En la conversión de RGB a CMYK, o viceversa, se administrará el color con los perfiles
 elegidos. Si está desactivada la administración del color, se utilizará otra conversión. 
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Administrador de producción

Todos los resultados de salida de EasySIGN se controlan con el Administrador de producción. Cuando envía un
trabajo desde EasySIGN se abrirá automáticamente el Administrador de producción (si no estaba ya abierto) y el
trabajo se mostrará con su estado actual. Si desea guardar un trabajo para una reutilización posterior, tiene que
activar la opción “Mantener en el Administrador de producción” en el cuadro de diálogo de EasySIGN. Así, el trabajo
seguirá en el Administrador de producción incluso después de haberse completado, con lo que podrá disponer del
tiempo suficiente para guardarlo.

Con ayuda del Administrador de producción podrá mantener en funcionamiento simultáneo varios dispositivos de
salida.

1 Menú.
2 Barra de botones.

Abre un trabajo guardado anteriormente. Debe asegurarse de abrir un trabajo con el mismo
dispositivo que seleccionó al guardar el trabajo. Si abre un trabajo con un dispositivo de salida
distinto el resultado será impredecible. Lo más aconsejable es guardar un trabajo con el
nombre del dispositivo de salida como parte del nombre del archivo. 

Guarda un trabajo seleccionado como un archivo. De esta manera no tendrá que esperar a que
EasySIGN vuelva a calcular un trabajo repetitivo. Basta con que abra el archivo y lo active.
Tenga en cuenta que estos archivos de trabajo pueden llegar a tener un tamaño considerable.
Elimínelos cuando ya no sean necesarios.

Activa un trabajo seleccionado que está en pausa.

Pausa un trabajo seleccionado que está activo.

Detiene un trabajo seleccionado que está activo.

Elimina un trabajo seleccionado.

Deja un trabajo en el Administrador de producción aunque se haya completado.

Estos botones le facilitan el control de la prioridad de los trabajos. Puede subir y bajar trabajos
en la lista. Se enviará en primer lugar el trabajo situado en la parte superior de la lista.
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3 Dispositivos de salida y trabajos disponibles.
Se agrega un icono por cada dispositivo instalado de EasySIGN. Debajo de dichos iconos puede ver los
trabajos que están activos actualmente.

4 Estado de un trabajo seleccionado.
Aquí podrá encontrar todas las propiedades, incluida la velocidad, el tamaño y la hora de inicio.

Puede ver las siguientes opciones adicionales a través del primer menú de la barra de menús.
1 Pausar todo.
2 Eliminar todos los trabajos.

No se puede cerrar el Administrador de producción mientras siga habiendo trabajos en él, estén activos o no.
Con este comando puede borrar el contenido del Administrador de producción, con lo que se perderán todos
los trabajos no finalizados o que sigan activos.

3 Configuración

1 Esta opción asegura que sólo se envía un trabajo al dispositivo de salida cuando EasySIGN ha terminado de
calcular todo el resultado de salida.

2 Esta opción asegura que se utilizará el administrador de impresión de Windows™ en lugar del administrador de
impresión interno.

3 Aquí puede establecer varias carpetas para los archivos temporales. Si no se indica ninguna se utilizará la
carpeta temporal predeterminada de Windows™.

Imprimir ventanas

Al elegir el comando "Imprimir ventanas" del menú "Archivo", aparece el cuadro de diálogo de impresoras estándar
de Windows. La única diferencia es que hemos añadido varias opciones de funcionamiento. En la parte inferior del
diálogo encontrará varias opciones adicionales que explicaremos con mayor detalle aquí.

Todo
Esta opción imprime todo lo que hay en la hoja de trabajo.

Selección
Esta opción imprime los objetos de la hoja de trabajo que han sido seleccionados.
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Tamaño
Aquí se puede indicar el tamaño que desea que tenga la hoja de trabajo impresa.

Adaptar a página
Cuando se activa esta opción, todos los objetos de la ventana activa (los objetos dentro y alrededor de la hoja de
trabajo) se reducen en tamaño para adaptarse al formato de papel de la impresora de Windows.

Mosaico
Si se activa esta opción, toda la hoja de trabajo se divide automáticamente en varios mosaicos. Estos se imprimen
solapados 5 mm a cada lado.

Imprimir líneas de dibujo
Esta opción no imprime la hoja de trabajo en color o tonos de gris, como es estándar, sino todos los objetos como
gráficos de líneas de dibujo.

Sistema de posicionamiento óptico (OPOS)

En EasySIGN puede utilizar una combinación de “Imprimir y cortar” para su impresora y trazador. EasySIGN admite
Sistemas de posicionamiento óptico predefinidos y personalizados. 

Los sistemas predefinidos los proporciona el fabricante de trazadores. Cuando seleccione un sistema predefinido
EasySIGN utilizará las especificaciones proporcionadas por el fabricante. Cuando utilice un sistema personalizado no
habrá limitaciones especiales.

Activar el sistema
Seleccione el comando “Ver, Configuración” y, a continuación, la ficha “Marcas de recorte”.
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1 Mostrar u ocultar las marcas de recorte.
2 Bloquear las marcas de recorte en la página.

Con esta opción activada se recalcularán las marcas de recorte cada vez que se produzca un cambio de
tamaño de página o de orientación.

3 Aquí puede seleccionar el sistema que desea utilizar.
4 Aquí puede establecer las dimensiones de marcas de recorte. 

Cuando haya seleccionado un sistema predefinido el tamaño de las marcas de recorte queda restringido por
las limitaciones especificadas por el fabricante.

Usar el sistema
La hoja deberá contener objetos que se puedan trazar e imprimir.

Active el sistema OPOS (“Ver, Configuración”, “Marcas de recorte”).
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A continuación, seleccione sólo los objetos que desee imprimir y después el comando “Archivo, Impresión a todo
color”. En el cuadro de diálogo, active la opción “Sólo selección” y la opción “Imprimir y cortar marcas de recorte”. A
continuación, seleccione “Imprimir”.
Después de imprimir la hoja, tome el material de su impresora y colóquelo en su trazador. El sistema de
posicionamiento óptico varía para cada trazador. Para conocer instrucciones más precisas, lea el manual de su
trazador.

Seleccione en la hoja el objeto que desee trazar y después el comando “Archivo, Trazar”. En el cuadro de diálogo,
active la opción “Sólo selección” y “Trazado alineado”. A continuación, seleccione “Trazar”.

Seguidamente, coloque el cabezal de su trazador sobre la primera marca de recorte y siga los pasos (si los hay) del
panel de control del trazador. 

Mover las marcas de recorte
Puede mover las marcas de recorte con ayuda de la herramienta de paneles.

Advertencia
No mueva ninguno de los objetos de la hoja entre el trabajo de impresión y el de trazado, ya que tendría resultados
impredecibles.

Enmascarar

El enmascarado es una forma de cortar mapas de bits y otros vectores utilizando vectores y sin dañar el original. Por
ejemplo: cuando coloca un mapa de bits sobre otro mapa de bits, siempre tendrá los bordes del límite del rectángulo
que tiene que tener en cuenta. Si por ejemplo, desea editar las dos fotografías de debajo de forma tal que la cara del
hombre quede de forma creíble sobre el fondo, sólo podrá conseguirlo con el enmascarado. Sin embargo, las
máscaras no pueden ser trazadas ni imprimidas.

Si intenta hacer esto sin enmascarar, siempre podrá ver las separaciones directas de los mapas de bits como se
muestra a continuación.
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Para conseguir que la ilustración del hombre quede de forma realista sobre el fondo, debe dibujar una línea que siga
el contorno de la cara.

Cuando haya dibujado el contorno tendrá que asegurarse de que sólo se seleccione el mapa de bits. En el menú
"Organizar" seleccione la opción "Enmascarar" y a continuación el comando "Poner en la máscara"; el cursor cambia
de forma y ahora podrá seleccionar el objeto que servirá de máscara. Todo lo que quede fuera de la máscara no se
mostrará, (ni imprimirá).

Cuando coloque el objeto enmascarado de arriba sobre la otra fotografía verá el resultado final

Herramientas de dibujo

Herramienta de dibujo “Bezier”
H e r r a m i e n t a  d e  d i b u j o  “ B e z i e r ”  

Se puede crear casi cualquier forma con este "lápiz digital". La utilización de este lápiz es algo más complicada que
un lápiz normal, pero por otro lado tiene muchas más ventajas. Cuando se dibuja con un lápiz común, la firmeza del
agarre determina la apariencia del flujo de una curva. Un lápiz digital siempre tiene un agarre firme, sólo tiene que
determinar la forma. 

Utilización

Seleccione la "Herramienta de dibujo Bezier" en la barra de herramientas. El cursor cambiará de forma como se
muestra.

Utilice este cursor para hacer clic en alguna zona de la hoja de trabajo (1), suelte el botón del ratón y muévase a una
ubicación distinta en la hoja de trabajo (2). Haga clic nuevamente con el cursor en dicha ubicación en particular y
haga clic una vez más con el botón derecho del ratón para soltar la línea (3). Ahora tiene una línea recta en la hoja
de trabajo. Si desea que esta línea sea exactamente horizontal o vertical (con pasos entre medias de 15 grados)
mantenga pulsada la tecla CTRL durante el movimiento del ratón. 
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Dibujar una línea curva es algo más complicado, pero después de practicar un par de veces este método le parecerá
lógico y fácil de llevar a cabo.
Haga clic una vez en la hoja de trabajo (1) y mueva el ratón una distancia corta a una ubicación distinta sin soltar el
botón del ratón (2). Suelte el botón del ratón y muévalo a un punto en la hoja de trabajo donde deberá hacer clic una
vez más con el botón izquierdo del ratón para completar la operación (3) y nuevamente el botón derecho del ratón
soltará la línea. Ahora tendrá una línea de flujo curvo.

Por supuesto no podemos describir aquí todas las posibilidades, pero estos dos métodos básicos deberían permitirle
dibujar prácticamente cualquier forma existente. Encontrará que esta forma de dibujar le permite trabajar mucho
mejor, más rápidamente y de forma más simple que con cualquier otro método. Sólo tiene que recordar unas
cuantas cosas:

1 Hacer clic e inmediatamente después soltar el botón del ratón después de un movimiento, da una línea recta.
2 Hacer clic y mover primero un poco manteniendo pulsado el botón del ratón da una línea curva después del

segundo movimiento.
3 Para soltar una línea (para detener), hacer clic una vez con el botón derecho del ratón. 

Herramienta “Scribble”
H e r r a m i e n t a  “ S c r i b b l e ”

Esta herramienta funciona de la misma forma que un lápiz común. Todos los movimientos hechos con el ratón se
transfieren a la hoja de trabajo.

Utilización

Seleccione la "Herramienta “Scribble”" en la barra de herramientas. El cursor cambiará su forma como se indica a
continuación.

A continuación haga clic en alguna zona de la hoja de trabajo con este cursor y empiece a dibujar. El resultado de
este método de dibujo por lo general deberá ser retocado con las herramientas de arrastre para eliminar las
imprecisiones de los movimientos del ratón.

Herramienta de dibujo Rectángulo
H e r r a m i e n t a  d e  d i b u j o  R e c t á n g u l o  

La herramienta de dibujo rectángulo es una forma rápida de dibujar un rectángulo o un cuadrado. En EasySIGN un
rectángulo es un objeto con sus propiedades específicas. Esto significa que un rectángulo es más que un vector, como
por ejemplo, una forma hecha con la "Herramienta de dibujo Bezier". En el caso de un rectángulo por ejemplo, puede
utilizar las herramientas de arrastre o un diálogo para redondear las esquinas y determinar su apariencia.
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Utilización

Seleccione la “Herramienta de dibujo rectángulo” en la barra de herramientas. El cursor cambiará como se indica a
continuación.

Haga clic con el cursor en alguna parte de la hoja de trabajo (1) y mueva el ratón sin soltarlo. Después de soltar el
cursor con el ratón aparecerá un rectángulo en la hoja de trabajo (2). Si hace lo mismo que (1) y (2), pero ésta vez
utilizando la tecla CTRL, el mismo movimiento dejará detrás un rectángulo (3). Si mantiene pulsada la tecla
Mayúsculas durante el arrastre, el rectángulo se dibujará desde el centro.

Después de dibujar un rectángulo podrá modificar los puntos de la esquina utilizando las herramientas de arrastre o
un cuadro de diálogo. Para hacerlo, seleccione el rectángulo y haga clic una vez con el botón derecho del ratón.
Desde el menú desplegable oculto que aparecerá debe seleccionar el comando "Propiedades", y se presentará el
siguiente cuadro de diálogo.

En este cuadro de diálogo encontrará los siguientes parámetros:
1/2 Aquí puede determinar la longitud y altura del rectángulo.

3 En este cuadro puede determinar el radio de las esquinas.
4 Aquí puede determinar la apariencia de la esquina.
5 Cuando haga clic en el botón "Cerrar" se cerrará el diálogo sin copiar los parámetros que ha configurado.
6 El botón "Aplicar" transfiere los parámetros que ha configurado al rectángulo sin cerrar el cuadro del diálogo.
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Podrá ver los parámetros aplicados directamente en pantalla.

También podrá redondear las esquinas o cambiar la forma utilizando la herramienta de arrastre.

Seleccione la herramienta de arrastre.

La cara del rectángulo cambiará (1) y verá que aparecen ocho puntos de anclaje. Seleccione uno de los puntos de
anclaje en la esquinas del objeto y muévalo a lo largo de la línea del rectángulo (2) manteniendo pulsado el botón.
Las esquinas quedarán ahora redondeadas. Cuando utilice la herramienta de selección para distorsionar un
rectángulo, las esquinas también se distorsionarán. Si hace lo mismo con la herramienta de arrastre (3) sólo
cambiará la escala horizontal o vertical del rectángulo, las esquinas permanecerán iguales.

Herramienta de dibujo Círculo
H e r r a m i e n t a  d e  d i b u j o  C í r c u l o  

La herramienta de dibujo círculo es una forma rápida de dibujar una elipse o un círculo. En EasySIGN una elipse es
un objeto con sus propiedades específicas, como un rectángulo.

Utilización

Seleccione la  "Herramienta de dibujo Círculo” en la barra de herramientas. El cursor cambiará como se muestra a
continuación.

El método de dibujo es idéntico al de dibujo de un rectángulo, con la única diferencia que ahora estará dibujando
círculos y elipses en vez de cuadrados y rectángulos.

Dibuje un círculo manteniendo pulsada la tecla control durante el arrastre.

Asegúrese de que el círculo esté seleccionado y a continuación seleccione las herramientas de arrastre. Mueva el
ratón a lo largo del círculo, pero asegúrese de mantenerse dentro del radio del círculo con la herramienta de arrastre.
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Ahora ha dibujado una "porción de tarta". Haga lo mismo, pero esta vez asegúrese de mantenerse fuera del círculo
con la herramienta de arrastre.

Ahora ha dibujado un "arco".

Dibuje un círculo nuevo y selecciónelo con la herramienta de arrastre. Seleccione el punto de anclaje inferior y
muévalo hacia arriba, haga lo mismo con el punto de anclaje a la derecha pero arrástrelo a la izquierda.

De esta forma podrá convertir un círculo en una elipse. Si desea cambiar la elipse nuevamente en un círculo, pulse la
tecla Mayúsculas y seleccione el punto de anclaje de la derecha o de la parte inferior. Moviendo el ratón podrá volver
a convertir el objeto en un círculo y al mismo tiempo modificar la escala del objeto de manera integral. Si hace lo
mismo pero esta vez con la tecla Control, la forma del objeto seguirá siendo la misma, pero su escala cambiará de
manera integral.

Estas propiedades pueden configurarse de  la misma forma que con el rectángulo utilizando un cuadro de diálogo.
Para hacerlo haga clic con el botón derecho del ratón en el círculo y seleccione el elemento del menú "Propiedades"
para llamar a este cuadro de diálogo.

Herramienta de dibujo Estrella
H e r r a m i e n t a  d e  d i b u j o  E s t r e l l a  

También puede cambiar la forma de una estrella utilizando las herramientas de dibujo o haciendo clic en el objeto con
el botón derecho del ratón y eligiendo la opción Propiedades. Esta operación abre un diálogo en el que podrá
determinar numéricamente las propiedades del objeto.

Utilización
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Seleccione la "Herramienta de dibujo Estrella" en la barra de herramientas. El cursor cambiará como se indica a
continuación.

Coloque el cursor en algún lugar de la hoja de trabajo y dibuje la estrella manteniendo pulsado el botón izquierdo del
ratón y haciendo un movimiento de arrastre.

A continuación seleccione la herramienta de arrastre y mueva el punto de anclaje derecho a lo largo del contorno de
la estrella.

De esta forma podrá aumentar el número de puntos de la estrella. Cuando realice el movimiento en la otra dirección
el número de puntos de la estrella se reducirá. A continuación seleccione el punto de anclaje a la izquierda del
anterior y muévalo hacia la parte exterior de la estrella.

De esta forma podrá modificar el radio interior de la estrella. Ahora seleccione el punto de anclaje izquierdo y mueva
el ratón hacia el centro de la estrella.
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De esta forma podrá modificar el radio exterior del círculo. Mediante ambos métodos podrá reducir o aumentar el
radio del círculo.

Herramienta de dibujo Polígono
H e r r a m i e n t a  d e  d i b u j o  P o l í g o n o  

De igual forma que con los demás objetos en EasySIGN, se puede editar un polígono utilizando el ratón o un cuadro
de diálogo.

Utilización

Cuando se selecciona la "Herramienta de dibujo polígono " en la barra de herramientas, el cursor cambiará como se
indica a continuación.

El dibujo con esta herramienta y sus propiedades son idénticos a los de la herramienta estrella.

Herramientas de dibujo Flecha
H e r r a m i e n t a s  d e  d i b u j o  F l e c h a

De igual forma que con los demás objetos en EasySIGN, se puede editar una flecha de  forma repetida utilizando el
ratón o un cuadro de diálogo.

Utilización

Si seleccione la "Herramienta de dibujo Flecha" en la barra de herramientas, el cursor cambiará como se indica a
continuación.

Tanto el dibujo con esta herramienta como sus propiedades son idénticos a los de los otros objetos de EasySIGN. La
única gran diferencia entre el objeto “flecha”  y los demás objetos es el número de puntos de anclaje de control.
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A Puede mover este punto de izquierda a derecha para modificar el punto de la flecha.
B Puede mover este punto en todas las direcciones para modificar la proyección del  punto de la flecha. Si utiliza

la tecla Mayúsculas durante el arrastre, el punto "C" será llevado a lo largo de la misma distancia y en la
misma dirección.

C Puede mover este punto en todas las direcciones para determinar la anchura del frontal de la estrella y la
sangría del punto de la flecha. Si pulsa y mantiene pulsada la tecla Control durante el movimiento, se moverá
el objeto, (dependiendo de la dirección en que se mueva) a lo largo de una línea horizontal o vertical.

D Este punto tiene influencia en la longitud de la cola de la flecha. Si utiliza la tecla Mayúsculas durante el
arrastre, el punto "C" se llevará a lo largo de la misma distancia y en la misma dirección.

E Este punto determina la sangría de la cola de la flecha.
F Este punto asegura que pueda moverse el objeto cuando se utilice la herramienta de arrastre.

Herramienta Espiral
H e r r a m i e n t a  E s p i r a l

Con la herramienta Espiral puede dibujar espirales de tipo normal y especial.

Uso

Seleccione la herramienta Espiral en la caja de herramientas y haga clic y arrastre para dibujar una espiral. Si
mantiene presionada la tecla Control mientras dibuja, el radio X e Y se mantendrán iguales.

Una vez dibujada la espiral puede utilizar la herramienta de arrastrar para ajustar el número de curvas, entre otras
propiedades.
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Si utiliza el cuadro de diálogo de propiedades podrá obtener más resultados de esta forma. Seleccione una espiral y,
a continuación, la opción “Propiedades” del menú contextual.

1 Posición X e Y en la hoja. 

2 Ángulo de principio y de fin.

3 Radio horizontal, vertical e interior de la espiral. 

4 Número de curvas. 

5 Dirección. 

6 Tipo

Constante

Exponencial

7 Forma

Aquí puede combinar distintas formas superiores e inferiores en una nueva forma de espiral única.
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Pincel de vectores
P i n c e l  d e  v e c t o r e s

El Pincel de vectores es una herramienta rápida y cómoda para el retoque de vectores.

Uso

Seleccione la herramienta Pincel de vectores en la barra de herramientas. El cursor cambiará de forma y se mostrará
la siguiente barra de herramientas.

Aquí puede establecer la anchura y la forma del pincel. Haciendo clic y arrastrando puede pintar una forma de
vectores de la misma manera que pintaría con un pincel real. Los objetos resultantes pueden utilizarse para
fusionarse con objetos que desee retocar.

Haciendo clic, soltando el ratón y arrastrando, puede pintar líneas rectas. Cuando utilice la tecla Control puede
restringir estas líneas a ángulos de 15 grados. 
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Borrador de vectores
B o r r a d o r  d e  v e c t o r e s

El Borrador de vectores es una herramienta para editar formas de vectores abiertas y cerradas.

Uso

En primer lugar, seleccione uno o varios objetos con los que desee utilizar el borrador y, a continuación, seleccione la
herramienta Borrador de vectores en la caja de herramientas. El cursor cambiará de forma y se mostrará la siguiente
barra de herramientas. 

Aquí puede establecer la anchura y la forma del borrador. Haciendo clic y arrastrando puede empezar a borrar partes
de los objetos seleccionados.

Puede utilizar el borrador con cualquier objeto, incluso texto, grupos y efectos complejos. Observe que cuando utilice
el borrador todos los objetos se convertirán en curvas. Incluso puede utilizar el borrador con mapas de bits. Los
datos reales del mapa de bits no cambiarán y éste será colocado en un contenedor con forma de máscara.

Haciendo clic, soltando el ratón y arrastrando, puede pintar líneas rectas. Cuando utilice la tecla Control puede
restringir estas líneas a ángulos de 15 grados.



140 EasySIGN

Edición de las herramientas de arrastre y nodos

Edición de las herramientas de arrastre y nodos
E d i c i ó n  d e  l a s  h e r r a m i e n t a s  d e  a r r a s t r e  y  n o d o s

Todos los objetos de EasySIGN han sido creados a partir de elementos básicos llamados trayectorias. De esta forma,
una línea/curva es parte de una línea entre dos nodos.

Se pueden utilizar las herramientas de arrastre para cambiar las características de la trayectoria y los nodos. De esta
forma se podrá cambiar la forma de un objeto; una línea recta puede cambiarse a una línea curva y a continuación
puede recibir la forma deseada.

Si desea cambiar la forma de un objeto utilizando "Editar, Herramientas de arrastre”, el objeto primero debe ser
transformado en una curva. Encontrará esta opción en el menú “Convertir a, Curvas”. Esto no es necesario para
objetos que han sido dibujados, porque se dibujan directamente en curvas. Los rectángulos, círculos y objetos de
este tipo deben ser primero transformados en curvas. Si los objetos están agrupados primero deberán ser retirados
del grupo.

Encontrará el símbolo de la herramienta de arrastre en la barra de herramientas, y tiene la siguiente apariencia.

Cuando haya seleccionado las herramientas de arrastre aparecerá la siguiente ventana flotante.

En esta ventana encontrará las siguientes opciones:

Añadir nodos
A ñ a d i r  n o d o s

Seleccione la opción en la ventana y el cursor cambiará a un cursor de arrastre con un "+" a lo largo de él. Cualquier
parte de una línea en la que haga clic con el cursor añadirá un nodo adicional. Cuando haya seleccionado dos nodos,
se añade un nodo en el centro de la curva. Cuando haya terminado de añadirlos puede salir de este modo haciendo
clic en la hoja de trabajo.

Eliminar nodo
E l i m i n a r  n o d o

Seleccione el nodo o los nodos que desea eliminar y a continuación seleccione esta opción.
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Abrir forma
A b r i r  f o r m a

Seleccione la opción en la ventana y el cursor cambiará a un cursor de arrastre con "tijeras" a lo largo de él. Cada
línea con la que haga clic con el  cursor se cortará y quedará abierta. Cuando haya terminado de cortar puede salir
de este modo haciendo clic en la hoja de trabajo.

A línea
A  l í n e a

Seleccione la línea curva que desea transformar en una línea recta y a continuación seleccione esta opción en la
ventana.

A curva
A  c u r v a

Seleccione la línea recta que desea transformar en una línea curva y a continuación seleccione esta opción en la
ventana.

Cerrar nodo
C e r r a r  n o d o

Seleccione los nodos que desea cerrar y a continuación seleccione esta opción en la ventana. Si ha seleccionado más
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de dos nodos, se cerrarán los nodos más cercanos entre sí. Si ha seleccionado dos nodos, el último nodo
seleccionado se utilizará como determinador de la ubicación. Esto significa que cuando utilice la tecla Mayúsculas para
seleccionar dos nodos, el último nodo seleccionado permanece en su ubicación actual y el nodo que seleccionó
primero se mueva hacia esta ubicación. Los parámetros son opcionales.

Interrupción de nodos
I n t e r r u p c i ó n  d e  n o d o s

Seleccione los nodos que desea interrumpir y a continuación seleccione esta opción de la ventana.

Nodo enfocado
N o d o  e n f o c a d o

Seleccione uno o más nodos que desee enfocar y a continuación seleccione esta opción de la ventana. Un nodo
enfocado significa que sólo se cambia el asa de control que edite con el ratón, el asa al lado no se verá influenciada.

Nodo suave
N o d o  s u a v e

Seleccione uno o más nodos que desee suavizar y a continuación seleccione esta opción en la ventana. Un nodo
suave significa que cada modificación realizada en este nodo con el asa de control tendrá efecto en el asa editada y
el asa de control de al lado. El asa de control de al lado cambiará cuando el ángulo del asa de control editada cambie.
Cuando modifique la longitud del asa editada, el asa de al lado permanecerá sin cambiar.
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Nodo simétrico
N o d o  s i m é t r i c o

Seleccione uno o más nodos que quiera hacer simétricos y a continuación seleccione esta opción en la ventana. Un
nodo simétrico significa que cada modificación realizada en este nodo con el asa de control tiene efecto en el asa
editada y el asa de control de al lado. El asa de control de al lado también cambiará cuando el ángulo del asa de
control editada cambie y además cuando cambie la longitud del asa de control editada. Las asas tendrán ambas la
misma longitud.

Alineación horizontal
A l i n e a c i ó n  h o r i z o n t a l

Esta opción pone todos los nodos seleccionados en una línea horizontal.
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Alineación vertical
A l i n e a c i ó n  v e r t i c a l

Esta opción pone todos los nodos seleccionados en una línea vertical.

En una línea
E n  u n a  l í n e a

Todos los nodos seleccionados se colocan en una línea entre el primer y el último nodo seleccionado.

Ángulo recto
Á n g u l o  r e c t o

Seleccione los nodos que desea poner en un ángulo recto y haga clic en esta herramienta. 
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Sustituir por línea
S u s t i t u i r  p o r  l í n e a

Haga una línea recta de todas las partes de la línea seleccionada entre el primer y el último nodo.

A arco circular
A  a r c o  c i r c u l a r

Seleccione la opción en la ventana, el cursor cambiará a un cursor de arrastre con un "arco" a lo largo de él. Con
esta herramienta podrá dibujar un arco de cualquier tipo de línea y desde este arco otro arco, etc.

Esquinas redondeadas
E s q u i n a s  r e d o n d e a d a s

Cuando utilice esta herramienta podrá redondear todas las esquinas ubicadas entre dos líneas rectas.
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Parámetros
P a r á m e t r o s

Cuando seleccione este botón aparecerá un cuadro de diálogo en el que podrá realizar las siguientes configuraciones
de las herramientas de arrastre.

1 Último seleccionado.
 Esta opción asegura que el último nodo seleccionado se utilice siempre como orientación para conectar los

extremos. 

 

2 Centro
 Esta opción asegura que los nodos que estén conectados entre sí siempre lleguen juntos en sus respectivos

centros.

 

3 Con línea
 Esta opción asegura que los nodos que van a ser conectados entre sí permanezcan siempre en su lugar y se

conecten a través de una línea.
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Conexión rápida

Un método de dibujo único y muy rápido. Si solía realizar tareas tediosas de editar líneas, agregar nodos, conectar
nodos y se veía obligado a trabajar con líneas guía, ahora sólo tiene que utilizar un elemento de menú. 

Para convertir las líneas de la figura anterior en un objeto cerrado antes tenía que agregar nodos en los puntos de
intersección de las líneas, eliminar las líneas y después cerrar los nodos que se superpusieran. Ahora basta con que
seleccione las líneas y utilice el comando “Organizar, Conexión rápida” para obtener el objeto cerrado siguiente.

‘Conexión rápida” también puede utilizar una combinación de objetos abiertos y cerrados.

Después de aplicar ‘Conexión rápida” a los objetos que se muestran anteriormente obtendrá el resultado siguiente.

Si coloca estratégicamente las líneas puede obtener resultados de manera aun más rápida que los que obtendría
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fusionando o estampando los objetos. 

Experimente un poco para familiarizarse con el modo en que “Conexión rápida” se comporta en distintas situaciones,
y así observará que la mayor parte de sus dibujos puede realizarse diez veces más rápido que antes.

Panelado

¿Qué son los paneles y para qué se utilizan? 

Incluso si tiene una impresora de formato grande, esto no significa necesariamente que pueda imprimir a cualquier
tamaño. Todos los equipos tienen un tamaño máximo. Una impresora con capacidad de material de 90 cm suele
admitir una anchura efectiva de sólo 88 cm.

¿Cómo?
Una impresora de formato grande que funciona con bobinas tiene una longitud máxima de impresión que depende de
la longitud de la bobina. La anchura está determinada por la anchura efectiva de impresión. La longitud difícilmente es
un problema; la anchura si lo es. Para ambas orientaciones existe la posibilidad de dividir la hoja de trabajo en
paneles. Los paneles son una demarcación de la hoja de trabajo que puede especificar usted mismo y que debe estar
basada en la anchura efectiva de impresión y la longitud máxima del soporte. Las demarcaciones aseguran que
durante la impresión de la hoja de trabajo ésta se divida en paneles que han sido definidos por el usuario. Para
ilustrar esto utilizaremos una tarea ficticia en la que la capacidad es mayor de lo que nuestra impresora normalmente
podría utilizar.

En este ejemplo vamos a suponer que el trabajo de impresión tiene un formato de salida de 3000 mm de altura y
4500 mm  de longitud; la anchura efectiva de la impresora es 700 mm.
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Líneas del panel que utilizan un ratón 
Las líneas que se requieren para especificar los paneles se pueden aplicar de dos formas, con el ratón o utilizando
una entrada numérica en un cuadro de diálogo. Para utilizar el ratón, para hacer el mosaico haga lo siguiente. A
partir de la barra de herramientas seleccione el símbolo "Herramienta panel".

Cuando la herramienta haya sido activada el cursor cambiará como se muestra a continuación.

Cuando utilice la orientación vertical como en este ejemplo, cada clic en la hoja de trabajo colocará una línea
horizontal (una línea de panel orientada a lo largo del papel). Si desea colocar una línea de panel vertical, mantenga
pulsada la tecla Mayúsculas y haga clic en la hoja de trabajo. Aparte de la diferencia entre las líneas de paneles
horizontal y vertical, hay también una diferencia entre negativo y positivo. Si hace clic una vez en alguna de las
demás herramientas o en la tecla de tabulación cerrará el modo de línea de panel.

Líneas del panel que utilizan un diálogo 
En el menú "Archivo" seleccione la opción "Configuración del panelado ". Aparecerá el siguiente cuadro de diálogo.

Con este cuadro de diálogo podrá dividir de forma automática la hoja de trabajo en paneles, estableciendo el tamaño
máximo de un panel. Puesto que la orientación de la hoja de trabajo no es importante para los paneles (vertical o
apaisado), solamente la línea cero de la impresora "horizontal" es siempre paralela a la alimentación de papel
perforado (dirección de movimiento) de la página.
En el campo "Tamaño horizontal" (1) ponga el tamaño máximo del panel horizontal en este caso igual a la longitud de
la página). Puesto que utilizamos una bobina de papel, aquí no se necesitan líneas de paneles. Ponga la longitud de la
página o un número mayor. En el campo "Tamaño vertical" (2) ponga 600 unidades. Con la opción "Solapados" (3)
queremos indicar el solapamiento total de una línea de panel vertical y "Solapado horizontal" (4) indica el
solapamiento total de una línea de panel horizontal. En "Solapado vertical" ponga 100 unidades. No estamos
utilizando un solapado real aquí sino uno muy grande, como demuestra más claramente la división de paneles en una
hoja de trabajo.
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Ahora se podría decir que se tiene una anchura de impresión efectiva de 700 mm. ¿Por qué se utiliza entonces sólo
600 mm.? La explicación es muy simple ya que por cada anchura especificada se debe añadir el solapado total.

Líneas de paneles negativas y positivas 
Las líneas de paneles positivas son las líneas utilizadas con mayor frecuencia, si va a imprimir un trabajo que es
mayor que la anchura de impresión efectiva necesitará un solapado para poder pegar los paneles separados
conjuntamente. Una línea de panel positiva determina el tamaño del solapado. Cuando se distribuye una impresión en
varios paneles que se colocarán en forma de acordeón, necesitará un solapado positivo en una esquina y uno
negativo en la esquina del otro lado.

A El vértice cerca de "A" se dobla hacia la parte interior. Esto significa que en este punto, parte del dibujo no
será visible. En este punto se requiere un solapado negativo. Un solapado negativo quita anchura a la
impresión, al contrario que un solapado positivo, que añade anchura a la impresión. 

Horizontal Vertical

Un solapado negativo se muestra mediante tres líneas continuas en gris oscuro.

B El vértice en "B" se dobla hacia el interior, esto significa que si no desea que la impresión quede partida por
una costura, tendrá que aplicar aquí un solapado positivo.

Horizontal Vertical

Un solapado positivo aparece indicado por dos líneas punteadas en gris oscuro en el exterior y una línea gris clara
continua en el centro.
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A El original.
B El resultado después de un solapado negativo.

C/D El resultado después de un solapado positivo.

Orientación de las líneas de paneles 
En la ilustración mostrada a continuación encontrará una explicación de cómo el programa ve la localización y
formato del solapado.

La siguiente ilustración es la parte inferior de una página orientada en vertical con una anchura de 3000 mm y una
altura de 4500 mm (la página de nuestro ejemplo).

Mantenga el cursor por encima de la línea del panel izquierdo y haga clic con el botón derecho del ratón para que
aparezca un menú desplegable oculto. En este menú seleccione la opción "Propiedades de la línea del panel".
Aparecerá el siguiente cuadro de diálogo. 

Puesto que el lateral derecho es la línea cero de la impresora, el núcleo de la línea de panel seleccionada está a 2400
mm. Esta es la distancia de la línea cero de la impresora hacia el núcleo de la línea de panel. La línea de panel se ve
como una línea de panel horizontal porque el horizonte va paralelo a la línea cero de la impresora.

Paneles para trazado
P a n e l e s  p a r a  t r a z a d o

Puede utilizar paneles cuando el trabajo que desea trazar es más grande que la capacidad del trazador. Por ejemplo,
si tiene un diseño de 180 cm x 180 cm y el trazador sólo admite vinilo de 100 cm de anchura. Es decir, tiene que
trazar el diseño para que después del trazado pueda unir dos piezas separadas de 90 cm.
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Primeramente debe ajustar el tamaño de la página al diseño. A continuación, seleccione el diseño y observe la barra
de estado para ver el tamaño actual del diseño o utilice la herramienta de escala y medida. Puede asignar estas
medidas al tamaño de la página (en el menú: "Ver", "Parámetros", "Página") para asegurarse que el diseño está
centrado en la página. A continuación, agregue las líneas de los paneles a la hoja: 

Los paneles dependen del tamaño de su hoja, por lo que si no ajusta el tamaño de su página al diseño, los espacios
en blanco de la hoja también se incluirán en el proceso de creación de paneles. Estos espacios supondrían un gasto
innecesario de vinilo:

La ilustración anterior representa la imagen después de realizar el trazado. Las flechas negras representan el vinilo
innecesario:

La mejor manera para familiarizarse con los paneles es trazar algunas hojas pequeñas para ver cómo funciona
exactamente. 

Agregar líneas de paneles para trazador
Seleccione desde la barra de herramientas "Herramienta de paneles":

Una vez seleccionada el cursor cambia y adopta esta forma:
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Haga clic en la hoja donde quiere la línea de paneles. 

Una línea de panel siempre tiene la misma dirección que los bordes de una hoja. Si desea agregar una línea de panel
en los ángulos derechos del borde, tiene que hacer clic en la herramienta de paneles mientras mantiene presionada
la tecla mayús. Una vez situada la línea del panel, puede editar las propiedades con el botón secundario del ratón,
cuando está colocado sobre la línea del panel. En el menú contextual, seleccione "Propiedades". En el cuadro de
diálogo puede ajustar la ubicación exacta y superponer la línea del panel:

Trazado
Cuando inicia el trazado puede optar por trazar todos los paneles al mismo tiempo o uno por uno. Active esta opción
e introduzca el número del panel si desea imprimir un sólo panel. Puede ver estos números en la hoja en modo de
paneles (cuando la herramienta de paneles está seleccionada).

Escaneado

¿Con qué resolución es necesario escanear?
¿ C o n  q u é  r e s o l u c i ó n  e s  n e c e s a r i o  e s c a n e a r ?

La siguiente regla es útil: un mapa de bits será de 72 PPP (Puntos Por Pulgada) cuando se utiliza en 1 a  1. Esto
significa que cuando se imprime el mapa de bits a un tamaño de 50 x 70 cms, este tendrá una resolución de 72 PPP
para este tamaño. Si el mapa de bits tiene muchos detalles podría incluso duplicar la resolución.
La impresora tiene solamente una cierta cantidad de PPP de impresión, todo aquello que esté por encima de la
capacidad de la impresora será ignorado. Lo que no se ignora es el tiempo de cálculo para la impresión. Un mapa de
bits con 72 PPP puede dar el mismo resultado que uno con 2400 PPP; la diferencia estará en que el mapa de bits de
2400 PPP ocupa diez veces más espacio en el disco duro. El tiempo de cálculo para el procesamiento de la impresión
también se multiplica por un factor de diez, y los resultados apenas son distintos. Si piensa que la resolución podría
ser mejor, aumente sólo unos pocos pasos o duplíquela, pero no multiplique inmediatamente por diez. 
En el mundo de las imprentas se utilizan películas que se imprimen en impresoras de 2400 PPP (existen impresoras
de inyección de tinta desde 180 hasta 600 PPP). La resolución que los mapas de bits de 1 a 1 utilizan aquí es 300 PPP
con una pantalla de 150 LPP (Líneas Por Pulgada). Esta resolución se utiliza para la mayoría de impresiones a todo
color. ¿Por qué utilizar entonces 2400 PPP para una fotografía?

Para facilitar las cosas EasySIGN tiene un "Asistente" de escaneo que le recomienda la resolución correcta a la que
debe escanear. 

En el menú "Archivo" elija el comando "Escanear" y desde el submenú seleccione "Asistente". Aparecerá el siguiente
cuadro de diálogo.
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En el centro de este diálogo encontrará el botón "Seleccionar origen" (1). Al hacer clic en este botón aparece un
cuadro de diálogo mostrando los escáners que tiene instalados en el sistema. En este diálogo seleccione el escáner
que desea utilizar. Cuando lo haya hecho haga clic en el botón "Siguiente" (2).

En esta ventana ponga la anchura y altura del original en el escáner (1). Cuando lo haya hecho haga clic en el botón
"Siguiente" (2).
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En esta ventana ponga el tamaño de la impresión que desea del original (1). Cuando lo haya hecho haga clic en el
botón "Siguiente" (2).

En esta ventana se mostrará la resolución recomendada (1). Al hacer clic en "Terminar" (2) se abrirá el cuadro de
diálogo estándar del escáner. En este cuadro de diálogo para escanear ponga el valor que se le ha sugerido. No
podemos mostrar el diálogo de escaneado aquí porque es distinto para cada escáner. Para obtener más detalles
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sobre el uso del cuadro de diálogo del escáner consulte el manual de su escáner.

Gestión del color

Utilización de los colores
U t i l i z a c i ó n  d e  l o s  c o l o r e s  

En la parte inferior de la pantalla de EasySIGN encontrará por lo general la paleta de colores actual, y si éste no es el
caso podrá elegir la opción "Ver" del menú y a continuación el comando "Paleta de colores".

La paleta de colores es una barra flotante, lo que significa que puede arrastrar la barra y cambiar su tamaño. 

Si desea asignar un color a un objeto, seleccione el objeto y en la barra de colores haga clic en el color que desea
asignar. Cuando el ratón esté sobre una zona coloreada, se mostrará el nombre del color bajo el ratón en la barra de
colores. Haciendo clic una vez con el botón izquierdo del ratón se asignará el color seleccionado al relleno del objeto
y haciendo clic con el botón derecho del ratón se asignará el color a la línea de un objeto. Si desea eliminar el relleno
o la línea de un objeto, para el relleno haga clic con el botón izquierdo del ratón en el cuadrado con la cruz y para la
línea haga clic con el botón derecho del ratón en el cuadrado con la cruz.

Si quisiera cambiar el color de un objeto o crear un color nuevo, seleccione primero el objeto y a continuación la
herramienta color de la barra de herramientas.

Cuando haya seleccionado esta opción, aparecerá el siguiente cuadro de diálogo.
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1 Modelo de color
 Aquí podrá elegir el sistema de color que desea en este momento. EasySIGN ofrece una amplia gama de

sistemas de colores, como: 

RGB : Rojo, verde y azul

CMYK : Cian, magenta, amarillo y negro

Valores de
gris

: Compuestos de sombras de gris

HSB : Tinte, saturación y  brillo

Colores
planos

: Colores completos especificados por los proveedores de
impresoras.

CMYKOrGr : Cian, magenta, amarillo, negro, naranja y verde

CMYKLiCLiM : Cian, magenta, amarillo, negro, cian claro y magenta claro

2 La presentación visual del sistema de color elegido. El color puede verse influenciado utilizando las barras de
desplazamiento en (A) o rellenando un valor en el cuadro de texto (B). El resultado se muestra en la paleta
(7).

 

3 Barras de colores estáticas
 Al activar esta opción, las barras de colores tienen la misma apariencia que en la ilustración anterior y podrá

mezclarlas según sus conocimientos del color. Si no está familiarizado con los valores de mezcla, por ejemplo,
qué color se obtiene al mezclar verde y rojo, puede desactivar esta función. Las barras de colores cambiarán
ahora a un tipo que muestra hacia donde desplazarlas para obtener un determinado color. Con cada
movimiento de desplazamiento todas las barras se modificarán.

 

4 El botón “Cerrar" cierra el cuadro de diálogo 
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5 El botón "Aplicar" transfiere el color del cuadro de diálogo al objeto seleccionado.
6 El botón "Añadir" abre un cuadro de diálogo de modo que podrá añadir el color a la paleta.

 

Para añadir el color a la tabla debe darle un nombre al color en el campo (1) y hacer clic en "Aceptar".

Color predeterminado 
Cada vez que dibuje un objeto con EasySIGN éste tendrá un relleno, estilo de línea y color de línea predeterminados.
Puede elegir la opción predeterminada usted mismo. Para hacerlo haga clic en un color en la barra de colores o
produzca un color en el cuadro de diálogo de color, sin seleccionar ningún objeto. El mismo método de trabajo se
aplica para la creación de un color de línea predeterminado.

Paletas de colores y gestión de librerías
P a l e t a s  d e  c o l o r e s  y  g e s t i ó n  d e  l i b r e r í a s  

Si desea cambiar los nombres de los colores en la barra de colores, eliminarlos, cambiar un color o añadir un color
de una librería, debe seleccionar la siguiente herramienta de la barra de herramientas.

Cuando haya seleccionado esta opción aparecerá el siguiente cuadro de diálogo.
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1 Cuando selecciona un color de la lista (2) el nombre de este color se muestra en el cuadro de texto (1). Puede
utilizar este campo para cambiar el nombre. 

2 En esta lista puede clasificar un color, seleccionarlo para cambiar el nombre o para eliminarlo.
3 Aquí encontrará los comandos para editar colores que estén en la lista (2):

Esta opción clasifica la lista alfabéticamente.

Esta opción pone el color seleccionado en la parte superior de la lista.

Esta opción mueve el color seleccionado hacia arriba una posición en la
lista.

Esta opción mueve el color seleccionado hacia abajo una posición en la
lista.

Esta opción pone el color seleccionado en la parte inferior de la lista.

Esta opción elimina el color seleccionado

4 El botón "Aceptar" aplica todas las modificaciones y cierra el cuadro de diálogo. 
5 El botón "Cancelar" cierra el cuadro de diálogo sin ejecutar las modificaciones.
6 El botón “librería” abre el siguiente cuadro de diálogo.
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1 En esta lista puede seleccionar el nombre de la librería requerida.
2 Esta lista muestra los nombres de los colores y números de productos de la librería seleccionada. Aquí puede

elegir varias opciones simultáneamente.
3 El botón "Aceptar" transfiere todas las opciones seleccionadas a la lista en el cuadro de diálogo anterior donde

puede seleccionarlos o modificarlos.
4 El botón "Cancelar" cierra el cuadro de diálogo sin modificar nada.
7 El botón "Editar" abre el cuadro de diálogo de color estándar donde podrá modificar las características del

color.

Seleccionar por color
S e l e c c i o n a r  p o r  c o l o r

El comando "Seleccionar por color" del menú "Editar" abre un cuadro de diálogo en el que se puede seleccionar todos
los objetos de un determinado color a la vez.
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1 Lista de todos los colores de relleno de la hoja.
2 Lista de todos los colores de línea de la hoja.
3 Añade la línea seleccionada y los colores de relleno a la lista de selección (4). 
4 La lista de selección.
5 Elimina el elemento seleccionado de la lista de selección.
7 El botón "Seleccionar" asegura que se seleccionan los objetos de la hoja correspondientes al color de la lista

que haya especificado.
8 El botón "Anular selección" asegura que se anula la selección de los objetos de la hoja correspondientes al

color de la lista que haya especificado.

Seleccionar por objeto
S e l e c c i o n a r  p o r  o b j e t o  

El comando "Seleccionar por objeto" del menú "Editar" abre un cuadro de diálogo que funciona de la misma forma
que el cuadro de diálogo anterior con la diferencia de que este diálogo puede seleccionar todos los objetos de un
determinado tipo a la vez.

Seleccionar de forma rápida objetos con un estilo de relleno similar
S e l e c c i o n a r  d e  f o r m a  r á p i d a  o b j e t o s  c o n  u n  e s t i l o  d e  r e l l e n o  s i m i l a r

Seleccione un objeto y, a continuación, la opción “Seleccionar por, Estilo de relleno similar” del menú contextual. Se
seleccionarán todos los objetos que tengan el mismo estilo de relleno. La selección busca objetos con el mismo
nombre de color en lugar de valores de color.
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Seleccionar de forma rápida objetos con un color de línea similar
S e l e c c i o n a r  d e  f o r m a  r á p i d a  o b j e t o s  c o n  u n  c o l o r  d e  l í n e a  s i m i l a r

Seleccione un objeto y, a continuación, la opción “Seleccionar por, Color de línea similar” del menú contextual. Se
seleccionarán todos los objetos que tengan el mismo color de línea. La selección busca colores con el mismo nombre
de color en lugar de valores de color.

Seleccionar de forma rápida objetos similares
S e l e c c i o n a r  d e  f o r m a  r á p i d a  o b j e t o s  s i m i l a r e s

Seleccione un objeto y, a continuación, la opción “Seleccionar por, Objetos similares” del menú contextual. Se
seleccionarán todos los objetos idénticos. 

Color de registro
C o l o r  d e  r e g i s t r o

¿Qué es el color de registro?

Color de registro es un espacio de color independiente. Este color no es un color real, sino una propiedad. Si un
objeto tiene esta propiedad, se imprimirá y trazará junto con cada color en una separación de color. La propiedad
"color de registro" hace que las marcas de recorte se comporten de la forma en que lo hacen. Puede asignar esta
propiedad a través de las herramientas de color para estilos de contorno o de relleno o mediante la paleta de colores.
El color de registro se indica en la paleta de colores por el campo en negro con la "R" en blanco.

Puede asignar cualquier color al color de registro de la propiedad para resaltar la diferencia entre los colores de
registro y los colores normales de la hoja. Para asignar un color predeterminado al color de registro, en el menú
"Archivo", seleccione "Parámetros" y, a continuación, elija la ficha "Generales". Cada objeto nuevo con un color de
registro se mostrará en este color. Esta configuración no tiene efecto en objetos a los que ya se haya asignado esta
propiedad. Puede cambiar la apariencia de los objetos con esta propiedad a través de las herramientas de color para
los estilos de contorno y de relleno.

En la ilustración anterior, "A" es el objeto con el color de registro de propiedad y el color rojo asignado a esta
propiedad.

1 Separación de color en rojo
2 Separación de color en verde
3 Separación de color en azul

El color de registro se incluye automáticamente con cada separación de color.
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Medir colores
M e d i r  c o l o r e s

En EasySIGN, puede incluir colores en la aplicación mediante un densitómetro. ¡Una manera perfecta de crear su propia biblioteca de colores! 

Parámetros
Abra el menú “Archivo, Parámetros” y seleccione la hoja de fichas “Densitómetro” en el cuadro de diálogo que se
muestra.

1 Seleccione aquí la opción “Sí, deseo usar mi densitómetro”.

2 Seleccione la marca del densitómetro en el cuadro combinado.

3 Seleccione el puerto al que se ha conectado el densitómetro. Si ha elegido un densitómetro con una conexión USB

en el cuadro combinado, esta opción no está disponible. No utilice densitómetros automáticos que miden varios

colores en un solo barrido, sino uno que mida únicamente un color cada vez.

4 Presione este botón para averiguar si se detecta el densitómetro. Esto puede llevar un tiempo; espere a que se

muestre el mensaje que indica que se ha detectado el densitómetro.

5 Seleccione el espacio de color en el que deben almacenarse los colores medidos (CMYK o RGB). Si desea imprimir

los colores, deberá utilizar el espacio de color CMYK.

6 Aquí puede seleccionar el perfil deseado para los espacios de color CMYK y RGB. Si t iene una impresora y un

perfil (ICC o ICM) para esta impresora: seleccione este perfil. De esta manera, los colores medidos

corresponderán lo máximo posible al resultado impreso. Si no dispone de una impresora o tiene varias, seleccione

los perfiles "CMYK predeterminado" y "RGB predeterminado".

Guarde la configuración establecida mediante el botón “Aplicar” y cierre el cuadro de diálogo.

Procedimiento
Seleccione "Llenar cubo" en la barra de herramientas y, a continuación, el icono de "Administración de color".

Al hacerlo se abrirá el siguiente cuadro de diálogo.
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Si desea guardar los nuevos colores en una tabla independiente, primero deberá presionar el botón “Nuevo” (2) del grupo “Tabla” y crear una tabla

nueva. Si ya lo ha hecho o desea añadir los colores medidos a una tabla existente, presione el botón “Medir” (1) del grupo “Color”.

Rellene el nombre del color y haga clic con el densitómetro en el color que desea medir. El color aparecerá en la previsualización de color (2) y los

valores de los colores se mostrarán en los cuadros de edición.

Si se muestra este icono, el color medido queda fuera del espectro (gama de colores imprimibles) de la impresora, según el perfil elegido en

”Parámetros”. Puede ajustar visualmente el color para que coincida con el color medido lo máximo posible.

Presione el botón “Añadir” para añadir el color medido a la tabla de colores activa. Cierre el cuadro de diálogo cuando haya terminado de medir los

colores. No olvide presionar el botón “Aceptar” para guardar los cambios. 

Relleno de degradado
R e l l e n o  d e  d e g r a d a d o

Con un relleno de degradado puede cambiar dos o más colores al siguiente color de la paleta. Con esta función
puede agregar más color y profundidad a su diseño. Hay diferentes tipos de degradado.

Lineal
El relleno es una línea recta por encima del objeto:
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Radial
El relleno está formado por círculos concéntricos:

Cuadrado
El relleno está formado por cuadrados concéntricos:

Cónico
El relleno se realiza con rayos desde el centro del objeto:

Cada uno de los rellenos de degradado se subdivide en dos tipos.

Dos colores
Este relleno sólo tiene dos colores que se intercambian:

Personalizado
Este relleno puede tener más de dos colores. Puede utilizar por ejemplo un relleno desde rojo a naranja, a amarillo o
a verde, etc.:

Puede personalizar rellenos de degradado al cambiar el "Relleno de borde", o el "Ángulo" y puede agregar y cambiar
colores, etc. Puede realizar esto en el cuadro de diálogo o directamente en la pantalla. 

¿Cómo se aplica un relleno de degradado?
Hay dos formas de aplicar un relleno.

Cuadro de diálogo de relleno de degradado
Seleccione un objeto y en la barra de herramientas, seleccione el submenú "Rellenos" y haga clic en el botón de
relleno de degradado: 

Ajuste los parámetros que desee en este cuadro de diálogo y haga clic en "Aceptar".

Directamente en la pantalla
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En el submenú "Rellenos" de la barra de herramientas, haga clic en el símbolo de relleno de degradado:

El cursor cambiará según se indica a continuación:

Cuando selecciona un objeto con esta herramienta y arrastra el ratón simultáneamente, se aplica un relleno de
degradado al objeto:

Cuadro de diálogo de relleno de degradado

Dos colores
1 Tipo
 Puede elegir diferentes tipos de rellenos de degradado:
  Lineal
  Radial
  Cuadrado
  Cónico.

2 Centro
 Puede ajustar el centro de un relleno con este control, si el relleno lo admite. En la columna izquierda de la

imagen siguiente, el centro tiene uno valor 0% horizontal y 0% vertical. En la columna derecha los valores
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horizontales y verticales son 25%.

3 Opciones

 Ángulo
 Puede ajustar el ángulo del relleno de degradado.

 Pasos
 Puede ajustar el número de pasos que se emplean para construir el relleno de degradado. Si desbloquea el

botón de este campo, puede ajustar el número de pasos del relleno de degradado activo actual. Si bloquea el
botón, el número de pasos que se visualizan se ajustan globalmente en el menú "Archivo", "Parámetros",
"General", "Pasos del relleno de degradado".

 Relleno del borde
 Este parámetro controla la distancia donde se encuentra el color inicial y final y en qué punto se inicia el

relleno de degradado.

 Efectos especiales
 Si está opción está activada, puede realizar un efecto especial con un relleno de degradado normal. Un

cuadrado con relleno de degradado normal tiene el siguiente aspecto:  

 

 El mismo relleno de degradado, pero con la opción de "Efectos especiales" activada y un ángulo de 6 grados,
tiene el aspecto siguiente: 

 

4 Relleno de degradado
 Puede elegir entre "Dos colores" o "Personalizado".  

5 Desde/A
 Puede determinar el color inicial y final del relleno. Cuando selecciona uno de los botones, aparece el siguiente

menú:
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 Al seleccionar uno de los cuadrados de color, asignará el color seleccionado como el nuevo color inicial o final. 
 

 

 Cuando selecciona el cuadrado negro con la letra "C" mayúscula, se abre un cuadro de diálogo en el que
puede crear un color personalizado.

6 Centro
 Puede determinar el centro del relleno:
 

 

7 Arco iris
 Al seleccionar uno de estos botones se puede determinar la dirección del color inicial y final. En el siguiente

ejemplo, la imagen izquierda representa la manera "más corta" de pasar de un color a otro en un espacio de
color y la imagen derecha representa la manera "más larga": 

 

 

8 Preferencias
 Esta lista proporciona una serie de rellenos de degradado predefinidos. Puede agregar algunos personalizados

al escribir un nombre y presionar el botón “+”. Si selecciona un parámetro y presiona el botón “-”, puede
eliminarlo. 

Personalizado
Cuando selecciona "Personalizado", el cuadro de diálogo cambia:
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1 Posición
 Puede encontrar la posición del color seleccionado dentro del relleno de degradado.  

2 Actual
 Puede visualizar el color seleccionado actualmente.  

A El color inicial.
B Una de las posibles posiciones de color en un relleno de degradado.
C El color final.

Al hacer doble clic en el espacio en blanco entre el punto "A" y "B" o al agregar un valor en (1), puede agregar una
nueva posición de color. Cuando quiere agregar una posición numérica (1), asegúrese de que no hay ninguna
posición existente seleccionada o mueva esta posición en vez de agregar otra. Puede anular la selección de una
posición al hacer clic en el espacio en blanco entre los puntos "A" y "B".

 

 

La nueva posición agregada tiene el color exacto de la posición en el degradado siguiente. Cuando arrastra el control
deslizante a una ubicación diferente, el color no cambia, sólo la posición. Puede cambiar una posición al seleccionar
esta posición y arrastrarla o al seleccionar esta posición y cambiar el valor en el campo de posición (1):
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Puede comprobar que la posición está seleccionada cuando el triángulo está negro. Cuando una posición está
seleccionada, puede eliminarla al presionar la tecla "Eliminar" en el teclado.

Para cambiar el color inicial y final, seleccione el punto "A" o "B" y, a continuación, ajuste el valor en el menú de color
(2). Para cambiar el color de una de las posiciones, seleccione esta posición y, a continuación, ajuste el valor en el
menú de color (2).

Ajustar un relleno de degradado directamente en pantalla
Seleccione un objeto con un relleno de degradado y, a continuación, en el submenú "Rellenos" de la barra de
herramientas presione el símbolo de relleno de degradado:

De esta forma, los controladores del relleno de degradado se hacen visibles:

Si arrastra uno de los controladores externos, podrá cambiar el ángulo y las posiciones del relleno de degradado.
Estos controladores son magnéticos y se pueden ajustar en una línea guía o nodo:

El control deslizante del centro sirve para cambiar el centro del relleno de degradado:
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Cuando una posición está seleccionada, puede cambiar sus propiedades. 

Sin seleccionar: 

Seleccionada: 

1 Ubicación
 Puede cambiar también la ubicación de la posición externa numéricamente al seleccionar el menú contextual

con el comando "Mover": 
 

 

2 Color
 Para cambiar el color de una posición tiene que seleccionarla y elegir un color de la barra de colores o en el

menú contextual seleccione "Propiedades". Si selecciona "Propiedades", aparecerá el cuadro de diálogo de
color para crear un color personalizado.

3 Eliminar
 Puede eliminar cualquier posición, salvo la posición inicial y final, a través del menú contextual o con la tecla

"Eliminar" del teclado. 

4 Agregar posiciones
Puede agregar una posición al situar el ratón en la línea de puntos entre la posición inicial y final y, a continuación, en
el menú contextual seleccione "Insertar" o haga doble clic en la línea de puntos directamente. Si está situado sobre la
línea de puntos el cursor del ratón cambiará su apariencia como se ilustra a continuación:

Al hacer doble clic se agrega una posición:
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Al seleccionar un color de la barra de colores puede cambiar el color de la posición actual:

Cambiar el tipo de relleno de degradado
En el submenú "Rellenos" de la barra de herramientas abra el cuadro de diálogo de relleno de degradado y, a
continuación, haga clic en el botón de relleno de degradado.

Con este diálogo abierto puede cambiar el "Tipo" de relleno:

Radial
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Al igual que otro tipo de relleno, puede agregar posiciones y editar la ubicación y color de este relleno de degradado.

Cuadrado

Cónico

Trabajar con rellenos de degradado
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Gracias a los controladores de relleno de degradado pueden realizar todas las operaciones directamente en la
pantalla al igual que en el cuadro de diálogo.

Tenga en cuenta que sólo puede cambiar los diferentes tipos de relleno de degradado a través del cuadro de diálogo:

Casi todas las acciones que puede realizar en el cuadro de diálogo las puede ejecutar directamente desde la pantalla:

Rellenos de degradado listos para cortar

Si desea preparar los rellenos de degradado antes de cortar, seleccione el objeto y en el menú contextual, elija el
comando "Convertir", "Listo para cortar":
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Cuando trabaja en modo de color no se puede apreciar la diferencia. Sólo podrá apreciar los cambios cuando cambie
al modo en marco. Para poder cortar el relleno de degrado, se convierte cada paso en un objeto vectorial. Esta
operación sólo es útil cuando el relleno de degrado no tiene demasiados pasos.  Si el relleno tiene muchos pasos, se
gasta mucho vinilo de diferentes colores y no resulta práctico.

 

 

Patrones de relleno

Los patrones de relleno son archivos de mapa de bits que se pueden disponer en mosaico sin problemas para formar un total completo y sin

interrupciones. EasySIGN incluye varios cientos de archivos de ejemplo. Puede obtener más de 3400 de estos rellenos en 27 categorías distintas

(como "Madera", "Metal", "Mármol", "Piedra", etc.) de nuestro sitio Web: http://www.easysign.com.

Encontrará los patrones de relleno en el subdirectorio "Shared\TEXTURES\" de EasySIGN. 

Cómo aplicar un patrón de relleno

Los patrones de relleno, al igual que los demás rellenos, se pueden aplicar mediante el botón "Llenar cubo" de la barra de herramientas. Primero,

seleccione un objeto vectorial al que desea asignar un patrón de relleno y, a continuación, seleccione el icono siguiente de la barra de herramientas.
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Aparecerá el cuadro de diálogo donde puede seleccionar el patrón de relleno.

1 Previsualización del patrón

Al presionar el botón "Patrón" aparecerá un cuadro de diálogo donde puede seleccionar el patrón de relleno
deseado.
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Se trata del "cuadro de diálogo Abrir" estándar que ya ha visto antes, pero con otras opciones adicionales.

1)

Aquí puede determinar la forma en que se presentan los archivos. Seleccione "Miniaturas" para ver previsualizaciones de las imágenes.

2)

Mediante el botón "+" puede añadir el subdirectorio actual a la "lista Favoritos".
Cuando seleccione un subdirectorio de esta lista, el cuadro de diálogo se desplazará automáticamente a la ubicación seleccionada. 

2 Origen del desplazamiento

Un patrón de relleno "comienza" en la esquina inferior izquierda de los objetos seleccionados. Aquí puede ajustar este origen.

3 Tamaño

Aquí puede ajustar el tamaño del patrón de relleno.

4 Transformaciones

Aquí puede ajustar la inclinación y la rotación del patrón de relleno.

Transformar mosaico con objeto
Esta opción determina si el patrón de relleno copia las transformaciones del objeto.

Orig ina l
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Objeto transformado con esta opción desactivada

Obje to  tra nsfo rm a do  con e sta  opción a ctiv a da

Manipulación de patrones de relleno con el ratón

Seleccione un objeto con un patrón de relleno.

A continuación, seleccione la herramienta para ajustar patrones de relleno (la misma que se utiliza para ajustar
rellenos de fuentes).

Ahora puede ajustar la rotación, la colocación (origen), la escala y la inclinación con el ratón.

Los ajustes realizados con el ratón se copian en el cuadro de diálogo del patrón de relleno. Si desea afinar las transformaciones, seleccione el objeto

con el patrón de relleno y, a continuación, el icono siguiente de la barra de herramientas.

Algunos ejemplos de patrones de relleno
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Marcas de registro

En EasySIGN existe la posibilidad de colocar automáticamente marcas de registro alrededor de una página o
selección. También podrá poner marcas de registro directamente en cualquier ubicación requerida. Las marcas de
registro se colocan siempre en una capa especial que se puede ajustar según la visibilidad, bloqueo y si las marcas
de registro van a ser imprimidas o trazadas. Puesto que las marcas de registro son un tipo diferente de objeto en
EasySIGN, se comportan de manera diferente. Si por ejemplo coloca marcas de registro alrededor de un objeto que
desea trazar con colores separados, no necesitará colocar una marca de registro nueva para cada color. Siempre se
traza o imprime una marca de registro con cada color, al margen del número de colores que haya en la hoja de
trabajo.
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Si desea utilizar una marca de registro en una ubicación específica, debe seleccionar las siguientes herramientas de
la barra de herramientas.

El cursor cambia como se indica a continuación:

En cada ubicación de la hoja de trabajo donde haga clic con el cursor aparecerá una marca de registro.

Al hacer clic con el botón derecho del ratón en una marca de registro aparecerá un menú con las siguientes opciones.

Eliminar : Elimina la marca de registro que hay bajo el ratón.

Eliminar
todas

: Elimina todas las marcas de registro en la hoja de trabajo actual.

Ocultar
todas

: Oculta todas las marcas de registro en la hoja de trabajo actual. Se puede hacer que las
marcas de registro estén visibles nuevamente utilizando el cuadro de diálogo de capas.

Propiedades : Abre un cuadro de diálogo donde podrá configurar lo siguiente.

1 Modificar la forma de una marca de registro.
2 Modificar el tamaño de una marca de registro
3 Si se ha marcado esta opción, los parámetros configurados en el cuadro de diálogo se aplicarán a todas las

marcas de registro de la hoja de trabajo.

Se puede abrir el siguiente cuadro de diálogo utilizando el menú "Introducir, producción, introducir marca de
registro".
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La forma y tamaño que establezca en este cuadro de diálogo será también la predeterminada al colocar nuevas
marcas de registro en la hoja de trabajo.

1 Aquí puede seleccionar la forma.
2 Aquí pude poner el tamaño de la marca de registro.
3 Cuando marque la opción "Alrededor de página o selección", las opciones del cuadro de grupo más abajo se

activarán. En el cuadro de grupo actual puede indicar si desea que las marcas de registro estén alrededor de la
página o de una selección.

4 En "Márgenes" puede establecer qué distancia debe haber de las marcas de registro a la selección o página.
5 Al activar esta opción, los valores que ponga en el primer campo se aplicarán automáticamente a los

márgenes en los otros tres campos.

Marcas de registro alrededor de la página 
Al utilizar esta opción las marcas de registro no sólo se colocarán alrededor de una página, sino que el tamaño de la
página también se modificará de modo que las marcas de registro podrán también imprimirse. Esto significa que
habrá cuatro líneas guías añadidas a la hoja de trabajo que indican el tamaño original de la hoja. De esta forma
nunca olvidará incluir las marcas de registro al imprimir la página, puesto que las marcas de registro se incluirán en
el tamaño de la página. 

Edición de marcas de recorte
El trabajo con marcas de recorte no difiere mucho de la versión anterior, aunque se han agregado algunas funciones
importantes. En la versión 3 y posteriores, las marcas de recorte pueden volver a colocarse y se pueden seleccionar
con otros objetos. También pueden convertirse a curvas y se puede ajustar su color.

Personalización de marcas de recorte
Las marcas de recorte tienen la propiedad "Color de registro". Esto significa que los objetos con esta propiedad se
imprimen o se trazan con cada separación de color. La propiedad "Color de registro" puede asignarse a cada uno de
los objetos vectoriales, que se imprimirán o se trazarán a continuación con cada separación de color. Si cancela la
propiedad "Color de registro" de una marca de recorte, ésta ya no se trazará ni se imprimirá con cada separación de
color.

Paginación

Cuando parte de la hoja de trabajo es demasiado alta para la impresión, en otras palabras si el formato de salida del
trazador no es lo suficientemente grande se puede utilizar la función "Paginación".
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Supongamos que la ilustración de arriba es demasiado grande para el trazador. En este caso debe seleccionar los
objetos que desea dividir y crear temporalmente un duplicado de la posición donde se va a llevar a cabo la división.
La división parte realmente los objetos en dos y éstos pierden sus propiedades. Cuando considere partir un texto por
ejemplo, no podrá editarlo después como texto. Para evitar esto es mejor llevar a cabo la operación en una copia del
diseño original.

En el menú "Editar" seleccione el comando "Paginación"; el cursor cambiará como se muestra a continuación.

Mueva el cursor al punto donde desea dividir el trabajo, haga clic una vez y arrastre el cursor a la zona que desea
dividir. Puede dividir bajo cualquier ángulo, pero si utiliza la tecla Control, los ángulos estarán limitados a 15 grados.
Cuando suelte el botón del ratón después del arrastre, aparecerá la siguiente ventana.

1 Solapado:
 En este campo puede poner el tamaño del solapado.
2 Cerrar formas:
 Cuando active esta opción, las formas se cerrarán después de la división. Si hace la división para un trazador

antes de imprimir, esta opción debe estar activada, pues de otro modo cortaría formas abiertas.
3 Objetos de grupo:
 Cuando divida un objeto, esta opción asegura que el resultado sea inmediatamente agrupado. Es preferible no

utilizar esta opción para varios objetos porque al agrupar, la secuencia de apilamiento puede cambiar, lo que
podría producir resultados no deseados.

4 El botón "Aceptar" aplica las configuraciones y el botón "Cancelar” cierra el cuadro de diálogo sin llevar a cabo
la división.

Al hacer clic en "Aceptar" podría parecer al principio como si nada hubiera cambiado. Si observa los gráficos de líneas
de dibujo o si desplaza el objeto a otro lado podrá ver el resultado.

Corte

Quizás no es una función específica de símbolos, pero ciertamente se trata de un derivado de la paginación. Esta
función permite recortar rápidamente un objeto o cortarlo por la mitad. En el menú "Editar" seleccione el comando
"Cortar". El cursor cambia como se indica a continuación:
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Este cursor puede dibujar una línea como cuando se hace la paginación. Sin embargo, esta función va exactamente al
lugar donde se desea recortar, si desea cortar todo el objeto debe colocar la línea sobre todo el objeto.

Cuando se suelta el botón del ratón aparece el siguiente cuadro de diálogo:

En este cuadro de diálogo podrá configurar "Solapado" (1) y cuando haga clic en "Aceptar" después de la
configuración, podría parecer al principio como si nada hubiera cambiado. Sin embargo, podrá dar a una mitad un
color distinto y hacer la diferencia visible.

Soldar

Ciertamente ésta es una de las funciones utilizadas con mayor frecuencia para la producción de dibujos y diseños
atractivos. Utilizando esta función podrá crear los dibujos más complicados en pantalla antes de cortarlos.

Fundir
La operación Fundir convierte dos objetos en uno. Seleccione los objetos que desea fundir en el menú "Editar, Soldar"
y elija el comando "Fundir objetos ".



184 EasySIGN

Estampación
El comando "Estampar objetos" elimina la forma de un objeto desde el objeto subyacente. 

Estampación de formas abiertas 
El comando "Sustracción abierta" funciona de la misma forma con la única diferencia de que el resultado de la
operación es una forma "abierta".

Estampación del último seleccionado 
La estampación normalmente funciona en secuencia de apilación, el objeto que se coloca encima perfora los objetos
subyacentes.  En esta opción no hay diferencia en el lugar donde el objeto esté colocado en la secuencia de apilación.
El objeto que ha sido seleccionado el último perfora los demás objetos y posteriormente es eliminado.

Enmascarar el último seleccionado 
Esta opción utiliza el último objeto seleccionado como una especie de máscara y perfora todos los demás objetos
alrededor de él.
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Unión
El comando "Unión" deja sólo las formas solapadas. Cuando se han seleccionado varios objetos que no todos se
solapan, este comando no generará un resultado.

En la siguiente ilustración todas las formas no se solapan. La forma en la parte superior solamente se solapa con la
que está en el centro. Esta función no generará un resultado en esta situación.

En la ilustración a continuación todas las formas se solapan y la función dará un resultado.

Añadir nodos
El comando "Añadir nodos" añade un nodo adicional a cada ubicación donde se intersectan las líneas del objeto
seleccionado.
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Trazado de fotografías

Esta función permite el trazado de un mapa de bits en color o escala de grises. Esto se produce haciendo tiras que se
hacen cada vez más gruesas cuando la fotografía se hace más oscura. La distancia de la línea y el número de líneas
son ajustables. Se recomienda no tomar menos de 2 mm para el corte porque de lo contrario las líneas se acercarían
demasiado unas a otras y el pelado de la lámina sería muy complicado. 
Si desea trazar una fotografía, seleccione el mapa de bits que desea utilizar. Si a continuación hace clic en el mapa
de bits seleccionado con el botón derecho del ratón, aparecerá un menú desplegable oculto con dos opciones
importantes para el trazado de fotografías.

A Mostrar como trazado de fotografía
 Cuando se elige esta opción, el mapa de bits seleccionado se muestra como un trazado de fotografía con los

parámetro aplicable actualmente.
B Opciones de trazado de fotografía
 Esta opción abre un cuadro de diálogo en el que podrá modificar los parámetros para el trazado de la

fotografía.

 

1 Anchura del trazo 
 Aquí podrá establecer la anchura de las tiras en que se dividirá la fotografía.
2 Número de trazos
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 Aquí podrá establecer el número de trazos en que se dividirá la fotografía.
3 Dirección de corte
 Aquí podrá especificar si desea que los trazos vayan horizontalmente o verticalmente.
4 Invertir brillo
 Esta opción invierte el brillo de la fotografía. Se puede utilizar si desea aplicar vinilo blanco sobre un fondo

negro.
5 Límites de la anchura del trazo
 Esta opción permite especificar el grosor mínimo y máximo de las tiras. 
6 Con el botón "Aceptar" podrá aplicar los parámetros y cerrar el cuadro de diálogo; con el botón "Cancelar"

podrá cerrar el diálogo sin aplicar los parámetros.

Los parámetros que haya configurado en este cuadro de diálogo se aplicarán al siguiente mapa de bits que desee
trazar como trazado de fotografía.

Texto

Texto
T e x t o

El texto es probablemente el componente más elemental de cualquier diseño. Por esta razón EasySIGN tiene
herramientas de texto muy avanzadas. Estas herramientas admiten el texto en trayectorias, en círculos, tabuladores
y todas las propiedades de formateo, etc. La herramienta de texto es muy fácil de utilizar y todo se puede editar e
introducir directamente en pantallas.

Introducción de textos
I n t r o d u c c i ó n  d e  t e x t o s

En la barra de herramientas seleccione el símbolo del editor de textos.

Aparecerá el siguiente cuadro de diálogo y el cursor cambiará a un signo de intercalación de texto.

Utilice el signo de intercalación de texto para hacer clic en la hoja de trabajo y empezar a teclear. Si desea introducir
textos desde fuera de EasySIGN, todo lo que tiene que hacer es seleccionar el texto en el editor de textos original (o
uno de los procesadores de textos de Windows™) y a continuación seleccionar el comando "Copiar". En EasySIGN
asegúrese de que el signo de intercalación de texto esté en la hoja de trabajo y a continuación utilice el atajo del
teclado “CTRL+V" para pegar el texto copiado. De esta forma se consigue la compatibilidad con casi todo el software
de procesamiento de textos que se utiliza en Windows™.
Si desea seleccionar parte del texto, ponga el signo de intercalación de texto al final o al principio de la selección
requerida y arrastre el cursor hasta que el texto requerido haya quedado seleccionado. Cualquier comando que
seleccione del cuadro de diálogo se aplicará al texto seleccionado.

Partes del diálogo 
1 Selección del tipo de letra.
 Aquí puede seleccionar el tipo de letra requerido. Se muestra un ejemplo de cada tipo de letra cuando se hace

la selección.
2 Puede utilizar estos botones para cambiar el texto seleccionado a negrita o cursiva (si el tipo de letra

seleccionado admite este formato). No debe olvidar nunca que hay familias completas de tipos de letra que
sólo admiten mayúsculas y que todos los sistemas tienen tipos de letra que sólo admiten el trazo normal.
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3 Puede utilizar el primer botón para poner un carácter en superíndice (se reduce el tipo de letra directamente
sobre el último carácter) o subíndice (se reduce el último tipo de letra debajo y a la derecha del último
carácter). 

 

4 Con el primer botón puede cambiar los caracteres seleccionados a mayúsculas y con el segundo botón puede
aplicar mayúsculas pequeñas. Mayúsculas pequeñas significa que cada letra mayúscula sigue siendo
mayúscula y que las letras minúsculas se convierten en mayúsculas a un tamaño que es el 70% de la
mayúscula original.

 

5 Con estos botones puede alinear el texto a la izquierda, derecha o al centro.

 

6 Estos botones le ayudarán a poner textos en un círculo, algo que se comentará con mayor detalle más
adelante en este capítulo.

7 En este campo puede poner el tamaño del texto seleccionado. La separación entre líneas (8) se ajustará
automáticamente con cualquier modificación en este  campo.

 

8 En este campo podrá modificar el interlineado.

 

9 Espaciamiento de palabras. Se calcula en porcentajes, siendo 100 por ciento la separación estándar entre
palabras. En el ejemplo a continuación, la separación entre palabras se ha duplicado. Esta modificación sólo se
ha aplicado a las zonas seleccionadas y no a todo el párrafo.

 

10 En este campo podrá determinar un separación adicional para los caracteres seleccionados y la separación
entre palabras. Cero por ciento es el estándar. Todo valor de aumento resultará en una separación mayor
entre tipos de letra (más espacio entre los textos).
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11 En este campo podrá determinar la anchura de los caracteres en el texto. Aquí podrá hacer que los textos sean
más anchos o más estrechos simplemente ajustando los valores. El valor estándar es 100 por ciento.

  

12 Establecer como predeterminado
 Los parámetros actuales del editor de texto se guardan como predeterminados.

13 Aplicar de forma predeterminada
 Los parámetros predeterminados se aplican a todos los controles del editor de texto.

14 Rotar texto
 Los caracteres seleccionados se rotan:

15 Inclinar texto
 Los caracteres seleccionados se inclinan:

Las funciones de rotación e inclinación se realizan a partir del punto de origen del carácter para la rotación e
inclinación.

Editar textos.
Si desea editar textos nuevamente puede seleccionar la herramienta de texto en la barra de tareas y colocar el signo
de intercalación de texto en el texto que desea editar. Podrá seleccionar el texto que desea editar y elegir el
comando "Editar texto", con el botón derecho del ratón. Ambos métodos hacen lo mismo pero de forma diferente.

Cómo dar a un texto color o contorno 
Para dar a un bloque completo de texto color o contorno, primero debe seleccionarse el bloque de texto con una
herramienta de selección. A continuación haga clic en un color de la barra de colores o abra el cuadro de diálogo de
color para crear un color.

Si desea dar a uno o varios caracteres de un texto color o contorno, seleccione las letras requeridas con la
herramienta de texto. A continuación haga clic en un color de la barra de colores o abra el cuadro de diálogo para
crear un color.
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Párrafos y tabuladores
P á r r a f o s  y  t a b u l a d o r e s  

EasySIGN no sólo admite la utilización de tabuladores en textos sencillos, sino también en textos colocados en una
trayectoria. Esto es muy conveniente si por ejemplo desea unir rápidamente varias listas de precios interesantes. Por
supuesto no puede utilizar textos en trayectorias para párrafos, ya que éstos constan de varias líneas. Si desea poner
un párrafo en una trayectoria, se transformará en una línea.

Formateo de un párrafo 
Puesto que EasySIGN no admite el retorno automático de líneas en la versión actual, tendrá que establecer los
guiones en los párrafos usted mismo. Esta es la única limitación en los párrafos, ya que EasySIGN admite todas las
demás características del formateo de párrafos, como la sangría y propiedades. El siguiente es un ejemplo del
formato de párrafo.

Teclee un texto empezando con un tabulador y a continuación un guión, después otro tabulador y un par de líneas de
texto.

En la regla verá una "Barra de tabuladores" y el párrafo aún no será un párrafo real. Para editarlo tendrá que
conocer lo que representan las distintas partes del tabulador.

A Sangría de la primera línea.
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 Al mover la barra de desplazamiento a la derecha, la primera línea (en este caso incluidos los tabuladores)
quedará alineada hacia ella.

B Sangría del párrafo.

 

 Al hacer la modificación moviendo la barra de desplazamiento a la derecha, todas las líneas, excepto la
primera quedarán alineadas con ella. La primera línea es dependiente de la barra de desplazamiento cerca de
"A".  También podrá poner estas configuraciones con el diálogo de propiedades de la barra de tabuladores.

C Los marcadores especifican la distancia estándar del tabulador. Esta propiedad sólo puede ser modificada
utilizando el diálogo de propiedades de la barra de tabuladores.

Si desea colocar un tabulador en la barra de tabuladores, sólo tendrá que hacer clic en la barra con el ratón y se
añadirá un tabulador a dicha posición.

El carácter que está ubicado detrás del primer tabulador quedará alineado. Si desea cambiar las propiedades (tipo de
alineación) del tabulador deberá hacer clic con el botón derecho del tabulador. En el menú desplegable oculto podrá
elegir entre "Izquierda", "Derecha", "Decimal" o "Centro". También podrá poner estas propiedades utilizando un
cuadro de diálogo y eligiendo "Propiedades" en el menú desplegable oculto. Si por ejemplo elige “Derecha",
aparecerá lo siguiente. 
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Para hacer que el párrafo tenga una apariencia de párrafo, debe especificar una posición para el segundo tabulador.
Esta debe ser una alineación del tabulador a la izquierda, porque la anchura del texto es demasiado grande para
alinear el tabulador a la derecha.

Para completar la imagen sólo tiene que poner la barra de desplazamiento de la parte inferior (para el párrafo) en la
misma ubicación que el segundo tabulador.

Los tabuladores pueden ser eliminados utilizando el comando “Eliminar" del menú desplegable oculto o arrastrando el
tabulador fuera de la barra de tabuladores.

Tenga en cuenta que los parámetros de los tabuladores y las alineaciones pueden ajustarse por línea.

Ejemplos de alineación de tabuladores 
Hay cuatro alineaciones de tabuladores distintas, cada una de las cuales tiene su propia utilización. En los ejemplos
que se dan a continuación se han utilizado los cuatro en el mismo ejemplo para mostrar las diferencias más
claramente.

Alineación del tabulador a la izquierda
Esta sólo se utiliza al principio de un párrafo con sangrado para alinear la primera frase con el resto del párrafo. No
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es conveniente para una lista de precios como podrá ver en el ejemplo a continuación.

Alineación del tabulador a la derecha
Esta no se utiliza con mucha frecuencia. Estos tabuladores se pueden utilizar en una lista de precios, donde todo lo
que hay detrás del punto decimal tiene el mismo carácter o el mismo número de caracteres. La alineación del
tabulador a la derecha sólo se utiliza para formatos especiales o para alinear el guión (por lo general para números
que van en aumento) en un párrafo con sangrado a la derecha, en vez de a la izquierda.

Tabuladores decimales
Probablemente es uno de los tabuladores más utilizados. Es especialmente indispensable para las listas de precios.
Puede especificar el carácter decimal en "Configuración regional" de Windows™. En Europa será por lo general una
coma y en los Estados Unidos un punto.

Tabuladores centrales
Nuevamente se trata de un tabulador que sólo se utiliza en ocasiones especiales. Probablemente es uno de los
tabuladores menos utilizados.

Limitaciones de los tabuladores 
Un tabulador sólo funciona cuando un párrafo tiene alineación a la izquierda. Un tabulador en un texto alineado a la
derecha o centrado simplemente se ignora. 

Diálogo de propiedades de la barra de tabuladores 
En este diálogo podrá configurar las propiedades de los tabuladores y párrafos, puede abrir este cuadro de diálogo
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haciendo clic en la regla del tabulador con el botón derecho del ratón. 

1 Posición del tabulador
 Cuando haya elegido una posición de la lista (2) de tabuladores existentes, podrá cambiar este número y

utilizando el botón "Mover" (8) podrá mover el tabulador a la nueva posición.  
2 En esta lista se muestran los tabuladores existentes en la barra de tabuladores.
3 Alineación
 Puede seleccionar la alineación del tabulador de la lista que se da a continuación.
4 Aquí puede especificar la distancia de los tabuladores estándar.
5 Aquí puede especificar la cantidad de sangrado de la primera línea.
6 Aquí puede especificar la cantidad de sangrado del párrafo.
7 Añadir
 Cuando haya puesto un número en la opción "Posición del tabulador" (1) podrá utilizar este botón para añadir

el tabulador a la lista.
8 Mover
 Esta opción permite mover un tabulador existente.
9 Borrar
 Esta opción permite borrar un tabulador seleccionado de la lista.

10 Borrar todo
 Este comando elimina todos los tabuladores de la lista.

11 Aceptar
 Aplica todas las modificaciones a la barra de tabuladores y cierra el cuadro de diálogo.

12 Cancelar
 Ignora todas las modificaciones y cierra el diálogo.

Colocación de textos en un trayecto circular
C o l o c a c i ó n  d e  t e x t o s  e n  u n  t r a y e c t o  c i r c u l a r  

La colocación de textos en un trayecto circular puede realizarse en pantalla y comprobarse directamente. Para
colocar textos en un trayecto circular primero debe dibujar un círculo; éste debe ser un objeto circular. Si transforma
primero el círculo en una curva no estará colocando el texto en un círculo sino en un trayecto. Por lo tanto, no es la
forma lo que aquí importa (podría ser también una elipse) sino la propiedad del objeto (debe ser un objeto circular).
Seleccione el texto que desea colocar en un trayecto circular y haga clic con el botón derecho del ratón una vez.
Desde el menú desplegable oculto seleccione el comando “Colocar texto en trayecto”.
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Cuando haya seleccionado el comando “Colocar texto en trayecto” haga clic en el círculo con el ratón. El texto se
colocará a sí mismo en el círculo. 

El círculo ahora se hace “invisible” y mientras el objeto sea un “texto en un círculo”, permanecerá allí conjuntamente
con el texto. Si ahora desea cambiar el radio del objeto, puede elegir las herramientas de arrastre de la barra de
herramientas y utilizarlas para seleccionar el objeto, para hacer el círculo visible nuevamente utilice las herramientas
de arrastre para seleccionar el texto.

Puede utilizar las herramientas de arrastre para editar el texto en el trayecto y arrastrar el texto a lo largo del
trayecto.

Arrastrando los nodos existentes podrá cambiar el radio y la forma del círculo sin influenciar el tamaño del texto.
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Utilizando la tecla de control junto con el botón derecho del ratón para arrastrarlo podrá aumentar o reducir el radio
del círculo.

Arrastrando el punto de anclaje en la parte inferior del círculo podrá convertirlo en una elipse horizontal. Utilizando la
tecla de control conjuntamente con el nodo izquierdo o derecho a arrastrar podrá aumentar o reducir el radio de la
elipse sin cambiar la forma de la elipse. Pulsando la tecla mayúsculas una vez mientras arrastra podrá volver a hacer
que la forma de la elipse sea un círculo.

Arrastrando solamente el nodo derecho del círculo podrá cambiarlo en una elipse vertical. Utilizando la tecla de
control y el punto de anclaje izquierdo o derecho a arrastrar podrá aumentar o reducir el radio de la elipse sin
cambiar la forma de la elipse.

Arrastrando el punto de anclaje más alto podrá cambiar el círculo en una tarta. Aquí podrá también cambiar la forma
utilizando la tecla de control conjuntamente con el punto de anclaje izquierdo o derecho a arrastrar, aumentando o
reduciendo el radio de la forma sin cambiar la forma misma. 
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Si  desea cerrar la forma de la tarta nuevamente debe utilizar la tecla de control para colocar el punto que ha sido
abierto exactamente sobre el otro punto “abierto”. 

Si utiliza las herramientas de arrastre para sujetar el punto de control de la primera letra podrá arrastrar este punto
a lo largo del trayecto.

Si sujeta una letra diferente para arrastrar, el posicionamiento será calculado nuevamente dependiendo de la
configuración del cuadro de diálogo del texto.
Si, como en el ejemplo anterior, tiene el posicionamiento en la parte central/superior, 

el texto se adaptará a éste. 

En el ejemplo anterior esto se ha llevado al extremo. La utilización de este comportamiento consiste en que una vez
elegido un determinado posicionamiento, las posibles modificaciones como el “kerning” no harán que se pierda el
posicionamiento. Si el posicionamiento no es de interés o si desea hacer todo manualmente, puede activar la opción
“alineación a la izquierda”, “alineación a la derecha” o “central”. Cuando haya seleccionado alguna de estas opciones
el texto permanecerá en la misma posición después de cualquier modificación. 
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No podrá arrastrar un texto más allá de su posición inicial cuando esté colocado en una trayectoria o círculo. Si el
texto se coloca en un círculo, por ejemplo, como en la ilustración anterior, sólo podrá mover el texto a la parte
central superior arrastrándolo una vez alrededor del círculo.

Texto en una trayectoria
T e x t o  e n  u n a  t r a y e c t o r i a  

El texto en una trayectoria funciona en muchos sentidos como el texto en un círculo. Los botones de alineación de
texto “Izquierda”, “Central”, “Derecha” o “Debajo” no están disponibles aquí. Dibuje primero una trayectoria y a
continuación seleccione el texto que desea colocar en la trayectoria con el botón derecho del ratón. Desde el menú
desplegable oculto seleccione el comando “colocar texto en trayectoria”.  

A continuación seleccione la trayectoria
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El texto ahora estará en la trayectoria. Con el texto en la trayectoria podrá también arrastrar todo el bloque de texto
o parte de él a lo largo de la trayectoria.

Si utiliza la tecla mayúsculas durante el arrastre podrá levantar los caracteres de la trayectoria de igual forma que
con el texto en un círculo. Esta opción también está disponible para una línea normal de texto.

Edición de la trayectoria
Incluso cuando el texto esté en la trayectoria, esta trayectoria puede ser editada, como ocurre con otras trayectorias
en EasySIGN. Todas las modificaciones a la trayectoria darán como resultado el ajuste del texto a la “nueva”
trayectoria.

Funciones de edición generales de texto en trayectorias y círculos
F u n c i o n e s  d e  e d i c i ó n  g e n e r a l e s  d e  t e x t o  e n  t r a y e c t o r i a s  y  c í r c u l o s

Inversión de la dirección de la trayectoria
Utilice el botón derecho del ratón para hacer clic en el texto seleccionado en el círculo o trayectoria.
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Desde el menú desplegable oculto seleccione el comando “Invertir dirección de la trayectoria”.

Lo mismo se puede hacer con el texto en una trayectoria.

En el ejemplo anterior las trayectorias del texto han sido dibujadas para hacerlo más claro, normalmente estarían
sólo visibles cuando se utilizan las herramientas de arrastre.

Giro de caracteres con la trayectoria.
Utilice el botón derecho del ratón para hacer clic en el texto seleccionado en el círculo o el texto en la trayectoria.
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Seleccione en el menú desplegable oculto el comando “Girar caracteres con la trayectoria”.

Las letras mantendrán la orientación vertical. Esta opción funciona de la misma forma que con el texto en la
trayectoria.

Una vez más con fines de claridad se ha dibujado la trayectoria interna al lado del texto.

Colocación del texto en una trayectoria
Normalmente el texto se coloca en una trayectoria alineada con su línea base. Podrá modificar este tipo de
alineación. Para hacerlo seleccione el objeto con el botón derecho del ratón y a continuación seleccione la opción
“Alinear en la parte inferior”, “Alinear en el centro” o “Alinear en la parte superior”. 
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Las mismas opciones están también disponibles para el texto en la trayectoria.

La opción “Alinear en la parte superior” podría no parecer correcta a primera vista, pero lo es. Esto se debe a que al
“Alinear a la parte superior” siempre tiene en cuenta cómo adaptarse a caracteres especiales, como por ejemplo la
letra mayúscula “E” con un circunflejo en la parte superior. 

Eliminación del “kerning”
Cuando se tiene  texto en una trayectoria, texto en un círculo o un texto del cual se deben retirar caracteres de la
línea base utilizando la tecla mayúsculas, puede utilizar este comando para poner el texto nuevamente en su forma
original. Todo el “kerning”, horizontal o vertical será eliminado.

Eliminación de texto de una trayectoria
Esta opción cambia un texto puesto en una trayectoria nuevamente en texto simple. La trayectoria volverá a
aparecer como un objeto separado.

Arrastrar distancia entre líneas e interletraje
A r r a s t r a r  d i s t a n c i a  e n t r e  l í n e a s  e  i n t e r l e t r a j e

Arrastrar interletraje
Situación inicial



203EasySIGN

Para ajustar el interletraje debe seleccionar primero el texto con la herramienta de arrastre. Aparecen dos puntos de
control:

El punto de control derecho se utiliza para ajustar el interletraje del texto:

Arrastre este punto de control para cambiar el interletraje de los caracteres y los espacios en blanco, al mantener
presionada la tecla mayús, sólo se ajusta el espacio entre palabras:
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Puede aumentar el interletraje arrastrando el punto de control hacia la derecha y reducir el interletraje arrastrando el
punto de control hacia la izquierda. Asimismo puede ajustar el interletraje si el texto está rotado o distorsionado:

Arrastrar distancia entre líneas
Para aumentar la distancia entre líneas arrastre el punto de control izquierdo hacia abajo, para reducir la distancia
entre líneas arrástrelo hacia arriba:
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Arrastrar distancia entre líneas e interletraje en una trayectoria o arco
A r r a s t r a r  d i s t a n c i a  e n t r e  l í n e a s  e  i n t e r l e t r a j e  e n  u n a  t r a y e c t o r i a  o  a r c o

La distancia entre líneas de un texto situado en una trayectoria o arco, al igual que el texto normal, sirve para ajustar
la distancia de la trayectoria o arco.

Arrastrar interletraje
Sin la tecla mayús:

Con la tecla mayús:

Arrastrar distancia de líneas
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Después de haber ajustado la distancia entre líneas del texto, puede volver a la posición normal haciendo clic con el
botón secundario del ratón en el menú "Alinear parte inferior", "Alinear parte central" o "Alinear por arriba".

Seleccionar y editar caracteres
S e l e c c i o n a r  y  e d i t a r  c a r a c t e r e s

Puede cambiar de forma simultánea el color de diferentes caracteres en cualquier parte del texto utilizando la
herramienta de arrastre. Por ejemplo, cambiar el color de todos los números del texto a rojo. Puede realizar este
paso utilizando la siguiente técnica:

Con la herramienta de arrastre puede seleccionar el punto de origen de cada carácter o dibujar un rectángulo que
seleccione todos los caracteres de una vez. A continuación, puede asignar un color a los caracteres seleccionados:
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En versiones anteriores, al mover un solo carácter, se movían todos los demás. Antes no era posible mover los
caracteres de uno en uno o mover varios caracteres a diferentes ubicaciones dentro del texto. Pero ahora todo esto
es posible. Puede utilizar el método anterior seleccionando el origen de cada carácter y arrastrándalo sin soltar el
botón del ratón. El resto de la línea de texto se arrastra de forma simultánea. Si selecciona un carácter, suelta el
botón del ratón antes de seleccionarlo de nuevo, sólo se moverá el carácter seleccionado. Si selecciona varios
caracteres, se moverán todos.

Haga clic y arrastre un carácter

Varios caracteres seleccionados
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Haga clic, haga clic de nuevo y arrastre un carácter

Excepciones
Cuando arrastra caracteres en un texto que contiene tabulaciones se obtienen resultados diferentes:

En el caso anterior, los caracteres situados a continuación del carácter seleccionado también se moverán cuando
arrastre el punto de control:

Sin embargo, el texto anterior contiene tabulaciones y el carácter situado a continuación sólo se mueve cuando se
alcanza la siguiente tabulación. El carácter siguiente se mueve a la posición de la siguiente tabulación.

Parámetros del texto
P a r á m e t r o s  d e l  t e x t o

Los parámetros predeterminados para los tamaños del superíndice, subíndice etc., se encuentran en la ficha "Ver",
"Parámetros": "Texto":
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1 Las unidades de texto siempre se expresan en puntos
Independientemente de los parámetros globales para unidades, el texto siempre se calcula en puntos.

2 Conectar la distancia entre líneas con el tamaño de fuente
Al ajustar en el editor de texto el tamaño de fuente de los caracteres, la distancia entre líneas se ajusta
automáticamente.

3 Distancia predeterminada entre fichas 
Sitúa las fichas con intervalos predeterminados automáticamente. Si introduce una ficha en un texto sin
establecer la ubicación, se utilizará un parámetro predeterminado.

4 Tamaño de versales
La diferencia entre la altura original de las fuentes y el tamaño de las versales se expresa en porcentaje.

5 Posición del subíndice
La posición se calcula desde la base de la línea del texto y se expresa en porcentaje.

6 Tamaño del subíndice
El tamaño de la altura original de fuente se expresa en porcentaje.

7 Posición del superíndice
La posición se calcula desde la base de la línea del texto y se expresa en porcentaje.

8 Tamaño del superíndice
El tamaño de un carácter de superíndice de la altura original de fuente se expresa en porcentaje.

9 Restaurar parámetros predeterminados
Restaure los parámetros predeterminados establecidos durante la primera instalación del software.

Los parámetros del 4 al 8 se aplican al nuevo texto introducido. No se aplica ningún cambio al texto introducido en
hojas existentes.
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Orientación del texto
O r i e n t a c i ó n  d e l  t e x t o

Gracias al menú "Texto", "Orientación del texto", "Vertical", el texto seleccionado se visualiza de arriba abajo en vez
de izquierda a derecha:

Con texto vertical la siguiente "línea que añada" se situará a la izquierda de la línea actual:

El espaciado y la distancia entre líneas se puede establecer con el editor de texto o con la herramienta de arrastre:

Importar texto
I m p o r t a r  t e x t o

En el menú "Archivo", seleccione "Importar" para importar archivos con la extensión ".txt". El límite de importación
para texto artístico es de 1000 caracteres. Si intenta importar un archivo de texto que contenga más de 1000
caracteres, sólo se importarán 1000.

Interletraje ajustable
I n t e r l e t r a j e  a j u s t a b l e

El interletraje es la distancia entre dos caracteres. Puede ajustar la distancia arrastrando el punto de origen con la
herramienta de arrastrar.
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Este interletraje está activo solamente para el carácter ajustado del bloque de texto activo. Asimismo, tiene la
posibilidad de guardar este interletraje en una fuente. Después de guardarlo, se aplicará a cualquier texto nuevo que
se escriba con este tipo de fuente. En realidad ya ha guardado un par de interletraje: la distancia entre dos
caracteres.

¿Cómo?

Escriba un texto con los pares de interletraje que desee ajustar y seleccione el texto con la herramienta de selección.

A continuación, seleccione el comando “Texto, Interletraje, Editar interletraje” del menú. El Administrador de objetos
se volverá visible (si no está ya abierto) y el cursor cambiará su forma por la de un cursor de arrastre.

Arrastre el punto de origen de un carácter a otra ubicación.

En el Administrador de objetos verá el nombre de la fuente, el par de interletraje y su valor ajustado.
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Cuando haga clic en “Aplicar” el ajuste se guardará en la tabla de interletraje.

Con cada nuevo texto se utilizará el par de interletraje ajustado en lugar de uno incrustado en la fuente original. La
fuente original se mantendrá intacta.

 
Aplicar
Guarda los ajustes realizados.

 
Eliminar
Elimina un par de interletraje de la tabla de interletraje.

 
Eliminar todo
Borra toda la tabla de interletraje.

 
Aplicar interletraje a bloques de texto seleccionados.

 
Aplicar interletraje a todo el texto de la hoja actual.
También se incluye el texto contenido en grupos y efectos.

Cuando abre hojas que ya contienen bloques de texto los pares de interletraje no se aplican automáticamente.
Cuando desee aplicar pares de interletraje ajustados a bloques de texto existentes deberá hacerlo manualmente
seleccionando el comando “Texto, Interletraje, Restablecer todo el interletraje”. Todo el texto nuevo que escriba
utilizará los nuevos pares de interletraje de forma automática.

Dividir texto
D i v i d i r  t e x t o

Puede dividir un texto en los siguientes componentes.

Líneas
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Palabras

Caracteres

Para dividir en uno de los componentes anteriores, seleccione “Texto, Dividir texto…”.

Unir texto
U n i r  t e x t o

Puede unir líneas, palabras o caracteres seleccionados en un solo bloque de texto. Todos los objetos de texto se
colocarán uno detrás de otro. El último objeto de texto seleccionado es el marcador de posición y pasa a ser el
primer componente de texto del nuevo bloque de texto. El resto de los objetos de texto seleccionados seguirá el
orden de la hoja. 

En el siguiente ejemplo la letra “A” negra es el último objeto seleccionado.

Para unir texto seleccione “Texto, Unir texto”.
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Corrector ortográfico
C o r r e c t o r  o r t o g r á f i c o

Opciones del corrector ortográfico

Si ésta es la primera vez que utiliza el corrector ortográfico deberá ajustar algunos valores de configuración.
Seleccione “Texto, Ortografía, Opciones del corrector ortográfico”.

1 Opciones del corrector ortográfico
Aquí podrá establecer excepciones, por ejemplo, omitir palabras en mayúsculas.

2  Idioma del diccionario principal 
Aquí podrá seleccionar el idioma que desee que utilice el corrector ortográfico.

3 Sugerencias
Aquí podrá establecer el equilibrio entre la velocidad y la precisión.

Vocabularios

Se pueden crear vocabularios para usarlos con un idioma específico o bien con todos los idiomas. Aquí podrá crear su
propio vocabulario de palabras escritas incorrectamente o agregar palabras que no se incluyan en los vocabularios
proporcionados. Seleccione “Texto, Ortografía, Adaptar vocabularios”.
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En el campo “Palabras” (1) puede agregar una palabra para la cual dejará que el corrector ortográfico actúe de una
manera determinada. En el campo Otra palabra” (2) puede indicar el resultado que desee. Con ayuda de “Acción” (3)
podrá seleccionar la acción que se haya de realizar cuando el corrector ortográfico se encuentre con esta palabra.
Por ejemplo, puede elegir que la palabra se sustituya por otra, o que no se tenga en cuenta. Con ayuda de “Archivos”
(4) podrá seleccionar el vocabulario al que desee agregar la palabra.

Corrección ortográfica

Si ha seleccionado una parte de un texto la comprobación sólo se realizará para dicho fragmento, en otro caso el
corrector ortográfico revisará todo el documento.

Seleccione “Texto, Ortografía, Revisar ortografía” o bien presione la tecla de método abreviado “F7”.

Se seleccionarán los errores ortográficos en el cuadro de diálogo y en la hoja.
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1 Aquí puede ver los errores ortográficos que encuentra el corrector.
2 Aquí se muestra la sugerencia. Puede cambiar la sugerencia escribiendo otra o seleccionándola en la siguiente

lista.
3 Una lista con otras sugerencias.
4 Omitir, sirve para omitir la sugerencia y continuar con el siguiente error ortográfico. Si desea que se omitan

todas las palabras similares haga clic en el botón situado junto a éste.
5 Cambiar, este botón cambia el error ortográfico por la sugerencia. Si desea que se cambien todas las palabras

similares haga clic en el botón situado junto a éste.
6 Si desea agregar al vocabulario un error ortográfico que se haya encontrado (no se trata de un error pero

tampoco está incluido en el vocabulario actual) puede hacer clic en este botón.
7 Si ha agregado su propia sugerencia en el campo “Cambiar a” (2) puede pedirle al programa que sugiera otras

palabras que se parezcan a su sugerencia haciendo clic en este botón.
8 El vocabulario actual.
9 Aquí puede abrir el cuadro de diálogo Opción, el cuadro de diálogo Vocabulario o bien cierre este cuadro de

diálogo y concluya la comprobación ortográfica.

Estadísticas de texto
E s t a d í s t i c a s  d e  t e x t o

A través del menú “Texto, Estadísticas de texto” verá un cuadro de diálogo que le muestra el número de palabras,
líneas, caracteres, etc. de una hoja.
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En este cuadro de diálogo verá el número de:

objetos de texto;
palabras;
símbolos (incluidos espacios);
símbolos (excluidos espacios);
líneas.

Insertar símbolos
I n s e r t a r  s í m b o l o s

Para insertar símbolos y caracteres especiales necesitará colocar el signo de intercalación en un bloque de texto y
seleccionar en el menú contextual la opción “Insertar, Símbolo”.

En el cuadro de diálogo podrá seleccionar una fuente y el carácter o símbolo que necesite. Seleccione el botón
“Aceptar” para insertar el símbolo o bien seleccione el botón “Insertar” si desea agregar más de uno.

Text Merge
T e x t  M e r g e

The function Text Merge is an advanced way to automate tedious jobs like creating hundreds of name tags. When you
have a job to create several nametags, container labels, stickers, engraving plates etc. you will normally get a list or
database file to use as a source from your customer. Normally this source would be a .CSV file (semicolon, tab or
comma delimited text), typically a .CSV file would look like this:
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surname;name;occupation
Smith;Ethan;Art Director
Johnson;Emily;Account Executive
Williams;Noah;Marketing manager
Brown;Emma;Sales manager
Jones;Joshua;Graphic designer
García;Madison;Graphic designer
Davis;Liam;Graphic designer
Martínez;Sarah;Graphic designer

The first row would contain the "field" names where as the rest of the file contains the values for that field names. You
could say that a .CSV is a simplified database table. If you would display the sample .CSV file above as a database
table it would look like this:

surname name occupation

Smith Ethan Art Director

Johnson Emily Account Executive

Williams Noah Marketing manager

Brown Emma Sales manager

Jones Joshua Graphic designer

García Madison Graphic designer

Davis Liam Graphic designer

Martínez Sarah Graphic designer

The Text Merge function doesn't stop at text alone, it is possible to use any design containing text, artwork and even
images to create hundreds of different results within minutes. Say for example we have to make some name badges
containing the names of the people from the .CSV example above together with their photo's. This would normally be
a tedious job, especially when there are hundreds of name badges to make instead of the only eight in the sample .
CSV file. 

For implementing the photo's of the people on the name badges we would not only need (of course) their photo's but
we also have to edit the .CSV file to make the software aware of the photo's and where to find these photo's. Their
will also be times you don't receive a .CSV file from you customer and have to create a .CSV file from scratch. For
these reasons we have created a separate software in the "Helpers" range to make these kind of jobs easier.

To find out the best possible way for this workflow and to learn the Text Merge functions we refer to the help file of
the "esHelperCSV" software. The help file of this "Helper" software contains all the information you need to edit and
create .CSV files and how to use them in the EasySIGN Text Merge function.

To get started do the following. In EasySIGN select the menu "File > Run Helpers > esHelperCSV", this will start the
"esHelperCSV" software. 

In the "esHelperCSV" software select the menu "Help > Help" to start the help file and follow the instruction in this
help file to learn about .CSV files and the usage of the EasySIGN Text Merge function.

Sombra

Las sombras, como la mayoría de los efectos de EasySIGN, están orientadas a objetos. Siempre que no convierta una sombra en curvas (por

ejemplo, para ajustes más detallados), puede ajustar las propiedades o incluso quitar el efecto completo para volver a los objetos originales. Las

propiedades de un efecto de sombra se pueden ajustar mediante la “herramienta de arrastre” o el cuadro de diálogo de propiedades. 

Aplicar una sombra
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Seleccione aleatoriamente un objeto vectorial, texto, mapa de bits, efecto, grupo o combinación de estos objetos.

Sombra en perspectiva

A continuación, seleccione el t ipo de sombra que desee en “Efectos, Sombra”. En los siguientes ejemplos se utiliza la sombra en perspectiva. El

procedimiento es el mismo para otros tipos de sombras.

La herramienta de arrastre se activa y se muestra en pantalla una previsualización de la sombra. Puede ajustar cualquiera de los nodos visibles con la

herramienta de arrastre para modificar la forma.

Al presionar "ESC" o el botón de la “herramienta de selección” de la barra de herramientas, la sombra se calculará de nuevo.
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Para cambiar la forma de la sombra en perspectiva, no es necesario que quite la sombra y aplique una nueva desde el menú. Basta con que solicite las

propiedades de una sombra mediante su menú contextual y, a continuación, cambie el t ipo de sombra.

5 Tipo de sombra
Aparece el cuadro de diálogo con el t ipo de sombra seleccionado actualmente.

A Norm a l
La sombra continúa detrás del objeto.
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B Supe rpone r
La sombra continúa parcialmente detrás del objeto.
La opción "Superponer" (1) se activa. Primero debe especificar una distancia, para que se vea la superposición.

C Espa cio  e n b la nco
Se añade espacio en blanco adicional entre el objeto original y la sombra. Aquí también debe especificar un valor para

“Superponer” (1), para ver el resultado.

D Orig ina l con borde  a d iciona l
Se añade un borde adicional alrededor del objeto original y el tamaño de la sombra se basa
en el objeto original.
Aquí también debe especificar un valor para “Superponer” (1), para ver el resultado.

E Som bra  con borde  a d iciona l
Se añade un borde adicional alrededor de la sombra y el tamaño de ésta se basa en el objeto
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original.
Aquí también debe especificar un valor para “Superponer” (1), para ver el resultado.

4 Aquí puede ajustar el estilo de plumilla del objeto original y de la sombra. Si ajusta aquí el estilo de plumilla, en lugar de

hacerlo en la hoja, este estilo se aplicará a todos los originales.

3 Si el tipo de sombra seleccionado tiene un punto de desvanecimiento, puede ajustarlo aquí
numéricamente.

2 Aquí puede ajustar el color de los estilos de plumilla y de relleno de los objetos y la sombra. Si ajusta aquí el color de los

estilos de plumilla y de relleno, en lugar de hacerlo en la hoja, estos estilos se aplicarán a todos los originales.

1 Aquí puede ajustar la profundidad, el ángulo y la superposición de la sombra seleccionada.

Bloque de sombra

A

B



223EasySIGN

C

D

E

Sombra caída

A
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B

C

D

E

Proyectar sombra
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A

B

C

D

E
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Efectos especiales

EasySIGN tiene efectos para los mapas de bits y vectores. Los objetos vectoriales más complejos o grupos de
objetos vectoriales pueden modelarse prácticamente de cualquier forma. Estos efectos también pueden ser puestos
uno sobre otro. Podrá colocar un efecto sobre otro de forma indefinida y de esta manera crear un efecto distinto
nuevamente. Cada efecto puede ser eliminado de un objeto de modo que recupere su forma original. Si desea aplicar
un efecto permanente para llevar a cabo otros procesos o retoques podrá seleccionar las opciones “Editar”,
“Convertir en” del menú y a continuación el comando “Curvas”. Este comando transforma el objeto de efecto en
curvas que podrán ser editadas.

Aplicación de un efecto
Seleccione o escriba un texto. 

En el menú “Efectos” seleccione el comando “Efectos especiales”; EasySIGN aplicará el efecto que se utilizó la última
vez en el objeto y pasará de inmediato al modo de herramienta de arrastre. El objeto tendrá la siguiente apariencia:

Las barras de desplazamiento del parámetro estarán sobre el objeto. Con estas barras de desplazamiento podrá
cambiar la forma del objeto de manera interactiva. 

Cada barra de desplazamiento cambia una parte diferente del efecto. El número de barras de desplazamiento
depende del número de parámetros que admita el efecto en curso. Si desea aplicar el efecto tendrá que seleccionar
con las herramientas de arrastre o pulsar la tecla del tabulador.
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Si desea modificar el efecto deberá seleccionar el objeto y a continuación hacer clic con el botón derecho del ratón.
En el menú desplegable oculto que aparecerá seleccione el comando “Propiedades”.

Aparecerá el siguiente cuadro de diálogo.
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Este diálogo mostrará el efecto actualmente aplicado y los parámetros adecuados (3). En la lista a la izquierda (1)
aparecen todos los efectos disponibles. El diálogo contiene además una ventana de ejemplo (2); esta ventana
muestra un ejemplo de los parámetros que está modificando en el diálogo. Todas las modificaciones de un parámetro
se muestran de una forma simplificada en esta ventana. Si lo que desea es ver un efecto en su forma final, debe
pulsar el botón “Aplicar” (4). El efecto se ejecutará en pantalla. 
Seleccione un efecto distinto y primero haga clic en “Aplicar” (4) y a continuación en "Cerrar" (5).

Para mostrar el hecho de que cualquier otra transformación puede ser una parte útil de un efecto, el objeto tiene que
modificar su escala verticalmente.

A continuación seleccione las herramientas de arrastre para mostrar los parámetros de este efecto.



229EasySIGN

Este efecto sólo requiere un parámetro, arrastre la barra de desplazamiento con las herramientas de arrastre hasta
haber obtenido el resultado requerido.

Podrá poner otro efecto sobre éste una vez más seleccionando la opción “Efectos” en el menú y eligiendo “Efectos
especiales”.

Cada efecto aplicado puede ser eliminado individualmente eligiendo el comando “Quitar efecto” del menú que
aparece con el botón derecho del ratón. Podrá eliminar todos los efectos hasta volver otra vez al objeto original. Si
desea que el efecto sea definitivo, debe elegir la opción “Editar”, “Convertir en “ en el menú y a continuación el
comando “Curvas”.

Líneas de cota

Las líneas de cota en EasySIGN están totalmente orientadas a los objetos. Todas las modificaciones en las
dimensiones o formas se ejecutan de inmediato en las etiquetas de las líneas de cota. Una línea de cota siempre
puede ser seleccionada o agrupada conjuntamente con un objeto. Todas las propiedades de las líneas de cota pueden
ser modificadas utilizando un cuadro de diálogo especial. 
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Aplicación de una línea de cota.
Primero seleccione un objeto y a continuación elija la opción “Líneas de cota” en la barra de herramientas.

El cursor cambiará como se indica a continuación.

Con este cursor seleccione uno de los puntos que desea medir y haga clic en él con el ratón. 

A continuación mueva el ratón (manteniendo pulsado el botón del ratón) hacia el siguiente punto y haga clic
nuevamente.

Suelte el botón del ratón y mueva la “Flecha” a la distancia a la cual desea colocar la línea de cota.

Cuando suelte el botón del ratón se colocará una línea de cota aquí y el tamaño se mostrará en una etiqueta.
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Si selecciona la línea de cota conjuntamente con el objeto y a continuación modifica su escala, la visualización de la
etiqueta se modificará automáticamente según las nuevas medidas.

Cambio de las líneas de cota
Se pueden hacer modificaciones directamente en pantalla utilizando un cuadro de diálogo especial o empleando el
menú del botón derecho del ratón. Para modificar las líneas de cota directamente en pantalla debe seleccionar las
herramientas de arrastre. Puede utilizar las herramientas de arrastre para seleccionar uno de los puntos de control
de la línea de cota y modificarla.

Cuando arrastre un punto de control cerca del extremo de la flecha podrá inclinar la línea de cota pulsando la tecla
mayúsculas mientras arrastra.



232 EasySIGN

Una línea de cota inclinada también muestra el ángulo de la línea.

Haciendo clic en una línea de cota seleccionada con el botón derecho de ratón aparecerá un menú desplegable oculto.
En este menú encontrará varios comandos directos, como el cambio de unidad utilizada en la línea de cota y el
comando “Propiedades”. El comando “Propiedades” llama al siguiente cuadro de diálogo.

1 Altura de texto
 Aquí puede poner el tamaño del texto.
2 Tipo de letra
3 El texto está fijado
 Cuando active esta opción, podrá indicar en “Texto de la etiqueta” (4) qué texto quiere mostrar en vez del

texto calculado automáticamente.
4 Texto de la etiqueta
 Aquí podrá poner su propio texto de la etiqueta.
5 Unidades ligadas a la hoja de trabajo
 Cuando active esta opción la unidad quedará ligada a la de la hoja de trabajo.
6 Unidades específicas
 Cuando active esta opción la etiqueta mostrará siempre la unidad elegida, al margen de la unidad utilizada en

la hoja de trabajo.
7 Precisión
 Aquí puede seleccionar cuantas posiciones decimales se utilizaran para mostrar las medidas.
8 Aquí puede introducir la forma de la flecha.
9 Colocar la etiqueta horizontalmente
 Cuando active esta opción la etiqueta siempre se presentará horizontalmente, al margen del ángulo de la línea

de cota.
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10 Mostrar unidades en el texto de la etiqueta
 Cuando active esta opción la etiqueta también mostrará las unidades utilizadas.

11 Aplicar
 Este botón aplica las configuraciones que ha realizado y las muestra de inmediato en la hoja de trabajo.

12 Cerrar
 Este botón cierra el cuadro de diálogo.

Bordes de pelado

Los bordes de pelado se utilizan para simplificar la extracción del exceso de vinilo durante el cortado. En pantalla los
bordes de pelado pueden pasar por el texto y/o la ilustración, pero durante el trazado sólo se cortará el exceso de
vinilo. Para el texto esto significa que una línea será cortada entre las letras y no a través de ellas. El contorno
exterior de las letras por supuesto no se corta.

Cómo añadir un borde de pelado
Hay dos formas de añadir un borde de pelado. Se puede hacer manualmente, seleccionando la opción “Bordes de
pelado” de la barra de herramientas.

El cursor cambiará como se indica a continuación.

Ahora se puede poner el borde de pelado alrededor del objeto elegido de la misma forma que dibujaría un
rectángulo.

Ahora se ha dibujado el borde pero deben añadirse las líneas que se intersectan. Para hacerlo seleccione las
herramientas de arrastre. El borde de pelado quedará como se indica a continuación.

Se pueden utilizar las herramientas de arrastre para arrastrar las líneas de pelado desde el engrosamiento en las
líneas horizontal y vertical.

Si hace clic en las herramientas de selección nuevamente podrá utilizar el menú que aparece al pulsar el botón
derecho del ratón para llamar al cuadro de diálogo siguiente seleccionando la opción “Propiedades”.
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1 Margen de contorno
 Es la zona entre la parte interior del objeto a trazar y el borde de pelado.
2 Margen de las líneas de pelado
 Es un margen de seguridad ajustable para cortar los objetos.

 Líneas de pelado horizontal y vertical
3 Ninguna
 No se dibujan líneas de pelado.
4 A intervalos
 Las líneas de pelado se dibujan a un intervalo ajustable.
5 Líneas individuales
 Cada línea de pelado puede ajustarse individualmente.
6 Aquí las líneas de pelado que han sido seleccionadas de la lista indicada a continuación se muestran en

pantalla. Las líneas de pelado existentes pueden ser modificadas y se pueden añadir líneas nuevas.
7 Aquí se muestran todas las líneas de pelado que están presentes.
8 Mover
 Mueve una línea de pelado existente.
9 Añadir
 Añade una línea de pelado nueva.

10 Quitar
 Elimina una línea de pelado existente.

También se puede utilizar un diálogo de introducción para añadir bordes de pelado y líneas de pelado a los objetos
seleccionados. Para hacerlo seleccione un objeto y a continuación seleccione en el menú “Insertar”, “Introducción”, la
opción “Selección alrededor del borde de pelado” aparecerá el siguiente cuadro de diálogo.
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1 Margen de contorno
 Es la zona entre la parte exterior del objeto a trazar y la estructura de pelado.
2 Margen de las líneas de pelado
 Es un margen de seguridad ajustable para cortar los objetos.

 Horizontal
3 Ninguna
 No se dibujan líneas de pelado.
4 A intervalos
 Las líneas de pelado se dibujan alrededor a una distancia ajustable.
5 Entre las líneas
 Cuando se ha seleccionado un texto, se puede colocar una línea de pelado entre cada línea de forma

automática.
6 A través de las líneas
 Las líneas de pelado se colocan a través de las líneas de texto.
7 Entre y a través de las líneas
 Se aplican los puntos 5 y 6 simultáneamente.

 Vertical
8 Ninguna
 No se dibujan líneas de pelado.
9 A intervalos
 Las líneas de pelado se dibujan alrededor a una distancia ajustable.

10 Aceptar
 Se aplican todos los cambios realizados y se cierra el diálogo.

11 Cancelar
 Se cierra el cuadro de diálogo sin aplicar los cambios realizados.

12 Predeterminado
 Restablece todas las configuraciones del diálogo a las configuraciones estándar.

Modificaciones al borde de pelado
Utilizando las herramientas de arrastre se pueden llevar a cabo diversas modificaciones directamente en el borde de
pelado.

Si se arrastra alguno de los nodos exteriores, se podrá modificar el margen del contorno.
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Arrastrando alguno de los nodos interiores se podrá determinar la posición y escala con relación al objeto.

Se pueden utilizar las herramientas de arrastre para cambiar las líneas de pelado que ya han sido colocadas.
También se pueden eliminar líneas de pelado arrastrándolas nuevamente a los engrosamientos de las líneas
horizontal y vertical de un borde de pelado.

Colocación de bloques

La colocación de bloques es un efecto rápido y fácil de aplicar que reorganiza objetos de la manera más efectiva
posible con el fin de ahorrar material. Este efecto está orientado a objetos, de manera que incluso después de
aplicarlo siempre puede agregar objetos adicionales o regresar al estado original de los objetos. 

Seleccione “Efectos, Colocación de bloques” para aplicar el efecto a una gama diversa de objetos seleccionados.
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Se mostrará un objeto de control alrededor de los objetos seleccionados. Al arrastrar las puntas del control los
objetos se reorganizarán por sí solos de la manera más eficaz dentro de las proporciones de anchura y altura del
objeto de control.

Puede arrastrar las puntas del control hasta que le parezca satisfactoria la recolocación de los objetos.
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Si considera que el resultado podría mejorarse existe la posibilidad de seleccionar “Propiedades” en el menú
contextual del efecto. En el cuadro de diálogo que se muestra dispone de las siguientes opciones para optimizar el
resultado.

1 Seleccione el sentido que desea editar.
2 Seleccione entre ordenado y óptimo. Óptimo dará el mejor resultado pero es más lento. 
3 Aquí puede establecer el tamaño horizontal o vertical.
4 Aquí puede establecer el espacio entre objetos. En las imágenes anteriores se utiliza un espacio de 2 mm, en

la imagen siguiente se usa uno de 0 mm.

5 Aquí puede seleccionar si desea dividir el texto en líneas, palabras, caracteres o bien no utilizar ninguna
división de texto. El texto se mantiene. Si elimina el efecto de colocación de bloques, el texto volverá a ser
como era antes de aplicar aquél.

6 Si activa esta opción el efecto girará los objetos para obtener un resultado mejor aún. Esta opción da el mejor
resultado cuando se utiliza un gran número de objetos y ningún espacio entre ellos.
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True shape nesting

'True shape nesting' is an automated method of minimizing material usage. ‘True shape nesting’ places objects
together with minimal space between them. Using this functionality is cost efficient and environmental friendly. For
example, the objects on the worksheet below are placed by using the 'Multiply' functionality.

 

Compare this placement to the placement automatically generated with 'True shape nesting' as shown below.
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For some objects the media cost reduction can be even far greater, for example:

Manual or other automated placement
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As you can see 'True shape nesting' saves almost 50% of the media cost.

Workflow

Using 'True shape nesting' is simple and straight forward. Before you can start using 'True shape nesting' you need to
know how to apply the object specifications.

Preparing the objects to be nested

'True shape nesting' requires the objects you want to nest to meet a certain specification. An object ready for 'True
shape nesting' needs to be enclosed in a 'Sticker contour' with the option 'Connect' checked.

Why do you need the option connect checked?
For example see the object below with a 'Sticker contour' applied. For clarity the 'Sticker contour' is represented by a
red line.

At first glance there seems to be noting wrong with this situation but if you want to start the 'True shape nesting', with
50 duplicates of the object, you will get the following error message. 
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Som e objects could not be  p laced. No unique  cutline  de fined fo r 50 objects. 

A unique cutline is a continuous line surrounding each of the objects you want to nest. The object used is one object
that consists of 3 words with spaces between them. The so called 'cutline' consists of tree separated cutline's, one for
each word. You could of course enlarge the distance of the 'Sticker contour' to the object until the lines meet, but that
would not be the best option in this case, see the image below. 

The white space surrounding the object is much larger then was intended (or even required by the customer). It is
much easier and more consistent to let the software try to optimize this object by checking the option 'Connect' in the
'Sticker contour' dialog. Checking this option will give you the following result.

If you think this option will take too much extra space/media after the nesting command, you can also make some
adjustments too the object, for example by quickly closing the gaps between the words.

Remove the 'Sticker contour' from the object (if
any).

Draw some simple shapes to close the gaps, pen
style or color is not important.
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With the new objects still selected, select the
menu 'Ed it > Conv e rt to ' > Line  ty pe  > S ign
Bla nk'. 'Sign Blank' is a line type that isn't
printed or cut, so this is a invisible object for any
kind of output.

Select the original object including the new
objects and group them together.

Select the menu 'Effe cts  > Sticke r  contour'
and apply the 'Sticker contour' to the group.

The actual workflow

You can subdivide the workflow in two scenarios, a scenario in which you have one object that needs to be duplicated
multiple times and then nested and a scenario in which you have many different objects that need to be nested. 

One object multiple times

1 Import or open the object you want to use.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. 

3 Prepare the object like described in the chapter above 'Preparing the objects to be nested'.

4 Multiply the objects using the menu 'Arra nge  > Multip ly '. Enter the number of duplications, in the
dialog that opens, and be sure to uncheck the option 'Modifiable'.

5 Place the objects outside the worksheet because 'True shape nesting' is based on the dimensions of the
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worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

8 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Multiple objects 

1 Import the different objects you want to use into one worksheet.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. Select the tab 'Page'
and adjust the page size accordingly in the dialog that opens.

3 Prepare the objects (if necessary)  like described in the chapter above 'Preparing the objects to be
nested' but do not yet apply the 'Sticker contour'.  We postpone this because it would be very tedious to
apply a 'Sticker contour' to, let's say, 100 objects that need no other preparation.

4 place the objects outside the worksheet because 'True shape nesting' is based on dimensions of the
worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe  ne sting'. Choose your
settings in the dialog that opens.

8 In the 'Prepare True shape nesting' dialog press 'Apply' to apply a 'Sticker contour' to all selected
objects.

9 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

10 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Optional
Say you only need the 'Sticker contour' to nest your objects and not to cut them after printing (where the distance of
the 'Sticker contour is not an option but a customer requirement). If you want to change the distance you first have to
remove the 'Sticker contour’ and reapply them using the 'Prepare True shape nesting' dialog again. This is a simple
four step process.

1 Select all object on the worksheet that are already nested.

2 Select the menu 'Effe cts  > R e m ov e  e ffe ct' which will remove the 'Sticker contour' of all selected
objects. 

3 With the objects still selected open the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe
ne sting' and apply the 'Sticker contour' with the new settings.

4 Apply the 'True shape nesting' again using the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe
ne sting'.
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Tip

If you have multiple objects, with different cutting types and/or distances, that you want to use for Print & Cut, then
you can use them as they are. Just apply a 'Sticker contour' on them using a distance of '0' (or any distance you
desire) and a line type of 'Sign Blank'.

The objects in the image above both have a Print & Cut line applied to an Inline effect (represented by the green line)
and a 'Sticker contour' for 'True shape nesting' with a distance of '0' and 'Sign Blank' as line type (represented by the
red line).

The 'Prepare True shape nesting' dialog

1 Cutter-tool
here you can select the line type you want to use, you have several predefined options to choose from.

2 Data
Here you can set the distance between the object and the 'Sticker contour'. 

When using the first 'Corner shape' options the 'Miter limit' will become available which will determine
how far a corner will 'Overshoot'.

In the image below from left to right the 'Miter limit' is set to 11, 72 and 125.
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3 Line properties
Here you can choose the shape of the corners. In the image below from left to right the first, second
and third option.

The second option is the most widely used because it gives the best result for almost any shape.

The 'True shape nesting' dialog

1 Nesting quality
Here you can set the quality of the 'True shape nesting'. The most commonly used option is 'Normal'
which will give a very good result consuming four times less memory as the 'More detail' option. The
option 'Less detail' is extremely fast and gives a lesser, but still acceptable, result and it also consumes
the least amount of memory.

2 Rotation
Here you can set the rotation allowed when nesting.

3 Options
The most important setting here is 'Incremental'. When this option is checked the 'True shape nesting'
will take objects already placed on the worksheet into account when calculating the nesting result.

The option 'use objects extends for objects without unique cutline' does just as it says. It will use the
objects extends while calculating the nesting result and not the actual shape of the object.

4 Page/cropmarks margin
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'True shape nesting' uses the worksheet as 'work area' or, when present, the inside of the alignment
cropmarks area. Especially with alignment cropmarks, but also with a worksheet, you don't want to nest
your objects all the way to the edge. Here you can enter the space between the outer most nested
shapes and the edge of the work area.

Out of memory

'True shape nesting' is very memory intensive. If you have too many objects selected it can run out of memory. 'True
shape nesting' has an 'Incremental' option, this options works together with the objects already nested on the
worksheet. You can use this option to nest very large numbers of objects as follows.

1 Place all objects you want to nest outside the worksheet.

2 Select a lower number of objects. If for example you tried to nest a 1000 objects all at once and ran
out of memory, select only 100 of them.

3 Start the 'True shape nesting' with your preferred settings, the objects will be placed on the worksheet.

4 Select the next 100 objects and start the 'True shape nesting' with your preferred settings, only now
activate the option 'Incremental'.

5 Repeat step 4 until you have placed all objects.

Distorsiones de mapas de bits (efectos)

En EasySIGN, también se pueden aplicar la mayoría de los efectos especiales a mapas de bits. Una propiedad única es que las distorsiones se

pueden aplicar al mismo tiempo a objetos vectoriales y mapas de bits.

A modo de ilustración, proporcionamos un ejemplo de esta aplicación.

Importe un mapa de bits y coloque texto encima y, opcionalmente, algunos objetos vectoriales más. Puede colocar
estos objetos fuera de los límites del mapa de bits.

Seleccione el mapa de bits y los demás objetos y, elija la opción “Efectos especiales” en el menú “Efectos”.
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Seleccione el efecto que desea utilizar y haga clic en el botón "Aplicar".

Puede superponer cualquier otro efecto, como un arco ajustado.
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Como con la mayoría de las funciones de EasySIGN, no se modifican los objetos originales. En todo momento, puede realizar cambios en el

texto, el mapa de bits y los objetos vectoriales. Incluso puede añadir nuevos objetos mediante el Administrador de objetos. El resultado final se

calculará de nuevo automáticamente.

Tenga en cuenta que cuánto más grande sea el mapa de bits, más tiempo se tardará en calcular el resultado final.

Parámetros para las distorsiones de mapas de bits
Seleccione la opción de menú “Archivo”, “Parámetros” y elija la ficha “Varios”. Aquí encontrará la opción “Resolución
de los efectos de los mapas de bits durante la edición”. Cuanto más alto sea el valor que establezca, más tiempo
tendrá que esperar hasta que se muestre el resultado final.

Vectorización

Vectorización
V e c t o r i z a c i ó n

La vectorización con EasySIGN es un proceso muy fácil de realizar. Si desea realizar una vectorización de “Línea
central”, “Contorno” o “Color”, todo lo que tiene que hacer para conseguirlo es crear un mapa de bits. Los vectores
siempre pueden ser editados y siempre podrá probar a realizar una configuración nueva simplemente ajustando el
comando “Vectorización” nuevamente. Si selecciona el comando “Curvas” en el menú “Editar”, “Convertir en“, podrá
transformar el objeto de vectorización en curvas que pueden ser editadas. Sin embargo, no podrá seleccionar el
comando “Vectorización” nuevamente.
Para una vectorización de “Línea central” o “Contorno” necesitará un mapa de bits en blanco y negro. Para una
vectorización en color necesitará un mapa de bits RGB.
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Vectorización de contorno
V e c t o r i z a c i ó n  d e  c o n t o r n o

Importe o escanée un mapa de bits en blanco y negro, por ejemplo un logotipo y asegúrese de tenerlo seleccionado. 

En el menú “Mapa de bits”, seleccione la opción “Vectorización”; aparecerá el siguiente cuadro de diálogo.

En la opción “Tipo” (1) elija la opción “Línea de contorno”. En la opción “Filtro de polvo” (2) puede seleccionar el grado
de extracción de polvo que realizará EasySIGN. Con el término “Polvo” queremos indicar, en el caso de un mapa de
bits con un logotipo y un fondo bastante blanco, las partes no deseadas para la vectorización (el polvo en el cristal del
escáner, las huellas digitales en el original, etc.). En la opción “Parámetros” (3) puede elegir alguna de las siguientes
opciones.

Prefijar
Aquí puede elegir entre varias configuraciones favoritas. Estas configuraciones mostrarán los mejores resultados para
un determinado tipo de mapa de bits. En este caso (un mapa de bits en blanco y negro) elegiríamos la configuración
“Texto en b/n de alta resolución”. Las barras de desplazamiento debajo del cuadro combinado se ajustarán a los
parámetros preseleccionados. Si desea modificar esta configuración puede elegir la opción “Definido por el usuario”
en el cuadro combinado. Podrá modificar las barras de desplazamiento según sus propias preferencias.

Número de nodos

 

Este parámetro determina la precisión con la que EasySIGN creará los vectores durante la vectorización. Cuantos
más nodos haya, más precisa será la forma. Ésta no es una regla de oro. Si el original está en muy malas
condiciones a veces es mejor seleccionar menos nodos, de lo contrario cada pequeña diferencia será realmente
vectorizada. En este caso un número menor de nodos por lo general dará como resultado una vectorización de mejor
calidad.
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Enfoque de las esquinas

Suele ocurrir durante el escaneado que las esquinas muy marcadas suelen redondearse, dependiendo de la
resolución o que el original es una copia impresa que nunca tuvo las esquinas muy definidas; EasySIGN ofrece la
posibilidad de corregir esto.

Enderezado de curvas

 

Este filtro convierte las líneas ligeramente curvas en líneas rectas. Si el parámetro adquiere un valor superior, tendrá
influencia en las líneas más curvadas.

Filtro horizontal/vertical

 

Este filtro cambiará las líneas que son más o menos horizontales o verticales en líneas totalmente horizontales y
verticales. Si el parámetro adquiere un valor mayor, se incluirán más líneas.

Cuando haya terminado con las configuraciones puede hacer clic en el botón “Aplicar” (4) para ver primero el
resultado o puede hacer clic “Aceptar” para cerrar el diálogo inmediatamente después de la vectorización. El
resultado será aproximadamente el que se muestra.

Vector de línea central
V e c t o r  d e  l í n e a  c e n t r a l

Una de las mejores características de la vectorización en EasySIGN es que no sólo es siempre posible editar
nuevamente, sino que todos los tipos de vectores funcionan de la misma forma. En el caso del vector de línea central,
la única diferencia con el vector de contorno es que en “Vector tipo” (1), en el diálogo, debe activarse la opción “Línea
central”. 

Vector de color
V e c t o r  d e  c o l o r

La forma de vectorizar tiene algunos otros parámetros aparte de los del vector de contorno y línea central, pero por
lo demás funciona exactamente de la misma forma que el vector de contorno. El vector de color sólo funciona con
mapas de bits RGB, por lo que si escanea una ilustración y la convierte en vectorial, debe asegurarse que el escáner
esté configurado en RGB.
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1 Número de colores
 Aquí puede determinar el número de colores que desea incluir en el vector.
2 Combinación de colores
 La opción combinación de colores permite combinar colores que se parecen mucho, en un solo color. La

ventaja de esto es que desaparecen las transiciones poco claras entre colores. Después de la vectorización las
transiciones poco claras suelen convertirse en líneas muy irregulares.

Crear contornos para objetos

En la versión 5, esta funcionalidad se ha ampliado enormemente. Se han añadido nuevas opciones y prácticamente todas las opciones permiten

combinar varios pasos en uno. La mejor manera de explicar las funciones actuales es con ejemplos.

Seleccione un objeto y, a continuación, elija una de las opciones de contornos del menú "Efectos". Según la licencia/versión o tipo de OEM, hay

disponibles las siguientes opciones:

Contorno
Delinear (cuadrado)
Delinear (círculo)
Contorno exterior (doble)
Contorno interior
Contorno interior (doble)
Aumentar trazo
Contorno de la etiqueta
Goma elástica
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1 Tipo

Datos adicionales

2 Distancia

3 Distancia exterior

4 Límite de inglete

5 Número

O pciones adicionales

6 Fusionar resultados

7 Ocultar original

8 Fusión previa

9 En la línea

Propiedades de línea

10 Forma de la esquina

11 Extremos de línea

Propiedades de línea

Todos los tipos de contornos comparten propiedades comunes relativas a la forma de la esquina o los extremos de
línea.
Las propiedades aplicables dependen del tipo de contorno.

Forma de la esquina (10)

Ángulos rectos

Esta opción dibuja un ángulo de inglete donde los bordes exteriores de dos líneas que se cruzan se prolongan hasta que

se cortan. Para evitar que se dibujen estos puntos de corte en casos en los que podrían estar demasiado lejos de los

extremos de la línea, puede ajustar el límite de inglete.
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A: Original

B: Límite de inglete 10

C: Límite de inglete 1

Extremos de línea redondeados

Esta opción dibuja un círculo alrededor del extremo de la línea con un diámetro igual a la anchura de la línea.

A: Original

B: Ejemplo

Ángulo de inglete

Esta opción alisa el punto de corte de dos líneas que se cruzan, eliminando parte de la
prolongación.
Es bastante similar a un ángulo recto con un límite de inglete de "0".

A: Original

B: Ejemplo

Extremos de línea (11)

Inglete

Esta opción alisa la línea en sus extremos, para que no se prolongue más allá.

A: Original

B: Ejemplo

Redondeado

Esta opción dibuja la mitad de un círculo en el extremo de la línea con un diámetro igual a la anchura

de la línea.

A: Original

B: Ejemplo
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Recto

Esta opción prolonga la línea más allá del extremo una distancia igual a la mitad de la anchura de la

línea y alisa el resultado.

A: Original

B: Ejemplo

Afilado

Esta opción dibuja un punto afilado en un extremo de la línea, donde la distancia al mismo es igual a la

mitad de la anchura de la línea.

A: Original

B: Ejemplo

 

Tipo (1)

Aquí puede seleccionar el t ipo que desee. Puede hacerlo durante la creación del efecto, pero puede cambiarlo también posteriormente, cuando

modifique las propiedades de un objeto con un tipo de contorno. Por tanto, puede cambiar el t ipo de contorno en cualquier momento. Si se han

aplicado varios otros efectos encima del contorno, estos efectos se volverán a calcular automáticamente.

A Texto al que se le ha aplicado un contorno, seguido de un arco ajustado, una perspectiva plana y una sombra en

perspectiva.

B El tipo se ha cambiado de "Contorno" a "Contorno doble". Todos los efectos aplicados encima se han adaptado al nuevo

tipo de contorno.

 

Tipo, Datos adicionales y Opciones adicionales

Mediante varios ejemplos, le hemos mostrado algunas de las posibilidades. Cuando utilice contornos, puede crear un gran número de combinaciones

usted mismo. Preste atención al hecho de que puede colocar un número ilimitado de tipos uno detrás de otro.
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En la imagen anterior, de izquierda a derecha, puede ver distintos tipos de contornos solapados unos encima de otros. Si modifica el texto ahora, se

calcularán de nuevo todos los contornos solapados (consulte la imagen siguiente).

Seleccione uno de los tipos de contornos, como "Contorno", en el menú "Efectos".

A: Original

B: Opción Ocultar original (7) deshabilitada.

C: Opción Ocultar original (7) habilitada.
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Contorno

El valor de Distancia (2) es 1 y el valor de Número (5) es 1.

Igual que la primera opción, pero ahora con las esquinas redondeadas.

Igual que la segunda opción, pero ahora con el valor 3 para Número (5).

Delinear
(cuadrado)
Delinear (círculo)

Dos variantes que no basan el contorno en la forma exterior de los objetos seleccionados, sino en la extensión de

la selección. Dispone de las opciones "cuadrado" y "círculo".
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Contorno doble

El va lo r de  Distancia  (2) es 3, e l de  Distancia  ex te rio r (3) es 5 y  e l de  Núm ero  (5) es 1.

Igual que la primera opción, pero ahora con las esquinas redondeadas.

Igual que la segunda opción, pero ahora con el valor 3 para Número (5).

Contorno interior

El va lo r de  Distancia  (2) es 3 y  e l va lo r de  Núm ero  (5) es 1.

Igual que la primera opción, pero ahora con el valor 3 para Número (5).
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Contorno interior
doble

El va lo r de  Distancia  (2) es 3, e l de  Distancia  ex te rio r (3) es 5 y  e l de  Núm ero  (5) es 1.

Igual que la primera opción, pero ahora con el valor 3 para Número (5).

Aumentar trazo

El va lo r de  Distancia  (2) es 2 y  e l va lo r de  Lím ite  de  ing le te  (4) es 1.

Igual que la primera opción, pero ahora con las esquinas redondeadas.

Contorno de la
etiqueta

Como su propio nombre indica, con esta opción puede crear contornos de corte para
etiquetas, aunque su uso no está limitado a esta aplicación.

Puede establecer una distancia positiva o negativa (9) respecto a los originales. Incluso puede establecer el

resultado a una distancia (2) "0", de manera que el contorno de la etiqueta siga exactamente la forma exterior.
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Goma elástica La goma elástica es realmente una función única. Puede imaginar el resultado como un conjunto de uno o varios

objetos alrededor de los cuales se ha estirado una goma elástica. Se trata de una buena alternativa, por ejemplo, al

contorno de etiqueta, si desea crear un contorno de corte sin entradas y, por tanto, con muchos menos líneas de

corte.

Puede establecer una distancia positiva o negativa (9) respecto a los originales. Incluso puede establecer el

resultado a una distancia (2) "0", de manera que la goma elástica siga exactamente la forma exterior.

Esta función también es muy útil para conectar objetos entre sí.

Si intentara dibujar el ejemplo anterior a mano, le llevaría un rato de trabajo conectar los dos círculos

perfectamente. Con la goma elástica y una distancia (2) "0", no le llevará más que presionar un botón.

Línea central

Un efecto orientado a objetos que sirve para obtener la línea central de un objeto de vectores.

Seleccione un objeto y el comando “Efectos, Línea central”.
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En el cuadro de diálogo puede elegir entre dos tipos de línea central y si desea ocultar el original. En nuestro caso se
seleccionó la primera opción y se mantuvo el original visible.

Dado que el resultado es orientado a objetos puede cambiar sus propiedades. Para ello, seleccione “Propiedades” en
el menú contextual. En el cuadro de diálogo de propiedades, seleccione la segunda opción.

El efecto se ha recalculado. Incluso cuando se cambia el original se vuelve a recalcular el efecto.
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Cuando el resultado le parezca satisfactorio puede elegir “Ocultar original” en el cuadro de propiedades y utilizar por
ejemplo el objeto para grabado.  Si desea efectuar algún cambio en el resultado tendrá que convertir el objeto en
curvas (CTRL+Q). Después puede editar el objeto pero ya no estará enlazado con el original.

Optimizar para la aplicación (reventado del color)

De manera especial cuando es necesario aplicar vinilo a un letrero de alumbrado es imposible pegar en frío dos
piezas de unión (sin ninguna superposición, uniéndolas directamente). Y si esto fuera posible, el encogimiento y
estiramiento posteriores impedirían que se mantuvieran encajadas. Por ello es necesario recurrir a la superposición.
La superposición debe ser mínima y aplicarse sin problemas y sin que queden bordes oscuros tras la superposición.
En estos casos EasySIGN cuenta con una función especial, llamada "Optimizar para la aplicación". Dicha función es
fácil de usar y ofrece la posibilidad de realizar recortes en las superposiciones. El recorte de objetos superpuestos
resulta práctico a la hora de pegar dos objetos de iguales dimensiones. Cuando no se recorta el objeto que se
superpone existe la posibilidad de que el objeto subyacente sobresalga por debajo de aquél.

Seleccione los objetos que desea optimizar. Para ver el resultado con mayor claridad, las imágenes se muestran
también en modo de marco.

A continuación, seleccione en el menú “Editar" el comando "Optimizar para la aplicación" y se mostrará el siguiente
cuadro de diálogo.

En este cuadro de diálogo puede escribir en "opciones" (1) la distancia para las superposiciones. Cuando desee
utilizar “Superposiciones delimitadas" active la casilla correspondiente. En "Orden de aplicación" (2) puede ajustar el
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orden de los colores. El resultado, con la configuración utilizada anteriormente, tendrá la siguiente apariencia.

El resultado está orientado a objetos, lo cual significa que siempre puede cambiar las propiedades. Para ello,
seleccione en el menú contextual del objeto la opción “Propiedades”. Cambie el orden de los colores de la aplicación
y haga clic en “Aplicar”, el resultado será como el que se muestra a continuación.

Con la herramienta de arrastrar puede ajustar la anchura de la superposición en la hoja.
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Optimizar para incrustar

Con esta función puede hacer una incrustación orientada a objetos. Seleccione la forma de vectores y el menú
“Editar, Optimizar para incrustar”.

1 Aquí puede seleccionar una herramienta existente en la biblioteca para un valor numérico de diámetro.
2 Fresado masculino
3 Fresado femenino
4 Resultado simétrico

Con la herramienta de arrastrar puede ajustar el objeto directamente en la pantalla. El resultado mostrará si la
herramienta o diámetro seleccionado es adecuado para el objeto.

1 Original
2 Incrustación correcta
3 Herramienta inadecuada, diámetro demasiado largo.

Inserción numérica de líneas

En respuesta a numerosas solicitudes, se ha agregado una funcionalidad mediante la cual puede insertar líneas
numéricamente en EasySIGN. Aquellos usuarios que trabajen con programas de tipo CAD encontrarán esta forma de
controlar el dibujo de líneas particularmente útil. 

En el menú “Insertar”, seleccione “Objetos” y, a continuación, “Línea". Este comando abrirá el siguiente cuadro de
diálogo.
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1 Punto final
 Aquí puede especificar las coordenadas "X" e "Y" de la línea. 
2 Tipo
 Aquí puede indicar si las coordenadas especificadas deben ser un "Punto inicial" o una 'Línea". Cada línea

consta de, al menos, un punto inicial y un punto final (línea). Si sólo ha especificado coordenadas con la
propiedad "Línea", el cuadro de diálogo mostrará una advertencia cuando presione "Aceptar" indicando que se
ha producido un error y le dará la posibilidad de solucionarlo.

3 Agregar
 Cuando termine de especificar una coordenada, agréguela a la lista "Forma” haciendo clic en este botón.
4 Editar
 Cuando seleccione una entrada en la lista "Forma", dicha entrada se mostrará en los campos de edición de las

coordenadas "X" e "Y" y podrá cambiar los valores. 
5 Forma
 Puede seleccionar una entrada para modificarla o eliminarla de la lista.
6 Eliminar
 Este botón elimina una entrada seleccionada de la lista "Forma".

Enlace de hojas

Se ha agregado la opción " Importar enlace " al cuadro de diálogo de importar de EasySIGN. Esta opción se habilitará
cuando seleccione una hoja de EasySIGN en este cuadro de diálogo. Si habilita esta opción, la hoja seleccionada se
importará como un enlace. A continuación, el enlace importado se mostrará como una vista previa en la hoja. Un
enlace siempre se representa mediante un símbolo de vínculo ubicado en la parte inferior de la vista previa.

¿Qué ventajas tiene enlazar?

Esta opción es muy útil si tiene un diseño que desea utilizar en varias hojas y que cambiará con frecuencia. De este
modo, en lugar de tener que importar y colocar el diseño, ajustar su tamaño, etc. cada vez que lo modifique, podrá
importarlo como un enlace. Si el original ha cambiado, las modificaciones se detectarán cuando se identifique la hoja
que contiene el enlace; el cuadro de diálogo de enlace se abrirá automáticamente. 
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Este cuadro de diálogo presenta la opción de actualizar el enlace presionando el botón "Actualizar enlace" (4). 

El marcador de posición se encuentra en la parte inferior izquierda del vínculo. Si ha cambiado el tamaño en el
archivo original, se realizará un ajuste desde este momento.

La hoja original puede abrirse haciendo doble clic en un enlace (si hace doble clic en un mapa de bits enlazado, se
abrirá el editor externo de Windows™ que haya seleccionado).

Si desea adjuntar una hoja enlazada (destruir el enlace y colocar el propio original en la hoja), puede hacerlo
seleccionando la opción "Información del enlace" en el menú contextual del objeto. El cuadro de diálogo de enlace se
abrirá y podrá seleccionar el botón "Desenlazar" (5). Este cuadro de diálogo también permite volver a enlazar el
original (si, por ejemplo, el archivo original se ha movido a una ubicación diferente en el disco duro) mediante el
botón "Volver a enlazar". El botón "Exportar" sólo está disponible para imágenes de mapas de bits.

Enlaces anidados

Si tiene hojas enlazadas que contienen mapas de bits enlazados (u otras hojas enlazadas), debe asegurarse de que
estos enlaces estén actualizados. El programa puede detectar si un enlace a una hoja original está actualizado pero
no si lo están los enlaces incluidos en estas hojas enlazadas. Siempre debe asegurarse de que una hoja original está
actualizada.

Resultado de los enlaces

Cuando abra el cuadro de diálogo de trazado, aparecerán varias opciones, una de las cuales se aplica especialmente
a hojas enlazadas: "Incluir colores de documentos enlazados" (3).  
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1 Sólo selección
 Si ha seleccionado objetos en la hoja, esta opción se activa cuando se abre el cuadro de diálogo de trazado.

Cuando esta opción está activada, la lista "Por color" estará limitada a los colores presentes en la selección de
la hoja.

2 Por color
 Sólo se trazará el color seleccionado en esta lista.
3 Incluir colores de documentos enlazados
 Esta opción sólo está disponible cuando la opción "Por color " está activada. La lista también incluirá ahora

todos los colores de las hojas vinculadas.

Comprobación de enlaces

Cuando se abre una hoja, todos los enlaces presentes se comprobarán para ver si aún están actualizados. Si no lo
están, aparecerá un cuadro de diálogo que le permitirá actualizarlos. Si no los actualiza en ese momento, se
actualizarán (si es posible) durante las tareas de trazado o de impresión. Para evitar sorpresas (el tamaño o
colocación puede ser completamente diferente en un enlace modificado y puede crear problemas inesperados), es
mejor asegurarse de que todos los enlaces están en orden antes de iniciar un trabajo de impresión o de trazado. Si
falta algún enlace, se le avisará antes de iniciar la impresión o trazado. Si no tiene en cuenta esta advertencia, los
vínculos que falten se imprimirán en una representación de baja resolución y la información ausente se omitirá
durante el trazado.

Autonumeración

EasySIGN admite el uso de un objeto de autonumeración. Esta función es muy fácil de utilizar. Simplemente, en el
menú “Insertar”, seleccione “Objetos” y, a continuación, “Autonumeración". Aparecerá un cuadro de diálogo y se
colocará en la hoja un objeto de autonumeración.
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En este cuadro de diálogo están disponibles las siguientes opciones.

1 Número
- "Encabezado" permite asignar un texto fijo que se colocará antes de la autonumeración.
- "Número" permite asignar el número a partir del cual comenzará la autonumeración.
- "Longitud mínima " permite definir el número de ceros utilizados para rellenar una longitud constante de una

autonumeración. Si sólo define un cero, no se utilizará ningún cero en la autonumeración.
- "Sufijo" permite asignar un texto fijo que se colocará después de la autonumeración.
2 "Alineación" permite definir si las partes del objeto de autonumeración se alinean unas detrás de otras o unas

bajo otras.
3 De esta forma puede ver una vista previa de la configuración seleccionada en este cuadro de diálogo.

Puede volver a este cuadro de diálogo en cualquier momento mediante el comando de propiedades a través del
menú contextual del objeto de autonumeración (botón secundario del ratón) para cambiar la configuración. La
configuración se aplicará al objeto de autonumeración al presionar "Aceptar".

Habrá obtenido un objeto de autonumeración básico. Cuando realice una duplicación o coloque un objeto detrás de un
original, mediante el comando "Multiplicar", o lleve a cabo cualquier otra acción que duplique el objeto, podrá permitir
que el objeto de autonumeración se incremente. Independientemente de si el objeto forma parte de un grupo o
diseño, por ejemplo, una etiqueta que contenga autonumeración, el número se incrementará automáticamente. Los
objetos ya incrementados pueden duplicarse. La numeración comenzará de nuevo a partir del objeto de
autonumeración en cuestión.
Es posible crear un intervalo de autonumeración rápidamente moviendo el objeto y haciendo clic en el botón
secundario del ratón (esta acción deja al original detrás). Si utiliza el método abreviado "CTRL+R" (repetir) varias
veces, podrá generar toda una hoja repleta de objetos de autonumeración en cuestión de segundos.

Con algunas limitaciones, las propiedades del texto de un objeto de autonumeración también pueden modificarse.
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1 El "Encabezado" permite modificar el color y la propiedad del texto independientemente para cada carácter. 
2 El autonumeración real permite modificar el color y la propiedad del texto independientemente para cada

carácter. Sin embargo, si el número se incrementa, la propiedad de la autonumeración se basará en el primer
carácter de ésta.

 

 
 
3 El "Sufijo" permite modificar el color y la propiedad del texto independiente para cada carácter.

No puede agregar ni eliminar ninguno de los caracteres de ninguna de las partes anteriores. Para ello debe utilizar el
cuadro de diálogo de propiedades del objeto de autonumeración. Cuando el objeto de autonumeración se modifica a
través del cuadro de diálogo, todos los caracteres tendrán las mismas propiedades que el primer carácter.

 

 
Si ya no desea utilizar el objeto de autonumeración como un objeto, puede convertir el objeto a un objeto de texto
mediante el menú contextual.

Almacenamiento de una selección de una hoja

Cuando haya creado una hoja y desee guardar una parte de ella en una hoja nueva, podrá exportar una selección de
esta hoja a un archivo nuevo. Para ello, elija "Exportar" en el menú "Archivo". En el cuadro de diálogo, seleccione el
formato "EasySIGN" y active la opción "Selección solamente ".

Administrador de objetos

Administrador de objetos
A d m i n i s t r a d o r  d e  o b j e t o s

¿Qué es un administrador de objetos?
El administrador de objetos le permite revertir cualquier objeto a su posición original. Cada acción, como aplicar un
efecto, fusionar objetos etc. no afecta al objeto original cuando se realiza a través del administrador de objetos. Cada
objeto se guarda separadamente de manera interna. Por ejemplo, un texto con varios efectos normalmente no se



270 EasySIGN

podría editar sin eliminar todos los efectos. A continuación, podría editar el texto y después volver a aplicarle todos
los efectos. Gracias al administrador de objetos puede seleccionar directamente la parte del diseño que desea editar
y automáticamente se aplican todos los efectos.

Importante
Cuando el administrador de objetos está activado no se producen resultados finales sino que se crean nuevos
objetos. Cada objeto dentro del nuevo objeto posee las características originales que tenía antes de formar parte de
este último. Si el uso del administrador de objetos le resulta demasiado complicado y desea empezar a trabajar
directamente, puede desactivar algunas funciones en el menú "Archivo", "Parámetros", "Administrador de objetos".
Cada objeto que cree es un objeto definitivo que puede conocer por versiones anteriores. Cuando domine el
administrador, puede volver a activar estas funciones.

Los objetos que se han creado cuando el administrador de objetos estaba (o está) activado se pueden convertir a
objetos definitivos con el comando "Editar", "Convertir a", "Curvas" (CTRL+Q) (no se puede acceder a cada elemento
del objeto por separado).

¿Cómo funciona el administrador de objetos?
Para comprender mejor cómo funciona el administrador de objetos y el proceso, le ofrecemos un ejemplo.

En el menú "Ver", seleccione "Administrador de objetos" para activar el administrador de objetos, si no está visible.
La ventana del administrador de objetos le proporciona una lista con todos los objetos de una hoja.

Cada objeto tiene su propio símbolo y descripción:

El texto mostrará este icono en el mismo color del texto y una etiqueta que representa los primeros caracteres del
texto. Cualquier otro objeto, como un efecto, sólo mostrará el nombre del efecto en la etiqueta.

Para representar el siguiente ejemplo, creamos una hoja vacía.
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1 Escriba texto que contenga un error, por ejemplo "ERRAR" en vez de "ERROR".  Utilice una fuente en negrita
de aproximadamente 19 mm de altura:

2 En el menú "Efectos", abra el cuadro de diálogo "Aumentar trazo" y, a continuación, active las opciones
"Fusionar objetos" y "Eliminar original". En el campo "Distancia" introduzca aproximadamente 0,6 mm:

3 Aplique un efecto. En este caso concreto hemos utilizado "Ajustar arco".

4 Aplique otro efecto.  En este caso concreto hemos utilizado "Sombra caída".

El texto original tiene un error que debe corregir. Debe corregir el texto antes de eliminar todos los efectos, a
continuación, intente volver a aplicar todos los efectos como estaban anteriormente. Seleccione el símbolo para el
texto en el administrador de objetos:
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El texto se selecciona simultáneamente en la hoja:

A continuación, seleccione el símbolo de texto para corregir el texto:

Cuando haya terminado con las correcciones, seleccione la herramienta apropiada en la barra de herramientas y
automáticamente se vuelven a aplicar todos los efectos al texto corregido. Puede corregir el texto y todos los efectos
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que ha aplicado al seleccionar y editar el texto en el administrador de objetos:

El administrador de objetos es una herramienta muy completa, que no sólo sirve para corregir errores de ortografía.
Por ejemplo, si desea cambiar un texto transparente por un texto con relleno, siga los pasos que le indicamos a
continuación:

1 En el administrador de objetos, seleccione el símbolo con contornos:

2 El contorno se selecciona en la hoja:

3 Seleccione el símbolo "Propiedades" en la barra de herramientas del administrador de objetos:
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4 Cuando aparece el cuadro de diálogo de propiedades del contorno, desactive la opción "Eliminar original":

5 El resultado es que el texto y el contorno tienen un relleno. Si selecciona el texto en el administrador de
objetos, puede cambiar sólo el relleno del texto:

Administrador de objetos y fusionado
A d m i n i s t r a d o r  d e  o b j e t o s  y  f u s i o n a d o

Todos los objetos de EasySIGN poseen numerosas ventajas gracias al administrador de objetos. Una función como
"Fusionado" muestra todas las ventajas. Para ilustrar estas ventajas, el siguiente ejemplo está en un marco.
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1 Dibuje un rectángulo y un círculo y colóquelos uno encima del otro.

2 En el menú "Editar", seleccione "Fusionado", "Fundir objeto":

3 Puede mover un objeto con total libertad en la hoja al seleccionarlo en el administrador de objetos:

Después de soltar el objeto se calcula automáticamente el efecto. Puede volver a ordenar todas las partes de su
diseño sin tener que eliminar los efectos aplicados.

Asimismo puede cambiar las propiedades del fusionado. En el cuadro de diálogo de propiedades puede cambiar el
tipo de fusionado: 
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No sólo se pueden cambiar los efectos, sino que también puede agregar nuevos objetos a un efecto ya existente,
como se ilustra a continuación:

1 Cambie el efecto a "Fundir objeto" y dibuje un círculo en el efecto existente:

2 Seleccione el círculo en el administrador de objetos y arrástrelo al fusionado:

El círculo forma parte ahora del fusionado:
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Puede aplicar más efectos al efecto resultante, como por ejemplo una sombra.

Si cambia el efecto de fusionado, automáticamente se cambian el resto de efectos:

Administrador de objetos y contorno
A d m i n i s t r a d o r  d e  o b j e t o s  y  c o n t o r n o

Todos los objetos de EasySIGN poseen numerosas ventajas gracias al administrador de objetos. Una función como
"Contorno" muestra todas las ventajas. ¿Cuántas veces ha aplicado un contorno que luego tuvo que cambiar para
empezar todo el diseño de nuevo? Cuando utiliza el administrador de objetos, en vez de empezar el diseño desde
cero puede cambiar las propiedades:

1 Dibuje cualquier objeto

2 Aplique el efecto "Aumentar trazo":
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3 Si desea esquinas redondeadas en vez de esquinas cuadradas, haga clic en el botón secundario del ratón, abra
el cuadro de diálogo de propiedades y ajuste este parámetro:

4 Si no está satisfecho con la anchura del contorno, abra el cuadro de diálogo de propiedades y modifique este
parámetro o ajuste la anchura directamente en la pantalla con la herramienta de arrastre:

5 Puede ajustar las propiedades de un objeto cuando desee. En el siguiente ejemplo la propiedad ha cambiado a
"Contorno doble".

Sugerencias del administrador de objetos
S u g e r e n c i a s  d e l  a d m i n i s t r a d o r  d e  o b j e t o s

Todos los objetos procesados con el administrador de objetos no están "listos para cortar", sin embargo esto no es un
gran problema. Puede realizar una copia del original y utilizar el comando "Editar", "Convertir a", "Curvas" (CTRL+Q).
Esta operación convierte el objeto en un "resultado final". En este objeto puede utilizar las funciones de salida de
EasySIGN. Siempre tiene el original si desea modificar el diseño.

Puede ser complicado seleccionar el subobjeto correcto (objeto que forma parte de un efecto o grupo), dado que
cada objeto de la hoja está representado en el administrador de objetos. La forma más sencilla es seleccionar el
objeto "principal" en la pantalla, este objeto se selecciona automáticamente en el administrador de objetos y al lado
de esta selección se encuentra el subobjeto.
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Cambiar la propiedad de los objetos no siempre ofrece el resultado deseado dado que no se pueden realizar todas
las acciones de una jerarquía existente de objetos y efectos. En el administrador de objetos, puede seleccionar los
objetos, arrastrarlos fuera de la jerarquía, cambiar o agregar propiedades e introducirlos de nuevo en la jerarquía.
Tenga en cuenta que arrastrar objetos con el administrador de objetos no influye en su ubicación en la hoja, por lo
tanto estarán en la misma ubicación en la jerarquía.

Si no puede seleccionar un objeto en el administrador de objetos, compruebe que la capa que contenga el objeto no
está bloqueada para edición.

Objetos del administrador de objetos: abrir y cerrar
O b j e t o s  d e l  a d m i n i s t r a d o r  d e  o b j e t o s :  a b r i r  y  c e r r a r

En el administrador de objetos (y en el menú "Organizar" hay dos comandos importantes:

Abrir un objeto

Cerrar un objeto

Al editar un objeto que forma parte de una compleja jerarquía en el administrador de objetos puede tener algún
problema con el tiempo de cálculo si necesita realizar muchos cambios. En este caso concreto, es mejor abrir el
objeto con el botón o el comando de menú "Abrir objeto" dado que omite temporalmente los demás componentes de
la jerarquía. De esta manera puede editar el objeto de manera fácil. 

El siguiente ejemplo ilustra texto con sombra, no es exactamente jerarquía compleja, pero ilustra cómo se pueden
abrir objetos:

Si desea ajustar el interletraje del texto, la sombra se volverá a calcular cada vez que suelte el botón del ratón. Este
es un ejemplo de una manera mejor de abrir un objeto. Seleccione el símbolo para el texto en el administrador de
objetos:

A continuación, en el menú "Organizar", elija "Abrir objeto" o haga clic en el botón del administrador de objetos. Sólo
se visualiza el texto seleccionado, las demás partes de la jerarquía son invisibles o se omiten temporalmente:

Ahora puede editar lo que desee sin necesidad de volver a calcular todos los objetos de la jerarquía:
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Los cálculos finales se realizan cuando cierra el objeto en vez de cada vez que suelta el ratón después de arrastrar
un objeto.

CTRL+CLIC o subselecciones

EasySIGN es compatible con subselecciones en grupos y efectos. Una subselección significa que puede seleccionar
una parte de un grupo o efecto sin tener que eliminar el efecto del objeto que desea seleccionar y editar. 

Imagine la siguiente situación:

Los 4 círculos de la imagen superior forman un grupo. Sobre los círculos se coloca un cuadrado rojo y ambos tienen
un efecto de sombra aplicado. Si desea aplicar otro color al cuadrado, debería eliminar el efecto de sombra, a
continuación, aplicar el nuevo color e intentar aplicar el mismo efecto de sombra que tenía antes. La manera más
fácil es seleccionar el cuadrado a la vez que la tecla CTRL:

De esta manera el cuadrado se selecciona directamente. Cuando tiene una subselección, los controladores de la
selección son redondeados en vez de cuadrados.
Dado que CTRL+CLIC funciona a través de la orden en la que se aplican efectos, grupos, etc. no siempre se puede
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seleccionar un objeto directamente. A veces tiene que hacer clic de nuevo para seleccionar "transversalmente" un
efecto o grupo: 

Puede ajustar una subselección (en este caso un cuadrado) como desee, puede cambiar el color, cambiar las
esquinas con la herramienta de arrastre, aplicar una transformación etc.:

Seleccione ahora uno de los círculos amarillos con la tecla CTRL:

Una vez subseleccionado el grupo de 4 círculos puede cambiar el color de los cuatro círculos de una sola vez:

Cuando hace clic de nuevo, sólo selecciona "transversalmente" uno de los círculos y ahora cualquier acción que
ejecute se aplica al círculo subseleccionado:
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Tenga en cuenta que al seleccionar objetos con la tecla CTRL se marcan en el orden en el que se aplicaron los
efectos, grupos etc. A continuación, se muestra una ilustración con un grupo de 4 objetos:

Puede seleccionar directamente el rectángulo amarillo con la tecla CTRL:

En el ejemplo siguiente se han utilizado los mismos objetos y se ha añadido un cuadrado que se ha unido al grupo
existente, es decir, un grupo dentro de otro grupo. Si desea subseleccionar el cuadrado amarillo, haga doble clic para
seleccionar "transversalmente" el grupo adicional:

Importante: cuando se delimitan posiciones con la tecla CTRL
Cuando desea reducir el movimiento de un grupo o efecto con la tecla CTRL, debe iniciar el movimiento primero y, a
continuación, presionar la tecla CTRL (una vez que ha iniciado el movimiento). Si presiona la tecla CTRL primero y, a
continuación, inicia el movimiento, probablemente sólo se moverá la subselección del grupo o efecto.

Ajustar arco

El comando "Ajustar arco" del menú "Efectos" permite colocar texto (y objetos) en un arco especial. El texto
alfabético, como se muestra en el ejemplo siguiente, y el texto arábigo tienen el inconveniente de que cuando se
colocan en un arco convencional, sus conexiones no se alinean. 
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Con el comando "Ajustar arco", puede alinear las conexiones de texto alfabético y arábigo de la forma en que lo
harían si escribiera en línea recta.

Los puntos de conexión del texto mostrado en la ilustración no se alinean. Para solucionar el problema, seleccione el
menú contextual del objeto y, a continuación el comando "Propiedades".

1 Tipo de distorsión
 Aquí puede seleccionar el comportamiento de los objetos del arco.
2 Centro
 Aquí puede establecer la ubicación del objeto en la hoja.
3 Propiedades del círculo
 Aquí puede establecer el radio, el centro y el punto inicial y final del círculo.

Para alinear los puntos de conexión del texto, elija la segunda opción y presiona "Aceptar".
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Todos los puntos de conexión se alinearán ahora. Este efecto se logra distorsionando ligeramente todas las letras. Si
utiliza un poco texto y radio pequeño, la distorsión será mayor que si utiliza mucho texto y un radio grande.

Ajuste de arcos

La forma más sencilla de controlar los ajustes de arcos en la hoja es mediante la herramienta Arrastrar.

El texto original.

Después del aplicar el comando "Ajustar arco".

Ajuste del radio y tensión del arco.
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Ajuste del radio.

Ajuste de la anchura.
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A Rote y ajuste el tamaño usando "I" como punto de delimitación.
 Presionando la tecla CTRL, ajuste el tamaño con "J" como punto de delimitación, dejando "I" bajo el mismo

ángulo.
B Ajuste la longitud y altura del arco.
 Presionando la tecla CTRL, rote alrededor de "J" sin ajustar el radio.

C Igual que "A".
D Ajuste la tensión del arco.
E Mueva los puntos de control.
 Presionando la tecla CTRL, rote alrededor de "J" sin ajustar el radio.
F Igual que "D".
G Rote y ajuste el tamaño mediante "A" como punto de delimitación.
H Igual que "B".
I Igual que "G".
J Movimiento del arco en modo de arrastre

Objetos del arco

Ajuste

Las siguientes ilustraciones muestran la diferencia entre aplicar o no aplicar la distorsión "Ajuste" a los objetos de un
arco. La ilustración de la izquierda utiliza la opción "Ajuste".
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Perspectiva plana

Puede aplicar perspectiva plana en uno o varios objetos simultáneamente. Con este comando puede aplicar una
perspectiva en varios puntos. Esto significa que un objeto puede tener dos puntos de desvanecimiento.

¿Cómo se aplica la perspectiva plana?
Seleccione el objeto al que desea aplicarle el efecto:
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A continuación, en el menú "Efectos", seleccione "Perspectiva plana":

Alrededor del objeto aparecen ocho puntos de control. Los puntos de control de las esquinas controlan la deformación
de la perspectiva. Puede utilizar la tecla CTRL con cada punto de control para restringir el movimiento horizontal y
vertical. 

Para ajustar la perspectiva, arrastre los puntos de las esquinas:
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Esta herramienta le asegura un control total sobre cualquier deformación de la perspectiva plana. Puede utilizar esta
herramienta para agregar un logotipo en un edificio o la cubierta de un coche con una correcta perspectiva. La
herramienta ideal para realizar presentaciones finales de diseños.

Todos los puntos de control se pueden ajustar según la línea guía y los nodos de otros objetos:

Si arrastra los puntos de control hacia el centro, puede mover dos nodos próximos sin afectar la posición relativa de
los mismos:
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Si arrastra un punto de control en una línea mientras presiona la tecla mayús, esta línea será paralela a la línea
opuesta:

Al usar el botón secundario del ratón en un punto de control, aparece un cuadro de diálogo para ajustar la posición
del punto de control de manera numérica:
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Puede aplicar una perspectiva plana a cualquier objeto vectorial:

Efecto de moldeado

Gracias al efecto de moldeado podrá darle forma a cualquier objeto en la forma que desee sin afectar el objeto
original. Con el ejemplo siguiente se ilustran las utilidades de la herramienta de moldeado.

Seleccione un objeto:



292 EasySIGN

Elija el comando "Efectos", "Efecto de moldeado":

Alrededor del objeto seleccionado aparecen 4 nodos. Puede arrastrar estos nodos en cualquier dirección con la
herramienta de arrastre. Si utiliza la tecla CTRL sólo podrá modificar el objeto horizontal y verticalmente:

Al soltar el botón del ratón el objeto adopta la forma del efecto de moldeado

Con los controles de los nodos se puede dar forma al efecto de moldeado:

 

Cuando trabaja con el efecto de moldeado el cuadro de diálogo de edición de nodos está visible, ya que el efecto de
moldeado es compatible con la edición normal de vectores y nodos, agregar nodos, cambiar propiedades, eliminar
nodos etc.

Para agregar y arrastrar un nodo:
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Seleccione todos los nodos y elija el comando "A la línea" para cambiar todas las curvas a líneas:

Este ejemplo ilustra la posibilidad de la edición de nodos con el efecto de moldeado. Si selecciona el nodo o presiona
eliminar puede quitar el nodo que ha agregado anteriormente. Asimismo, puede elegir la opción de eliminar en el
cuadro de diálogo de edición de nodos:

Seleccione ahora los nodos restantes y elija el comando "A la curva" y "Hacer simétrico".

El objeto se adaptará a las curvas del efecto de moldeado. Es imposible que el objeto se adapte a las curvas 100%.
Sin embargo, puede cambiar la precisión de adaptación en el comando "Propiedades" del menú contextual del efecto
de moldeado. A través de este comando se abre un cuadro de diálogo donde se puede establecer la precisión del
efecto:
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Al aumentar la precisión, el objeto se adapta mejor al efecto de moldeado pero tarda más en realizar el cálculo.
Primero debe moldear el objeto a la forma que desee y, a continuación, aumentar la precisión y realizar los últimos
ajustes. 

Baja precisión

Alta precisión

El efecto se puede aplicar en varios y complejos objetos:

El efecto de moldeado es especialmente útil para ajustar texto. Las posibilidades en este caso son prácticamente
ilimitadas:
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Con el comando "Editar", "Convertir a", "Curvas" (CTRL+Q) puede cambiar un objeto moldeado en un objeto
vectorial y con el comando "Efecto", "Extraer desde el efecto" puede mantener los objetos originales.

Mezcla

Con esta opción puede mezclar objetos y colores.

Durante la mezcla, la forma, el relleno y el estilo de línea (color y anchura) se tienen en cuenta.

Cómo crear una mezcla

Seleccione dos o más objetos y, a continuación, el menú "Efectos, Mezcla".
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Se aplica la última configuración utilizada y la aplicación cambia al modo de la herramienta de arrastre.

Arrastrando el nodo en forma de diamante (1) puede determinar si la mezcla de color se aproxima más al primer o al
segundo objeto. Arrastrando el nodo en forma de triángulo (2) puede determinar si las formas de la mezcla deben
parecerse más al primer o al segundo objeto.  

Al hacer clic en la mezcla con el botón secundario del ratón, puede seleccionar "Propiedades" en el menú contextual.
Aparecerá el cuadro de diálogo de propiedades de la mezcla. Aquí puede establecer, por ejemplo, el número de
pasos.

Si hace clic, con la tecla Ctrl presionada, en uno de los originales (o los selecciona en el Administrador de objetos),
puede editar el objeto original (por ejemplo, cambiar el color de la forma). Posteriormente, la mezcla se calculará de
nuevo. 

Puede añadir nuevos objetos a la mezcla (o quitarlos) mediante el Administrador de objetos si los arrastra dentro o fuera del efecto de mezcla.

Si selecciona la opción "Circular" del cuadro de diálogo de propiedades, puede conectar el primer y el último objetos.
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Incluso ahora puede editar los objetos originales o aplicar otros efectos a la mezcla.

Cuadro de diálogo de mezcla

1 Par
Aquí puede seleccionar los distintos pares de mezcla. Si la mezcla está formada únicamente por dos
originales, entonces habrá sólo un par de mezcla, con 3 objetos habrá 2 pares de mezcla, etc.

Originales (1), pares de mezcla (2) y los resultados (3).
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2 Número de pasos

Aquí puede establecer el número de pasos por cada par de mezcla. Si activa la opción "Aplicar a todos los
pares de mezcla", el número de pasos se aplicará a todos los pares de mezcla.

3 Circular

Aquí puede establecer si el primer y el último objetos deben formar también un par de mezcla.

1 : No circular
2 : Inferior
3 : Superior

4 Espacio

En "Desviación", puede establecer si el punto inicial del objeto debe aproximarse más al primer o al segundo objeto.

1 : 0%

2 : -50%

3 : 50%

5 Estilo de relleno y de plumilla para los objetos generados

Con los cuadros combinados de "Centro" y "Otros" puede establecer cómo, por ejemplo, deben comportarse los degradados en una

mezcla.

1 : Configuración predeterminada de las dos opciones en "No ajustar automáticamente".

2 : "Otros" en "Como el objeto inicial".

En "Desviación", puede establecer si el punto inicial de la mezcla de color debe aproximarse más al primer o al segundo objeto.
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1 : 0%

2 : -75%

3 : 75%

6 Nodo de inicio relativo

Esta opción permite determinar el nodo de inicio relativo para cada par de mezcla.

1 : Nodo 0 (configuración predeterminada)2 : Nodo 1

3 : Nodo 2

4 : Nodo 3

7 Todos los objetos

Rotación en el sentido de las agujas del reloj. Esta opción ajusta la rotación de todos los objetos de una
mezcla en la misma dirección.

Algunos ejemplos de efectos de mezcla

Creación de patrones, la imagen superior tiene configurado "Centros equidistantes " y la inferior, "Misma separación".
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La imagen superior tiene un relleno de degradado y, en la inferior, cada carácter tiene un color distinto.

A la izquierda, los objetos originales y, a la derecha, los mismos objetos con una mezcla.

Una combinación de la mezcla y otros efectos.

Diseño de un logotipo con efectos de mezcla.

Efecto de mezcla en líneas.

Cómo crear un efecto de neón con la mezcla

Utilice una fuente en negrita. Aquí se muestra una fuente Verdana con una altura de 200 mm y los caracteres tienen una anchura del 150%.
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Establezca la opción "Sin relleno " para estos objetos y un estilo de línea de 6 mm de anchura. Aplique el siguiente
color al estilo de línea. 
CMYK: 0-100-100-100

Seleccione "Editar, Clonar, Encima". La clonación no es fundamental, pero hace la vida mucho más fácil si es
necesario modificar el texto más adelante. Cree el estilo de línea con 2 mm y aplique el siguiente color.
CMYK: 0-100-100-0

Seleccione "Editar, Duplicar encima". Cree el estilo de línea con 1 mm y aplique el siguiente color.
CMYK: 0-0-0-0

Dibuje un rectángulo negro con esquinas redondeadas detrás de los objetos de texto.

Seleccione todos los objetos de texto y, a continuación, el menú "Efectos, Mezcla".

Si ha utilizado clones, entonces sólo tendrá que editar el "texto de control" para que se vuelva a calcular todo el efecto.
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Clonar

Un clon es una copia de un objeto con todas sus propiedades aún enlazadas con el objeto original. Cada propiedad
del clon que cambie se desconectará del original. 

Esto se entenderá mejor mediante un ejemplo. 

Dibuje un rectángulo.

Seleccione el comando ‘Editar, Clonar, Desplazado”.

A continuación, copie el clon varias veces. Cuando se copia un clon automáticamente se convierte en un clon del
mismo objeto original que el clon del que se copia.

Si se cambia el color del objeto original, el clon también se verá afectado por este cambio.

A continuación, cambiaremos el color de uno de los clones. La propiedad “Color” quedará desconectada de ese clon.
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Si ahora cambiamos el color del original todos los clones se verán afectados excepto aquél del que desconectamos el
color.

Únicamente se desconecta el color, por lo que si cambiamos el tamaño del original se verán afectados todos los
clones.

La propiedad “Color” se vuelve a conectar seleccionando “Restaurar original” en el menú contextual del clon.

En el cuadro de diálogo que se muestra verá una lista (1) de todas las propiedades desconectadas. Seleccione la
propiedad que desee volver a conectar (el color en este caso) y haga clic en “Aceptar”.
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Si ahora cambia la forma y el color del objeto original, dicho cambio afectará a todos los clones.

El objeto original es un rectángulo. Si lo convertimos en curvas los clones también se convertirán. Cada uno de los
ajustes que realice ahora con la herramienta de arrastrar afectará a todos los clones. 

Clones y texto
Los clones de texto tienen una característica especial. Cuando se altera de alguna manera el texto, también cambian
los clones.

 

Clones y efectos
No puede clonar un efecto pero puede aplicar uno a un clon.
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El clon del efecto reaccionará a los cambios que se hagan en el objeto original y por ello recalculará el efecto.

Creación de patrones

Con esta función puede subdividir vectores, efectos, mapas de bits y combinaciones de todos ellos en elementos
independientes.Incluso puede aplicar varios "patrones" uno encima del otro para crear sus propios efectos. Puesto que los "patrones"

constituyen un efecto, los objetos originales no se ven alterados. Puede quitar los "patrones" en cualquier momento.

En los ejemplos siguientes se muestra la posibilidad de aplicar varios niveles de "patrones" a varios objetos.

Orig ina l

Con "pa trone s" hor izonta le s
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Con "pa trone s" hor izonta le s  y  v e rtica le s

Con "pa trone s" hor izonta le s , v e rtica le s  y  ra d ia le s

Aplicar un patrón
Seleccione el objeto o los objetos a los que desea aplicar un "patrón". A continuación, seleccione el menú "Efectos, Creación de patrones” y elija

uno de los submenús.

El último "patrón" utilizado se aplica a los objetos seleccionados. Para ajustar este "patrón", seleccione la opción “Propiedades” del menú

contextual. También puede modificar el "patrón" directamente en la pantalla, mediante nodos de control, pero el cuadro de diálogo proporciona

más opciones y un mayor control.

En "Tipo" (1) encontrará tres categorías principales de "patrones". Cada vez que se selecciona uno de estos subtipos, aparecen activas otras

opciones en el cuadro de diálogo.
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Obje to  orig ina l, e l contorno  negro  adic iona l s irve  para  ind ica r los lím ites.

A Lineal

2 Varios

Ciclo

Esta opción determina la proporción entre patrones y separaciones.

C ic lo: 50%

C ic lo: 25%

C ic lo: 75%

Variabilidad

Esta opción determina la proporción entre la anchura del primer patrón y del último.
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Variab ilidad: 0%

Variabilidad: 100%

Ángulo

Con esta opción, puede establecer el ángulo.

Ángulo: 0 grados

Ángulo: 45 grados

4 Número de

Patrones

Número de patrones que se deben utilizar.
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Patrones: 4

Pa trones: 8

Separaciones

Con esta opción, puede indicar que se añada o se quite una separación de los "patrones". De
esta manera, puede controlar mejor cómo los "patrones" rellenan un objeto.

Separación: 0, e l m ism o núm ero  de  separaciones y  pa trones

Separación: -1, una  separación m enos

Separación: +1, una  separación m ás

B Cónica

2 Varios

Consulte "Lineal" para obtener más información.

Algunos ejemplos:
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C ic lo: 50, Variab ilidad: 0% , Ángulo: 0 grados

C ic lo: 50, Variab ilidad: 50% , Ángulo: 15 grados

C ic lo: 75, Variab ilidad: 0% , Ángulo: 0 grados

4 Número de

Consulte "Lineal" para obtener más información.

Con "patrones" cónicos, sólo puede ajustar el número de patrones aquí.

Patrones: 16

5 Centro

Aquí dispone de varias opciones para influir sobre el centro de los "patrones". En el siguiente ejemplo, el centro está

colocado en

 x: -50% e y: +50%. Puede especificar porcentajes de la anchura y la altura de la selección,
valores numéricos, y coordenadas absolutas o relativas (a la selección).
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C Radial

Esta opción se puede subdividir en "Normal", "Polígono" y "Estrella".

2 Varios

Consulte "Lineal" para obtener más información.

3 Radio

Aquí puede proporcionar los radios exterior e interior (vertical) y también el radio horizontal.
La proporción entre el radio exterior y el radio horizontal determina la relación de aspecto.

Ex te rio r: 100% , Inte rio r: 5% , Horizonta l: 100%

Exte rio r: 100% , Inte rio r: 5% , Horizonta l: 200%

Exte rio r: 200% , Inte rio r: 5% , Horizonta l: 100%

6 Estrella/Polígono

Este grupo de opciones se activa si ha seleccionado “Estrella” o “Polígono”. 

Nº de esquinas

Establece el número de esquinas.
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Nº de  esquinas: 5

Nº de  esquinas: 10

Amplitud

Esta opción influye sobre la forma interior de la “estrella” o “polígono”. 

Am plitud: 50%

Am plitud: 0%

Am plitud: 100%

Puesto que los "patrones" son muy versátiles y se pueden aplicar a casi todos los tipos de objetos, se trata también
de una eficaz función de diseño para varios fines, sin duda no limitada a tareas de corte.
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Redondear

Las esquinas de formas vectoriales se pueden redondear sin alterar los objetos originales. Si una línea recta conecta a una curva, esta línea también

se redondea. Seleccione un objeto del que desea redondear las esquinas.

A continuación, seleccione la opción “Redondear” en el menú “Efectos”.

El cursor cambia al modo de la “herramienta de arrastre” y aparecen nodos de control para redondear alrededor del objeto. Se aplicará

automáticamente la última configuración de “Redondear” utilizada. También puede ajustar el “redondeo” mediante un cuadro de diálogo, donde

puede elegir adicionalmente entre esquinas redondeadas y esquinas “biseladas”.

Exagerando el “redondeo”, puede incluso crear formas totalmente nuevas.
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El “redondeo” se puede aplicar a todos los objetos vectoriales y, por tanto, también se pueden utilizar objetos
estándar (como la “estrella”) para crear nuevas formas.

Puesto que el efecto de “redondeo”, al igual que todos los demás efectos, no altera los objetos originales, puede
ajustar el objeto original mediante la combinación de teclas CTRL+CLICK o mediante el Administrador de objetos.

Plantillas

Asistente para plantillas
A s i s t e n t e  p a r a  p l a n t i l l a s

Mediante el Asistente para plantillas puede cambiar fácilmente una de las muchas plantillas suministradas o bien una
plantilla personalizada. Puede cambiar el texto y los objetos de una plantilla escribiendo un texto nuevo o eligiendo
otro archivo de imagen. Con ayuda del Asistente para plantillas puede incluso cambiar las dimensiones, el tamaño de
página y multiplicar o rellenar una página con copias de una plantilla.
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Seleccione “Archivo, Nuevo a partir de plantilla” para abrir el Asistente para plantillas. En primer lugar, verá un
cuadro de diálogo en el que puede buscar archivos de plantilla con ayuda de una vista previa de las plantillas. 

1 Favoritos: si hace clic en el signo “+” podrá agregar la carpeta seleccionada actualmente a sus favoritos. La
próxima vez que abra este cuadro de diálogo podrá ir directamente a una carpeta seleccionándola en la lista
de favoritos.

2 Aquí puede buscar en la carpeta de su sistema.
3 Aquí puede ver las vistas previas de los archivos de plantilla de la carpeta seleccionada actualmente.

Seleccione la plantilla que desea utilizar y haga clic en “Aceptar”.
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La primera vez que abra el Asistente para plantillas verá una página de bienvenida. Puede cambiar este
comportamiento activando la opción de que desea omitir la página de bienvenida a partir de ahora (1). El número de
páginas que verá en el Asistente depende de las opciones que seleccione y del número de objetos reemplazables de
la plantilla seleccionada.

Se mostrará una página en el asistente para cada texto que tenga la propiedad “Reemplazable”. En dicha página
puede cambiar el texto y la fuente.
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1 Muestra una vista previa de la ubicación del texto en la plantilla.
2 El texto de la plantilla.
3 Texto cambiado.
4 Restablece el texto al texto original.
5 Cambia la fuente.

Cuando una fuente no se haya presente en el sistema se mostrará un signo de interrogación en la lista y se le
aconsejará que cambie dicha fuente por otra existente.

Cuando se hayan procesado todos los objetos de texto de la plantilla verá una página con una imagen reemplazable
(si existe alguna en la plantilla).
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1 Muestra una vista previa de la ubicación de la imagen en la plantilla.
2 Aquí puede seleccionar si desea reemplazar la imagen.
3 Abre un cuadro de diálogo en el que puede buscar y seleccionar imágenes.

Si no selecciona otra imagen se utilizará la de la plantilla.
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1 Seleccione la dimensión predefinida de la plantilla.
2 Indique sus propias dimensiones predefinidas.
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1 Seleccione un tamaño de página predefinido.
2 Defina un tamaño de página personalizado.
3 Consulte los tamaños de página disponibles para sus dispositivos de salida.
4 Seleccione la orientación de la página.

Si no cambia ninguna propiedad se utilizará el tamaño de página de la plantilla.
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Aquí puede multiplicar la plantilla indicando un número o dejando que el programa calcule el número de plantillas
necesarias para rellenar el tamaño de página seleccionado. Asimismo, puede establecer el margen de página y el
espacio entre las plantillas.

Si no cambia ninguna propiedad se utilizará únicamente una copia de la plantilla.

Crear plantillas propias
C r e a r  p l a n t i l l a s  p r o p i a s

Crear plantillas propias es una tarea muy sencilla. Cualquier texto que se escriba en su hoja se puede reemplazar
automáticamente. Puede anular este comportamiento seleccionando “Organizar, Plantillas, Cancelar reemplazable”. Si
desea activar esta propiedad para texto u objetos seleccione “Organizar, Plantillas, Crear reemplazable”.
A continuación, guarde la hoja como plantilla seleccionando “Archivo, Guardar como, Archivo de plantilla”. Si abre
este archivo con el comando “Archivo, Nuevo a partir de plantilla” el asistente mostrará una página para cada texto y
objeto que tenga activa la propiedad “Reemplazable”.

Importación y exportación especiales

Exportación de archivos PDF de Adobe™
E x p o r t a c i ó n  d e  a r c h i v o s  P D F  d e  A d o b e ™

Puede exportar cualquier hoja de EasySIGN a un archivo PDF (Formato de documento transportable). Debe tener en
cuenta que únicamente los objetos que se coloquen en una página se exportarán correctamente. PDF no muestra los
objetos que quedan fuera de una página.
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Seleccione “Archivo, Exportar”. En el cuadro de diálogo, seleccione mediante “Tipo de archivo” el filtro “(Formato de
documento transportable) (*.PDF)” y escriba el nombre del archivo PDF que desee exportar. Cuando haga clic en el
botón “Exportar”, aparecerá el siguiente cuadro de diálogo:

1 Degradados
Utilice vectores por debajo de... pasos.
PDF tiene su propia forma compacta de tratar los degradados. Estos degradados son mucho menores que los
degradados de vectores pero nunca son idénticos a los degradados de su hoja. Si desea que los degradados
sean idénticos a los de su hoja asegúrese de escribir un número aquí que sea mayor que los pasos de relleno
del degradado de su hoja. Si utiliza una configuración predeterminada, 300 pasos es un valor suficiente.

Convertir los degradados en...
PDF reconoce únicamente los espacios de color RGB y CMYK. Si utilizó un relleno HSB de arco iris en su hoja
tendrá que convertirlo a uno de los espacios de color mencionados. Normalmente, CMYK es el método mejor y
más preciso.

2 Mapas de bits
Compresión
Puede elegir entre compresión “Ninguna” y “JPG”. Cuando desee utilizar el archivo PDF para una agencia de
servicios, la mejor elección será "Ninguna". El archivo PDF será mucho más largo que un archivo comprimido
pero los mapas de bits de la hoja tendrán exactamente el mismo aspecto para la agencia de servicios que
tenían en su hoja. Cuando utilice compresión puede que se pierdan algunos detalles. 
 
Calidad
Aquí podrá establecer el porcentaje de compresión.

Correo electrónico

Configuración del correo electrónico
C o n f i g u r a c i ó n  d e l  c o r r e o  e l e c t r ó n i c o

Con el sistema de correo electrónico de EasySIGN, puede enviar de forma rápida y sencilla una hoja activa como un
archivo adjunto a un mensaje o enviar una previsualización para la aprobación del cliente.

Para poder utilizar esta función, debe ajustar algunas opciones. Seleccione el menú “Archivo,”Enviar a, Parámetros de correo electrónico”.

Hoja de fichas Parámetros HTML
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1 Aquí puede indicar a la aplicación cuándo desea que se le avise en caso de que los archivos adjuntos sean demasiado

grandes. Tenga en cuenta que la mayoría de los proveedores aplican un límite de tamaño tras enviarse el mensaje de

correo electrónico, y los clientes también prefieren no recibir mensajes grandes de varios MB.

2 HTML

Datos adjuntos:

aquí puede seleccionar si desea utilizar una plantilla HTML cuando envíe una hoja como un archivo adjunto y, en tal

caso, qué plantilla.

Previsualización:

aquí puede seleccionar la plantilla que desea utilizar cuando envíe una hoja como una previsualización.

Codificación:

aquí puede seleccionar el código de país correspondiente al área donde reside.

Esta selección debe coincidir con la configuración de la plantilla HTML que va a utilizar.
A modo de ejemplo, consulte los parámetros predeterminados y las plantillas proporcionadas.

3 Interfaz

Compatible con EML:
esta opción abre el mensaje de correo electrónico en la aplicación compatible con .EML. En la mayoría de los equipos es

Outlook Express™.

La ventaja de esta opción es que puede editar el contenido de cualquier manera que le
convenga, antes de enviar el mensaje de correo electrónico.
Puede omitir la configuración de la hoja de fichas “Parámetros SMTP”, pero debe ajustar las opciones correspondientes

en la aplicación compatible con .EML.

SMTP directo:
esta opción abre el mensaje de correo electrónico en el entorno de trabajo de EasySIGN. Puede cambiar la plantilla

seleccionada antes de enviar el mensaje. Si selecciona esta opción, deberá ajustar también las opciones de la hoja de

fichas “Parámetros SMTP”.

4 Previsualización:
especifique aquí la anchura máxima en píxeles y la resolución de la previsualización de la hoja. 
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Hoja de fichas Parámetros SMTP

Ajuste únicamente estas opciones si ha seleccionado “Conexión SMTP directo” en la hoja de fichas “Parámetros HTML”.

Sólo debe ajustarlas si no tiene acceso a un cliente compatible con .EML, como Outlook Express, o si no desea utilizarlo. En caso de producirse

problemas, le recomendamos que se ponga en contacto con su proveedor. Él le podrá proporcionar la información necesaria.

Si utiliza esta aplicación en una red corporativa con Exchange Server, póngase en contacto con el administrador de la
red.

1 Remitente

Nombre :

especifique el nombre que se muestra en el campo “De:” de un mensaje de correo electrónico. A menudo se tratará del

nombre de su compañía.

 

Correo electrónico:

especifique aquí su dirección de correo electrónico.

Método de autenticación:

el método que utiliza su proveedor para iniciar una sesión.

Elija una de las siguientes opciones:

NINGUNO : En el caso de que su proveedor admita el inicio anónimo de sesiones. Esto no
es lo habitual.

CRAM MD5: Necesitará este método si desea iniciar una sesión en un servidor LDAP.

AUTH LO GIN: Este método es adecuado en la mayoría de las situaciones. El nombre de
usuario y la contraseña se envían codificados.

PLAIN LO GIN: Igual que AUTH LOGIN, pero el nombre de usuario y la contraseña se envían
sin cifrar. No se recomienda esta opción.
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Nombre de usuario:

especifique aquí su nombre de usuario. Podrá encontrarlo en la carta que le envió su proveedor de correo electrónico. De

lo contrario, deberá ponerse en contacto con su proveedor.

Contraseña:

especifique aquí su contraseña. También podrá encontrarla en la carta que le envió su proveedor de correo electrónico. Si

no la encuentra o la ha cambiado, deberá ponerse en contacto con su proveedor.

2 Servidor

Nombre/dirección del host:
especifique aquí el nombre del servidor SMTP. A menudo se trata de 'smtp.dominio.com', donde debe reemplazar

“dominio” por el nombre de su proveedor. Consulte la carta que le envió su proveedor. Si trabaja con una red

corporativa, puede especificar la dirección IP o el nombre WINS del servidor.

Número de puerto:
especifique aquí el número de puerto que utiliza el servidor SMTP para recibir el correo electrónico. A menudo se trata

del 25. En caso de producirse problemas, póngase en contacto con su proveedor.

3 Libreta de direcciones

WAB:
seleccione esta opción si desea utilizar la libreta de direcciones de Windows™.

Contactos de Outlook™:
seleccione esta opción si desea utilizar la lista de contactos de Outlook™.

4 Conexión:

active esta opción si desea que este programa inicie una sesión automáticamente en su proveedor si no hay una conexión

abierta.

Plantillas HTML de correo electrónico
P l a n t i l l a s  H T M L  d e  c o r r e o  e l e c t r ó n i c o

El sistema de correo electrónico de EasySIGN utiliza plantillas HTML. Mediante una plantilla HTML, puede incluir toda la información

necesaria de la compañía en la presentación de un diseño a un cliente.

Durante la instalación de EasySIGN se instalan varias plantillas HTML de ejemplo en el subdirectorio “ \HtmlTemplates\” del directorio del

programa. Estas plantillas contienen el llamado texto falso (que sirve de marcador de posición para su propio texto) y un logotipo de ejemplo. Las

imágenes, como el logotipo de ejemplo, se colocan en el subdirectorio “ \HtmlTemplates\images\”. Debe ajustar una plantilla antes de utilizarla, de

lo contrario podría sorprender a sus clientes con la aparición del texto falso en los ejemplos. Como prueba, envíese a usted mismo una plantilla

existente por correo electrónico.

Adaptar y crear plantillas HTML
Tiene total libertad para adaptar o crear plantillas. Una plantilla HTML debe contener como mínimo el siguiente texto (literalmente):

<<|InsertWorksheetImageHere|>>

Este texto se utiliza para marcar el punto en el que el programa debe sustituir la previsualización de la hoja (imagen)
en la plantilla HTML.

Hay otra marca, o marcador de posición, que puede usar para añadir texto no estándar adicional al mensaje de
correo electrónico antes de enviarlo.
Este texto siempre aparece en un punto fijo del mensaje y está marcado en la plantilla con el siguiente texto
(literalmente):

<<|InsertAdditionalBodyHere|>>

Cuestiones a las que debe prestar atención
Para evitar problemas, debe prestar atención al uso de una sintaxis HTML correcta. Se recomienda utilizar un editor HTML profesional, como

“Dreamweaver™”. En el caso de que se produzcan problemas al convertir la plantilla HTML a correo electrónico, debe comprobar la sintaxis

HTML. Una sintaxis incorrecta suele ser la causa del problema.

Dado que la plantilla HTML se debe crear sólo una vez, puede encargar su creación a una oficina externa si sus
conocimientos de HTML no son suficientes.

Si ninguna de las opciones indicadas es la adecuada en su caso, puede utilizar la plantilla HTML “basic.htm”.
Esta plantilla contiene sólo una marca (marcador de posición) para la previsualización de la hoja y otra para el texto adicional. En el cuadro de

diálogo de correo electrónico de EasySIGN, puede rellenar este texto según como desee para cada nuevo mensaje.
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Ya uso otras plantillas de correo electrónico, ¿qué hago ahora?
Si ya utiliza otras plantillas de correo electrónico corporativas, por ejemplo, en Outlook™ (no confundir con la aplicación gratuita Outlook

Express™), puede incluir fácilmente previsualizaciones de hojas en estas plantillas. Seleccione la parte de la hoja (o toda la hoja) que desea incluir

como previsualización en la plantilla. Seleccione el menú “Editar, Copiado especial, Como mapa de bits en el portapapeles”. Como este nombre

sugiere, la selección se copia en el portapapeles como un mapa de bits, que posteriormente puede copiar en el mensaje de correo electrónico. La

disponibilidad del menú depende del t ipo de licencia de EasySIGN.

Configurar el correo electrónico
C o n f i g u r a r  e l  c o r r e o  e l e c t r ó n i c o  

Realice los siguientes pasos para configurar el sistema de correo electrónico de EasySIGN.

Paso 1
Ajuste las opciones necesarias. Esto se debe realizar sólo una vez. Consulte el capítulo “Configuración del correo electrónico”.

Paso 2
Cree una plantilla HTML según el estilo corporativo. Esto se debe realizar sólo una vez.

Consulte el capítulo “Plantillas HTML de correo electrónico”.

Paso 3

Enviar la hoja activa como archivo adjunto
Esta opción resulta útil sólo si el destinatario también tiene una licencia de EasySIGN. En caso contrario, un cliente al que desee presentar un

diseño no podrá hacer nada con un archivo de EasySIGN enviado como archivo adjunto en un mensaje de correo electrónico. Utilice el segundo

método para la presentación a clientes.

Seleccione el menú “Archivo, Enviar a, Dirección de correo electrónico (como adjunto)”.

Con un cliente de correo electrónico compatible con .EML
El cliente compatible con .EML se abrirá con la hoja actual como archivo adjunto. Si ha seleccionado esta opción, se

utilizará una plantilla para el texto del mensaje.

Con una conexión SMTP directo
Aparecerá un cuadro de diálogo en EasySIGN, donde puede rellenar opciones del mensaje de correo electrónico como

“Para”, “”CC” y “CCO”. Aquí todavía puede seleccionar una plantilla para el texto del mensaje.

Para conocer el procedimiento, consulte "Cuadro de diálogo SMTP".

Si no utiliza una plantilla con este método, no es necesario que rellene el campo “Texto adicional”, puesto que éste
sólo se usa con plantillas.

Enviar la hoja activa (o parte  de e lla) como previsualización al cliente
Utilice esta opción si desea enviar una previsualización para la aprobación del cliente. Todas las personas que tengan un cliente de correo

electrónico que admita mensajes HTML (casi todos los clientes de correo electrónico modernos) podrán ver la previsualización.

Seleccione el menú “Archivo, Enviar a, Dirección de correo electrónico (previsualización en plantilla)”. 

Con un cliente de correo electrónico compatible con .EML
El cliente compatible con .EML se abrirá con una previsualización de la hoja actual en la
ubicación del marcador de posición para previsualizaciones (<<|InsertWorksheetImageHere|
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>>).

Con una conexión SMTP directo
Aparecerá un cuadro de diálogo en EasySIGN, donde puede rellenar opciones del mensaje de correo electrónico como

“Para”, “”CC” y “CCO”. Aquí todavía puede seleccionar una plantilla para el texto del mensaje. En el mensaje final, el

marcador de posición para previsualizaciones se reemplazará por una previsualización de la hoja activa.

Para conocer el procedimiento, consulte "Cuadro de diálogo SMTP".

Cuadro de diálogo SMTP
A continuación se muestra el cuadro de diálogo SMTP y una descripción de sus componentes.

Prioridad "baja" del mensaje de correo electrónico.

Prioridad "normal" del mensaje de correo electrónico.

Prioridad "alta" del mensaje de correo electrónico.

Abre una previsualización del mensaje en Internet Explorer™.

Guarda el mensaje en el disco como un archivo .EML.

Vacía el campo " Archivos adjuntos".

Abre el cuadro de diálogo de parámetros.

1 Plantilla:
aquí puede seleccionar la plantilla que desea utilizar.

2 Archivos adjuntos:

aquí puede seleccionar los posibles archivos adjuntos.

3 Información:

aquí puede rellenar la información estándar del mensaje de correo electrónico. Al presionar los botones “Para”,

“CC” y “CCO” se abre la libreta de direcciones.

4 Texto adicional :
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este campo resulta útil sólo si utiliza el marcador de posición <<|InsertAdditionalBodyHere|>> en la

plantilla HTML. El marcador de posición se sustituye por este texto.

Transparencia

Mapas de bits y vectores de transparencia
M a p a s  d e  b i t s  y  v e c t o r e s  d e  t r a n s p a r e n c i a

EasySIGN incluye algunas funciones muy avanzadas y exactas para aplicar y administrar la transparencia. La
transparencia se puede aplicar a todos los objetos de una hoja, incluidos los grupos, efectos y el estilo de línea de los
objetos. Hay disponibles varios métodos de transparencia distintos: 

1 Transparencia uniforme

2 Transparencia de degradados

3 Transparencia de patrones

4 Transparencia de mapas de bits con canales alfa

1 : Transparencia uniforme

Este tipo de transparencia se puede aplicar a cualquier objeto. El procedimiento es el siguiente:

Seleccione el objeto (u objetos) al que desea aplicar la transparencia.

A continuación, seleccione la herramienta de transparencia en la caja de herramientas.

Aparecerá un cuadro de diálogo flotante donde se puede administrar la transparencia.

La transparencia predeterminada es “Ninguna”. Cámbiela a "Uniforme".
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En la hoja, la transparencia del objeto cambiará al valor predeterminado de 50%. Si reduce este valor a 20%, el
objeto se volverá menos transparente. Para ello, escriba el valor 20 y presione Entrar.

Si cambia el valor de transparencia a 80%, el objeto será prácticamente invisible, mientras que con 100% será totalmente transparente.

Ahora, haga clic en la herramienta de selección en la caja de herramientas (o presione “ESC”)… El cuadro de diálogo de transparencia desaparecerá

y el objeto se seleccionará de nuevo.
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A continuación, aplique un estilo de línea al objeto transparente.

Como puede observar, el estilo de línea también es transparente. Ahora cambiaremos las propiedades de
transparencia. Este método es siempre el mismo; primero seleccione el objeto transparente y, a continuación, haga
clic en la herramienta de transparencia en la caja de herramientas.

Cambie la transparencia a 50% (1).

En el cuadro combinado (2), seleccione "Relleno". Ahora sólo será transparente el estilo de relleno.

En el cuadro combinado (2), seleccione "Plumilla". Ahora sólo será transparente el estilo de plumilla.
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Puede quitar la transparencia de un objeto; para ello, selecciónelo, haga clic en la herramienta de transparencia y
elija la opción “Ninguna” en el primer cuadro combinado.

A la izquierda puede ver un grupo de objetos complejos sin transparencia y, a la derecha, el mismo grupo con
transparencia.

Por supuesto, la transparencia se puede aplicar a una combinación de mapas de bits y objetos vectoriales.

2 : Transparencia de degradados

El procedimiento para aplicar una transparencia de degradado es similar al que se utiliza para aplicar la transparencia uniforme, pero con algunas

funciones adicionales.

Seleccione el objeto que desea volver transparente.
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Seleccione la herramienta de transparencia en la caja de herramientas y seleccione una de las opciones de transparencia de degradado.

(Lineal, Radial, Cuadrada o Cónica).

Como con los degradados normales, puede arrastrar los controladores para establecer la dirección de la
transparencia. Esto se puede realizar directamente en la pantalla o mediante el cuadro de diálogo de degradados.

El cuadro de diálogo de transparencia contiene las siguientes opciones:

1 Selecciona distintos tipos de transparencia.

2 Inicia la transparencia en porcentaje.

3 Finaliza la transparencia en porcentaje.

4 A qué se debe aplicar la transparencia, Relleno, Plumilla o ambos.

5 Opciones adicionales. En el caso de un relleno transparente, aparecerá el cuadro de diálogo de
degradados.
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A la izquierda puede ver un grupo de objetos complejos sin transparencia y, a la derecha, el mismo grupo con
transparencia.

Por supuesto, la transparencia se puede aplicar a una combinación de mapas de bits y objetos vectoriales.

3 : Transparencia de patrones

Un patrón transparente se puede aplicar de igual manera que una transparencia uniforme o una transparencia de degradado.

En (1), seleccione “Patrón”.

Si está activada la opción “Patrón”, se utilizará de forma predeterminada un mapa de bits en blanco y negro como
patrón transparente. Cuando se usa un mapa de bits en blanco y negro, las opciones (2) y (3) están disponibles en el
cuadro de diálogo. Se establecerá la densidad de los píxeles blancos y negros. En el ejemplo se utiliza una
transparencia del 50% para los píxeles blancos.
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Ahora, haga clic en el botón de las opciones adicionales para que se muestre el cuadro de diálogo de rellenos en
mosaico y pueda aplicar otro patrón transparente.

El mapa de bits elegido está en escala de grises, por lo que las opciones (2) y (3) ya no estarán disponibles.
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Puede modificar las opciones directamente en la pantalla o mediante el cuadro de diálogo de rellenos en mosaico.

A la izquierda puede ver un grupo de objetos complejos sin transparencia y, a la derecha, el mismo grupo con
transparencia.

Por supuesto, la transparencia se puede aplicar a una combinación de mapas de bits y objetos vectoriales.

4 : Transparencia de mapas de bits con canales alfa

EasySIGN no sólo permite importar mapas de bits con canales alfa, sino también crear manualmente canales alfa. Se
puede crear un canal alfa a partir de cualquier objeto imaginable.

Primero importe un mapa de bits. Éste puede ser un mapa de bits sin un canal alfa.
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A continuación, cree una sencilla mezcla entre dos rectángulos de distinta anchura. No es necesario que esta mezcla esté colocada encima del mapa

de bits; puede estar colocada en cualquier lugar de la hoja.

Seleccione el mapa de bits y haga clic en la opción de menú "Mapa de bits”, “Transparencia”, “Elegir…". El puntero del
ratón cambiará de forma. Utilícelo para seleccionar la mezcla.

1 Posición

Sin cambios

Esta opción se puede utilizar si los objetos para el canal alfa están ya colocados correctamente
en el mapa de bits.

Ajustar

Esta opción ajusta los objetos seleccionados para el canal alfa a la anchura y la altura del mapa
de bits.

Alinear

Esta opción alinea los objetos seleccionados para el canal alfa respecto al mapa de bits,
utilizando las opciones seleccionadas en la paleta de alineación.
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2 Previsualización

Esta opción muestra una previsualización del resultado final. Puede elegir entre “antes” y
“después”.

3 Color inicial del canal alfa

Establece el comportamiento del canal alfa donde no hay objetos que lo cubran. Puede elegir entre blanco y negro.

4 Combinar

Invertir

Esta opción convierte todos los objetos blancos en negros y viceversa, para invertir la
transparencia de una manera eficaz. También tiene en cuenta los valores grises.

Sustituir

Puede aplicar un número ilimitado de objetos al canal alfa, pero si activa esta opción, todos los
canales alfa presentes se sustituirán por la selección actual.

Añadir

Si ya hay un canal alfa, esta opción permite añadirle la selección actual.

Restar

Si ya hay un canal alfa, esta opción permite quitarle la selección actual.

Intersección

Si ya hay un canal alfa, se producirá la intersección del canal con la selección actual.

5 Varios

Quitar objetos seleccionados

Quita la selección activa después de aplicarla al canal alfa.

Suavizado

Se recomienda esta opción, ya que evita efectos ‘escalonados’ en el canal alfa. Si sólo utiliza objetos horizontales y

verticales (como cuadrados), puede desactivar esta opción.

Seleccione otro objeto (1)..

Si se activa esta opción, se puede seleccionar otro objeto para el canal alfa inmediatamente después de hacer clic en

Aceptar.

Aplicar los objetos ahora

Esta opción está disponible si activa “Seleccione otro objeto (1)..”. Aplicará primero la selección actual antes de que se

pueda realizar la nueva selección.

Para el canal alfa, hemos elegido las siguientes opciones en nuestro ejemplo:

1 Ajustar

2 Blanco

3 Invertir/Sustituir

5 Suavizado

A continuación, dibuje una elipse, seleccione el mapa de bits y elija la opción de menú "Mapa de bits”, “Transparencia”, “Elegir…”

Seleccione las siguientes opciones:

1 Ajustar

2 Blanco
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3 Invertir/Añadir

5 Suavizado

El menú "Mapa de bits, Transparencia..." contiene las siguientes opciones:

Mostrar

Activa o desactiva el uso del canal alfa.

Invertir

Invierte la transparencia.

Recortar

Esta opción reduce el tamaño del mapa de bits lo máximo posible, utilizando los límites del canal
alfa.

Elegir

Consulte la descripción detallada mostrada anteriormente.

Separar

Esta opción separa el canal alfa del mapa de bits.

Estas opciones también están disponibles mediante el menú contextual del mapa de bits.

Parámetros de transparencia

Si desea imprimir las transparencias o exportarlas a otras aplicaciones, consulte las opciones para hacerlo. Seleccione el menú “Archivo”,

“Parámetros” y elija la ficha “Salida”. Aparecerá el cuadro de grupo “Transparencia/Patrón de relleno” con las siguientes opciones:

Calcular como RG B  o  CMYK
Establece si la transparencia se va a calcular como RGB o como CMYK. Para obtener
los resultados más precisos, elija CMYK.

Resolución PPP
La configuración óptima es 300 PP, pero en hojas de gran tamaño (como las que se
utilizan para imprimir en formato grande) será suficiente una resolución de 72 PPP,
especialmente si el resultado se va a mostrar a una cierta distancia, como en una
valla publicitaria.

Intersección

completa como

mapa de bits

Si activa esta opción, la transparencia se aplicará de forma óptima. Si no se utiliza
esta opción, pueden producirse diferencias de color en hojas complejas donde se
superpongan distintos objetos transparentes.

Suavizado Proporciona la mejor previsualización de la transparencia, ya que los resultados se
suavizan. Si no utiliza esta opción, es posible que se produzca algún efecto
‘escalonado’.

En EasySIGN, la transparencia se calcula con la máxima precisión para garantizar la mayor calidad posible al
exportar a otros formatos. Esto tiene un precio en la velocidad de procesamiento, si la hoja tiene muchos objetos
transparentes. Puede reducir el tiempo necesario si disminuye, por ejemplo, la resolución de exportación.
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Compatibility

Instalación de Compatibility
I n s t a l a c i ó n  d e  C o m p a t i b i l i t y

La instalación de “Compatibility” para cada programa compatible se realiza durante la instalación de EasySIGN.
Durante esta instalación, puede elegir el programa para el que desea instalar “Compatibility”.

Después de la instalación

Puede iniciar “Compatibility” mediante “Inicio, Programas, Compatibility”, o directamente desde EasySIGN, mediante
el menú "Archivo, Compatibility". 

Trabajar con “Compatibility”
T r a b a j a r  c o n  “ C o m p a t i b i l i t y ”

Inicie “EasySIGN” mediante el menú "Archivo, Compatibility", el programa deseado.

Aparecerá un icono en la bandeja del sistema de Windows™ y se iniciará el programa seleccionado (en este ejemplo, CorelDRAW™ 8). Si el

programa deseado no se inicia o aparece un mensaje que indica que no se ha encontrado el programa, inicie el programa manualmente y, a

continuación, "Compatibility".

Cada icono de una aplicación compatible tendrá un color distinto. El icono sólo se muestra cuando se inicia el programa seleccionado.

Cuando haga clic en el icono, aparecerá el siguiente menú.

1 Cancelar

Cierra el menú.

2 Cerrar
Cierra el programa “Compatibility”.

3 Cambiar a EasySIGN.

4 Seleccionar idioma.

5 Sign Center (sólo en combinación con CorelDRAW™) Esta parte se tratará más adelante.

6 Exportar
Coloca la hoja (o mapa de bits) activa directamente en EasySIGN.

Excepciones
Si se utiliza Macromedia Freehand™, no se mostrará ningún icono en la bandeja del sistema. El enlace entre EasySIGN y este programa se

controla mediante el menú “Adicional, EasySIGN, Exportar”.

En cada programa debería aparecer un menú adicional. Por ejemplo, en Adobe Illustrator™ dispone de la posibilidad de exportar sólo los objetos

que se pueden cortar.

Programas de diseño vectorial

Si utiliza “Compatibility” con Illustrator™ o CorelDRAW™, por ejemplo, se optimizará una copia de la hoja activa
antes de exportarla a EasySIGN.
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Programas de mapas de bits

Si utiliza “Compatibility” con Photoshop™ o Corel PhotoPAINT ™, por ejemplo, se optimizará una copia del mapa de bits activo antes de

exportarlo a EasySIGN.

Opciones en CorelDRAW™

Si ha instalado CorelDRAW™ y nunca ha utilizado la función de exportación al formato de Adobe Illustrator (.AI) con anterioridad, deberá hacerlo

manualmente esta vez para inicializar los filtros de exportación de CorelDRAW™. La ubicación a donde se exporta o el contenido de la hoja no

tiene importancia. Esto es necesario hacerlo sólo una vez.

Limitaciones generales

Nunca utilice más de una instancia de un programa compatible al mismo tiempo. Por ejemplo, si tiene dos instancias
de CorelDRAW™ 10 abiertas, no se garantiza que funcione “Compatibility”.

Limitación para productos de Adobe™

No pueden estar ejecutándose a la vez dos versiones distintas del mismo producto. Por ejemplo, no puede estar ejecutando Illustrator™ 9 e

Illustrator™ 10 al mismo tiempo si utiliza “Compatibility” para estos productos.

Grabado/fresado

General
G e n e r a l

El módulo de fresado de EasySIGN es un producto que contiene todos los métodos de trabajo 2.5D. Al trazar sólo
existen datos de 2 dimensiones, mientras que con 2.5D se agrega la profundidad. 2.5D es un concepto muy amplio,
que puede utilizarse para grabado, fresado o incluso para una aplicación especial. ¿Qué significa cada uno de estos
términos exactamente?

Grabado
Es el corte de texto y logotipos a partir de un material. La mayoría de estos cortes no son muy profundos y nunca
atraviesan el material. Muchos materiales de grabado disponen de una capa superior de un color diferente que tras el
corte muestra la capa inferior. Algunos ejemplos pueden ser las etiquetas de nombres y las etiquetas de tipos.

Fresado
Con el fresado se corta atravesando el material. Asimismo, la extracción parcial de un material se denomina fresado.

Cuando se tiene un objeto de curvas, dicho objeto contendrá información suficiente para ser usado como objeto de
trazado. Para el grabado será necesaria más información. Esta información adicional se denomina “Estilo de
producción”. Puede enlazar este estilo de producción con cualquier objeto de vectores. Dentro de este estilo de
producción se incluye el estilo de relleno, la profundidad, la velocidad, etc. Para el fresado, es necesaria también otra
información adicional: si se desea fresar el interior, el exterior, la velocidad, etc. Esta información se incluye también
en el estilo de producción. 

Aplicar un estilo de producción
Se puede asignar un estilo de producción a un objeto de dos maneras distintas: manual y mediante un asistente.

Estilo de producción manual
Seleccione un objeto de vectores (también puede utilizarse un objeto de texto) y el icono de estilo de producción.

Se mostrará el siguiente control desplegable.

Seleccione la primera opción (1).
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1 Barridos
Un estilo de producción se compone de uno o varios barridos. En muchos casos basta con un barrido, pero en
el caso de materiales gruesos son necesarios más barridos. Los distintos barridos se muestran en (1). Después
de seleccionar uno de estos barridos el resto del cuadro de diálogo mostrará la configuración del elemento
seleccionado.

2 Tipo de barrido

A Tipo de barrido
Determina el tipo de barrido. Cada tipo tiene una finalidad concreta. Con esta configuración
puede determinar lo que se hará con la forma. 

Línea
Un barrido de línea seguirá el contorno del objeto original.

Masculino
Este barrido se realizará por la parte exterior de una forma, y el resultado será la forma real
dibujada.

Fem enino
Este barrido se realizará por la parte interior de una forma, y el resultado será la extracción de
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la forma real del material.

Re lleno  de  ‘S’
Este barrido extraerá la parte interior de una forma y seguirá una trayectoria con forma de “S”
a lo largo del material. La forma se extraerá del material sólo hasta una profundidad
determinada.

Re lleno  de  línea
Una forma se rellenará con un conjunto de líneas rectas, apropiadas para el láser y otras
técnicas en las que el calor podría provocar un problema.

Re lleno  de  línea , o rdenado
Igual que el “Relleno de línea”, pero en este caso la herramienta escogerá la trayectoria más
corta que ha de seguir.

Re lleno  de  is la
Se extraerá todo el interior de una forma siguiendo una trayectoria que traza círculos
concéntricos partiendo desde el exterior hasta el centro de la forma. 

B Ángulo
Ángulo de las líneas de relleno.

C Superposición de relleno
Tamaño de la superposición en la que las líneas se cubren entre sí.

D Margen
Distancia desde el exterior de un relleno hasta el interior de una forma.

3 Herramienta

A Herram ienta
Herramienta de la biblioteca que se utiliza para hacer el barrido.

B Pro fundidad, ve loc idad y  ve loc idad de l m otor
Estos valores se indican normalmente en la configuración del dispositivo. Aquí, estos valores
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generales pueden sobrescribirse para cada forma. Debe usarse sólo cuando una forma se
deriva de la configuración predeterminada.

4 Zona de inicio

Zona  de  inic io
Cuando se está fresando una forma a veces no se desea bajar la herramienta exactamente
sobre la esquina de dicha forma. Hacerlo podría dar lugar a pequeñas marcas en el resultado.
La “zona de inicio” evita que esto suceda al iniciarse el barrido en un lugar seguro de la parte
exterior de la forma y después desplazarse hasta el principio propiamente dicho. 

Esta opción puede utilizarse asimismo con materiales blandos. Al establecer la “Zona de inicio”
como “Donde sea posible” evita que se produzcan marcas en los puntos en los que la
herramienta reduzca la velocidad. 

Estilo de producción mediante el asistente
El Asistente para trayectorias de herramientas constituye una ayuda a la hora de aplicar una trayectoria de
herramienta complicada. En este asistente se implementa una serie de posibilidades de trayectorias de herramientas
de uso frecuente. Este asistente puede iniciarse desde la barra de herramientas o bien desde el cuadro de diálogo
para las opciones de trayectorias de herramientas.



344 EasySIGN

El asistente le preguntará qué desea hacer, y mostrará ilustraciones explicativas. Responda a estas preguntas y haga
clic en “Siguiente” hasta que llegue al botón “Aplicar”. Si inició el asistente desde la barra de herramientas, la
trayectoria de la herramienta se aplicará al objeto seleccionado. Si inició el asistente desde el cuadro de diálogo de
opciones para trayectorias de herramientas, la trayectoria de la herramienta se agregará a la lista de este cuadro de
diálogo.

Biblioteca de herramientas
Mediante este cuadro de diálogo puede definir sus propias herramientas. Seleccione el menú ‘Archivo, Biblioteca de
herramientas”.
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1 Biblioteca de herramientas
 Aquí encontrará todas las herramientas existentes. Si selecciona una de ellas podrá cambiar su configuración

en “Propiedades de la herramienta” (2).

2 Propiedades de la herramienta

A Anchura del final del mango de la herramienta. Esta opción estará deshabilitada si el mango
tiene la misma anchura a todo lo largo.

B Anchura de la punta de la herramienta.

C Profundidad máxima a la que puede bajar la herramienta en el material.

D Ángulo de la punta de la herramienta.

E Aquí puede asignar un color a la herramienta: Se mostrará en la hoja el color de la
herramienta a fin de distinguir las diferentes herramientas.

3 Aquí podrá agregar o eliminar una herramienta de la biblioteca. 
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Add an Engraver/Router
A d d  a n  E n g r a v e r / R o u t e r

To add an Engraver/Router select the menu 'File > Device Setup > 'Add Router Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.

Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.
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How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.

To finish the installation of your device, click 'Finish'.
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Configurar dispositivo
C o n f i g u r a r  d i s p o s i t i v o

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Router/Engraver Settings' and click on 'Router/Engraver Setting 0'. On the right the
available Router/Engraver settings will become visible.

Aparecerán cuatro iconos. Al hacer doble clic en un icono se abrirá el cuadro de diálogo de configuración.

A Ordenación y optimización

1 Sin ordenar
 El diseño se grabará/fresará en el orden en el que se dibujó.
2 Velocidad
 El orden de los objetos se ajustará para obtener la velocidad óptima.
3 Transporte de vinilo
 El orden de los objetos se ajustará para obtener el menor movimiento en la dirección del material.

B Parámetros predeterminados
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1 Altura de activación
 La altura por encima del material con movimientos de una herramienta.
2 Velocidad del receptor
 Velocidad con la que la herramienta baja sobre el material.
3 Velocidad de preparación de herramientas
 Velocidad de la herramienta cuando está elevada (no está en contacto con el material).
4 Aceleración
 Aceleración máxima de la herramienta, importante para las esquinas.

C Parámetros predeterminados por objeto

Esta configuración se activa cuando las trayectorias de herramientas no tienen un valor propio en el cuadro de
diálogo de opciones para trayectorias de herramientas. Cuando establece la opción “Utilizar configuración
predeterminada” como falsa.

1 Profundidad
 Profundidad de la herramienta.
2 Velocidad
 Velocidad de grabado/fresado.
3 Motor de herramienta
 Revoluciones de la herramienta por minuto.

D Asignaciones de herramientas
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Puede establecer el número y la posición de una herramienta, si su máquina viene equipada con un cambiador de
herramientas. El software seleccionará la herramienta correcta durante un trabajo.

Configuración de visualización
C o n f i g u r a c i ó n  d e  v i s u a l i z a c i ó n

Para el grabado y el fresado se han agregado dos nuevas calidades de visualización.

“Ver, Calidad, Trayectoria de herramienta”: esta configuración muestra la trayectoria de la herramienta y el sentido
de giro.
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“Ver, Calidad, Trayectoria de herramienta sólida”: esta configuración muestra la trayectoria y la anchura de la
herramienta. Aquí podrá comprobar si los tipos de herramienta y de relleno son los que necesita para el trabajo.

EasySIGN Print Server

EasySIGN Print Server, before you start
E a s y S I G N  P r i n t  S e r v e r ,  b e f o r e  y o u  s t a r t

Before you can start printing with the EasySIGN Print Server, either as stand-alone or as a supplement to EasySIGN,
you have to make some settings. In the following chapters we will explain what each setting does. Before you read
the following chapters, please work through the "Getting Started". As a prerequisite, you have to finish all the steps
that are explained in that manual. The "Getting Started" teaches you the basics of the EasySIGN Print Server. Also all
the necessary license tickets must have been entered, which is also explained in the "Getting Started".

We really can't emphasize enough that you have to finish the "Getting Started" to be able to understand the following
chapters. The EasySIGN Print Server is very easy to use, but you will have to gain some basic understanding first.

Note
If you've downloaded this software as a TryBuy, you can also download the "Getting Started" as a PDF file from the
download menu of http://www.easysign.com.

First use and Main screen
When you start the EasySIGN Print Server for the first time, the main screen will become visible, it will look
something like below. It might happen that you get a Wizard that asks you for a ticket. If so, please refer to the
“Getting Started” that came with the software. 
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Also, if you do not have a printer installed yet, a Wizard will come up to guide you through the procedure of installing
it. This wizard is described in the getting started and this manual assumes you have already installed a printer.

The components of this main screen are as follows. A more detailed explanation of each window will follow in the next
chapter.

Current jobs (A)
In this window all jobs will be placed that have been added, either by using a Hotfolder or by adding it manually. The
list will show a small preview for every job, as well as its name and some extra information. From this list, jobs can
be edited as well as dragged and positioned onto the prints.

Archived Jobs (B)
Once a job has been printed, it will be moved automatically to the archived jobs. This list behaves similarly to the
‘current jobs’ list, so you can place jobs, edited them and remove them. Only the name of the list, ‘Archived jobs’
signifies that the jobs have been printed already.

Installed Devices (C)
In this list, all installed printers will be shown, and you can edit every detail. A printer that is busy will shown a red
line through it, which means that the device cannot be edited at that moment.

Hotfolders (D)
A Hotfolder is a directory that is monitored by the software for files to be printed. By moving a file directly into this
directory, a new job will be created along with some default settings.

Logbook (E)
In the logbook, all significant events that occur in the print server will be shown, like starting and finishing a print, and
any error messages that might occur. The logbook has the option of being e-mailed to any mail account, enabling you
to monitor the progress from a remote location.

Print preview (F)
The most important part of the print server is the print preview which occupies the middle of the screen by default.
This preview shows an empty roll of material, ready for placement of jobs.

Print Properties (G)
This is where most of the interaction with the print server takes place. Here you will set the width and height of the
material, the stacking, start the print etc.
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User interface
U s e r  i n t e r f a c e

The user interface and placement of any window is customisable. Any window can be docked almost anywhere,
simply by clicking on its name, and dragging it to the desired position. By double-clicking on a docked window, it will
be floated above other windows. To dock a floating window, simply drag its title bar to another position. The window
placement will be shown by a blue, semitransparent box, and if it is to your liking, just release the mouse button to
dock the window.

Any Window can have the following situation: 

Floating The window is positioned over other windows, obscuring the underlying interface.
Double click the title of any window to float it.

Docked The window is positioned next to other windows. Drag any window by its title bar to
position it, a blue transparent box will show where it will be docked.

Auto Hide The window will be shown by a tab with its name on the left side of the main
window. By hovering the mouse over this tab, the window will be shown. To use this
feature, click the pin symbol in the title bar.

Hide A window can be closed by clicking the cross in its title bar. To re-enable it, use the
main menu "View > Toolbars" to re-check the menu item.
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It is also possible to change the entire look and feel of the windows in the print server. To do this, use the main menu
command "View > Icon style" and "View > Application look".

And if this does not provide you with enough customization options, you can now also customize the main menu and
toolbars. To do this, right-click the area to the right of the menu, and choose ‘Customize...’ The following dialog will
appear:

Through the tabs in this menu you can customize all menus and toolbars, or even create new ones to your liking. This
manual will not describe every option in detail, feel free to experiment until the interface is to your liking. Most tabs
have a ‘reset all’ button that will restore the original situation.

Working with jobs
W o r k i n g  w i t h  j o b s

The first thing to do when printing something is to add jobs. A job is a single file, like a PDF, JPEG or TIFF file. It has
many properties, which we will discuss in this chapter.

Adding a job
A job can be added in three different ways: by dragging it onto the job list, through the menu item "File > Add job", or
through a hot folder. Hotfolders will be discussed later on, in a separate chapter. 

To drag a file from the Windows explorer to the print server, simply drag and drop it onto the ‘job list’ or ‘Archived job
list’, like shown here:
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Or, click the main menu and go to "File > Add Job". Then, browse to the file you want to print and click it.

After a file has been added, a job will appear for it in the job list. The print server will then start to create a preview
for it, and collect some information like the size of the job and the number of pages.  It might be that the job does not
display a preview right away, as this process takes some time on larger jobs. During previewing, the job cannot be
edited, so please be patient.

After a while, the job will show ‘ready for printing’, and it will then be editable. To edit the job double-click it, or click
the edit icon.

which will show the following dialog:
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Options

A Nr of copies
How many times the current job should be repeated on the print.

B Print extra info
Select yes if you want extra info on the final print. This prints the setting, device, etc. at the bottom of
the print.

C Print cropmarks
Selecting Yes enables cropmarks on the final print.

D Cropmark type
Choose form ‘cropmarks’, ‘cropmarks and swatch bar’, or ‘Rulers’. If you are using paneling, you
should select ‘Rulers’, which will help you align the panels.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Size  -  R o ta tion

A Width
The width of the current job in units. To change, type a number or use the spin buttons.

B Height
The height of the job in the currently active units.

C Width scale
The current width as a percentage of the original file size.

D Height scale
The current height as a percentage of the original file size.

E Scale proportionally
When ticked, the width and height of the job change proportionally.

F Rotation
Select the desired rotation in 90 degree steps from the combo box.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Pa ne ling

A Paneling type
You can choose between ‘None’ and ‘User defined’, User defined switches the paneling to on.

B Number of panels
By changing this number, the job will automatically be divided in the specified number of panels.

C Carriage Panel size
Vertical panel line(s) in the preview. Type the positions where you want the panel lines to appear, for
example ‘50 100 150’.

D Carriage panel overlap
The overlap of the panels, these can also be negative. You can enter one value, which sets the overlap
for all panels, or multiple values if you want different overlaps. If you enter nothing or ‘0’ there will be
no overlap.

E Roll Panel Size
The position(s) of the panel lines in the roll direction.

F Roll panel overlap
The overlap of the panels in the roll direction.

G Active panels
If empty all the panels will be printed. When you enter one or more panel numbers separate by e white
space only these panels will be printed.

H Paneling In the preview window
You can manually add or remove panels by pressing the right mouse button in the preview window and
selecting a horizontal or vertical panel line from the menu. A double click will add a carriage panel line,
if you hold down the SHIFT key before double clicking, a roll panel will be added.

E Cropmark size
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The size, around the print, of the printed cropmarks.

Co lo r  co rre ction
All the different color corrections will be applied on top of the color management. As with all settings, you can see the
result in the preview window. This might take a few seconds, especially when the job file is large.

A Brightness
The brightness of the job, ranges from -100 to +100.

B Contrast
The contrast of the job, ranges from -100 to +100.

C Saturation
The saturation of the job, ranges from -100 (no color at all) to +100 (very bright color).

D Hue
The hue (color shift) of the job, ranges from -180 to +180.

E Color temperature
The temperature (‘warmth’) of the job, ranges from -4000K (very warm) to +4000K (very cold).

F Grayscale
Tick this box if you want the entire job to output in grayscale.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Input ICC pro file
The following settings are color management related, and this manual is not intended as a complete guide. For a more
complete explanation of color management, see also the document “Calibration training”.

A CMYK bitmap input profile
A combo box from which you can select the desired input profile for CMYK bitmaps. All profiles on your
system, including the profiles from the EasySIGN "Shared" directory, are listed here.

B RGB bitmap input profile
A combo box from which you can select the desired input profile for RGB bitmaps.

C Grayscale bitmap input profile
A combo box from which you can select the desired input profile for Grayscale bitmaps.

D Bitmap render intent
The render intent for bitmaps. You can choose from the following:

Pe rce ptua l
All colors in a device’s gamut will be scaled to the output gamut, keeping the relation between the
colors intact. This method is recommended for reproducing scanned or imported bitmaps.

R e la tiv e  co lo r im e tr ic
This method will leave colors that fit into both gamut’s intact. Colors outside of the gamut of the output
device will be adjusted to fit, preserving brightness and color at the expense of saturation. This method
is preferred if accurate color representation is necessary, for example when printing spot colors.

Sa tura tion
Scales the source gamut to the destination gamut but preserves relative saturation instead of hue, so
when scaling to a smaller gamut, hues may shift. This rendering intent is primarily designed for
business graphics, where bright saturated colors are more important than the exact relationship
between colors.
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Abso lute  co lo r im e tr ic
Absolute colorimetric rendering reproduces in-gamut colors exactly, and clips out-of-gamut colors to
the nearest reproducible hue, sacrificing saturation and possibly lightness. This method also takes the
color of the paper into account when printing.

E Color manage CMYK bitmaps
Whether or not CMYK bitmaps should be color managed.

F Use embedded profiles when available
Whether or not you want to use the profile that was included in the source file for a job.

G CMYK vector input profile
A combo box from which you can select the desired input profile for CMYK vector data.

H RGB vector input profile
A combo box from which you can select the desired input profile for RGB vector data.

I Grayscale vector input profile
A combo box from which you can select the desired input profile for Grayscale vector data.

J Vector render intent
The render intent for vector data, see the description under "Bitmap render intent" for
the available types.

K Color manage CMYK vector
Whether or not CMYK vector data should be color managed.

L Suppress dirty Cyan
If enabled, dirty cyan is suppressed. use this if you want cyan to be printed as cyan, even after color
managing.

M Suppress dirty Magenta
If enabled, dirty magenta is suppressed.

N Suppress dirty Yellow
If enabled, dirty yellow is suppressed.

Working with Hotfolders
W o r k i n g  w i t h  H o t f o l d e r s

First of all what is a Hotfolders? A Hotfolder is a directory on your hard disk or network that represents a set of default
settings. By copying a job into a Hotfolder, the new job will be set up the same way as the Hotfolder, and then it will
be added to the job list, ready for printing. So if want to set up a way to print something that is always mirrored, or at
200% by default, a Hotfolder would be the way to do it.

Also, if you want to print something directly from the EasySIGN design software to the Print Server, a Hotfolder is
necessary to store the exported print job.

Adding a Hotfolder
To add a Hotfolder, first you have to find the window labeled Hotfolders. If it is not visible, just go to "View >
Toolbars" and make sure that ‘Hotfolders’ is ticked.

The Hotfolders window has the usual three-button icons, to add, remove and edit the Hotfolders that have been set.
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By clicking the ‘add’ button, a wizard will come up that guides you through the
process of installing a new Hotfolder.

Step 1. Choosing a device and a setting
Any Hotfolder will mark the incoming files with a device and setting, meaning that the jobs are intended to be printed
on the selected device and setting.

Please be aware that a Hotfolder is just a set of defaults. Any job that comes in through the Hotfolder, gets the same
setting but everything can be changed of course before committing to printing.

Check that you have chosen the correct printer and setting, and click ‘Next’ to continue. In the next page of this
Wizard, there is one important setting, the ‘Root directory’. You should choose one root directory and place all hot
folders in it. The root directory can then be shared over the network, for other computers to use.
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There are some extra settings to be made in this dialog:

A Input file processing
When you place a file in a Hotfolder it will be processed. When processing is done, you can choose
whether to remove the file or move it to a subdirectory called ‘Processed’ or ‘Error’.

B Job Processing
When a job has been printed, you can choose whether you want to keep it in the Archive. The following
choices exist:

R e m ov e
When the job has been printed, it will be removed immediately.

Archiv e  a s  spa ce  a llows
The job will be put in the archive, but it will be removed automatically if the software runs out of disk
space.

Archiv e  inde fin ite ly
The job is kept in the archive until removed by the user.

When you click ‘Finish’, your Hotfolder will be added and it will shown in the list.

Setting up Hotfolders
Every hot folder can have its own default settings, making it very easy to create Hotfolders, not only for every type of
material, but even for customer based hot folders. 
Make the default settings once, give it an appropriate name, very handy for returning jobs. Remember that these
settings are only defaults: an incoming job can always be changed before printing it. 

Editing the settings of a Hotfolder can be done in the following way: select the
Hotfolder itself, then click the ‘edit’ icon in the top of the toolbar.

The following dialog will appear:
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On the left side of the dialog are three icons that activate the following three tabs:

Hotfolder properties

A Name
The name and directory of this Hotfolder. You should change the name in something meaningfull.

B Folder
The actual directory that gets monitored for new files coming in. You can change this directory by
clicking the ‘Browse’ button on the right.

C Folder is active
Activates or de-activates the Hotfolder.

D After rendering
For some files, the RIP will render them, after which the original file will no longer be necessary, and
can be removed. Use ‘remove’ if you copy original files into the Hotfolder. Use ‘Move to processed’ if
you want to keep the original files for some reason. The file will then be moved to the ‘Processed’
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directory which is created in the Hotfolder directory.

E If an error occurs
Same as above, except the input file will be moved to the ‘error’ directory or deleted if it generates an
error while rendering.

F Job processing
When a job has been printed, it will be automatically moved to the job archive, where it will stay.

G Output settings
The default printer and setting that this job is meant to be printed with.

H Nr of copies
Number of times the job will be placed when dragged onto a print.

Sizing and paneling
This page gives you the opportunity to set up an incoming job for the correct size and paneling options. These settings
are similar in their function to the settings on an individual job, so please refer to the previous chapter on working
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with jobs for a more elaborate description.

Input profiles and color management
Again, these settings are the default settings for color management on the jobs that come in on this Hotfolder. As they
are similar to the settings on an individual job, please refer to the previous chapter on jobs for a detailed description
on how they work.

After pressing "OK" the Hotfolders tab will look like below:



367EasySIGN

Working with prints
W o r k i n g  w i t h  p r i n t s

This is where it all comes together: a print is the centre where you place the individual jobs, arrange them, and send
them to your printer. The prints are shown like below:

A Print view
This view shows the print as it is going to come out of your printer: a long roll of material, which is
empty for now. To place jobs, you can simply drag them from the job list onto the print. If the job has
paneling activated, this will automatically show when dragging the job.

The print view has a number of drag able items itself:

Ma te r ia l s ize (B)
By dragging the small arrow on the lower right of the print view, the material size can be adjusted.

Ma rg ins (C)
The front end of the material, as well as the left and right side, can be dragged to set a margin. This
margin will be used when automatically placing items with the ‘stacking method’ option enabled.

Viewing around the print view can be done with the scrollbars around it, or by using the toolbar above it. The function
of the individual buttons are: 
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Wireframe
Shows placed jobs as a wireframe, with information as text.

Filled
Shows the jobs as a color preview.

Zoom sheet
Shows the entire length of the print, including empty space.

Zoom front
Shows the first side of the print, zoomed to maximum width.

Zoom jobs
Shows everything (every job) that has been placed on the print.

Select mode
Click this button to be able to select and move jobs.

Zoom in
Click this button, then drag across the print view to zoom to a specific area.

Zoom out
This button instantly zooms the view out by a predetermined amount.

Drag view
Activate this button, then click and drag to move the print view.

There can be an unlimited amount of individual prints at the same time, which enables you to work on a new print
while a previous one is processing. To do this, look at the top of the print where you will find a tab bar with the name
of your current print.

After adding a new print, just click back and forth between them to bring them to the front. The X in  prints name lets
you close and delete them, of course this will only work if the print is not being processed just yet.

When you create more than a few prints, they cannot be displayed all at the same time. In that case, a small arrow
on the right shows a menu of all available prints.

Print properties bar
On the right side of the print view you will find a large toolbar which enables you to control the active print. It has the
following options:
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A Device
The specific printer that this print will appear on.

B Setting
The setting you want to use for this device.

C Device mode
There are five different device modes available, hover the mouse over the icons to see a description:

Pr int

This is the default, it only prints even if cutline's are available.

Pr int a nd  cut

Immediately after printing, the job is also cut. Only available on Print & Cut hybrid machines.

Pr int & cut –  pr int only
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This will print a job with cropmarks, ready to be re-inserted on cut. Available on Print & Cut hybrid
machines only, and used in case you would want to laminate a Print & Cut job before cutting it.

Pr int & cut –  cut only

This will cut a print & cut job on a hybrid machine.

Cut only

This cuts a job on a hybrid print & cut machine without printing anything.

Be aware that the Print & Cut modes are only used on hybrid machines, meaning printers with an
integrated cutter. Please refer to the manual that can with the printer for the correct workflow.

Print & Cut workflows that use a separate cutter and printer can of course also be processed, however
the print server treats these as a normal print job (with crop marks of course) and they would be
printed in the default ‘print’ mode.

D Roll width/length
The size of the material in the printer. This size can also be changed by dragging the small black arrow
on the lower right of the print view.

E Stacking method
When placing jobs, it is possible to align the jobs automatically, a process called ‘nesting’. There are
three options available:

Sim ple

All jobs will be placed after each other, no other optimization Is performed.

Jobs  toge the r

Multiple copies of a job will be nested, but they will not be mixed with other jobs.

Sa v e  m a te r ia l

An optimal placement of jobs will be made, mixing copies of jobs and panels if necessary.

The selected stacking method will be shown by these buttons. However, when you move a job
manually, the stacking switches off and no automatic placement will be performed, until you click one
of these buttons again.

F Alignment

All stacking methods can have a left, middle or right alignment.  Click one of these buttons to choose,
the default is right-alignment.

G Margin
The distance between stacked jobs.

H Confidence strip
A strip can be enabled on the left and/or right side of the print. Enabling this ‘exercises’ the print heads,
which might help to keep open all inks in a print head. Width can be adjusted.

I Margins
A left, right and front margin can be entered here, this enables you to keep some extra material
around the print itself. This can be handy when doing Print & Cut for example.

J Number of copies
The number of times this print will be printed.

Print buttons
There are several ways of starting a print, you can choose to start printing right away, or to be a bit more careful and
render a print first. The buttons have the following functions:
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K Print now
Starts rendering, and as soon as a small portion of the render is ready the print will start. This can be
used when you have a fast computer and you know for sure that the computer can keep up with the
printer.

L RIP, then print
This renders the print data first, and when everything is ready the print will automatically be started.
Can be used on slower computers to make sure the printer will never need to wait.

M RIP only
Renders all data, but w ill not print until ‘Print now ’ is clicked.

N Triggers
It is possible to start any print that you have set up at a specific time. When you click the ‘Triggers’
button a new dialog appears:

Sta rt a t a  spe cific da te  a nd  tim e  (A)
This enables you to start the current print when you are away, for example when you want to print
during the night.
 
Sta rt whe n le ngth m ore  tha n (B)
This starts a print when there are enough jobs available.

Sta rt whe n e fficie ncy  m ore  tha n (C)
This starts the job when the stacking has produced a print with high enough accuracy.

Archive

Archive
A r c h i v e

Archive es una utilidad diseñada especialmente para EasySIGN. Este programa ayuda a gestionar las hojas de
trabajo de EasySIGN y la base de datos de clientes. En EasySIGN podrá guardar hojas de trabajo por cliente. En
Archive podrá abrir, importar, gestionar y procesar datos del cliente, etc.

Primera versión 
Si nunca ha tenido una versión de Archive en su ordenador antes, aparecerá un "Asistente" que le ayudará a
inicializar el programa.
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En el diálogo inicial del "Asistente", se explican los pasos a seguir. Deberá decidir en qué modo va a ejecutar Archive;
esto depende de si trabaja en una red. También debe especificar la ubicación en la que desea que Archive guarde las
hojas de trabajo que ha creado con EasySIGN. Siempre podrá llamar a este "Asistente" cuando haya inicializado el
programa. Si lo hace y ya tiene un directorio Archive y hojas de datos de EasySIGN, se recomienda crear una copia
de seguridad antes de continuar con el "Asistente". Si todo está claro puede hacer clic en el botón "Siguiente" (2)
para continuar.

En la siguiente pantalla del "Asistente" puede elegir los "modos" en los que desearía trabajar.

4 "Independiente"
 Utilice este modo si no trabaja en red o si no utiliza la red, cuando el programa se utiliza en un solo ordenador.
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5 "Servidor PTP"
 Este es el caso cuando el ordenador en el que trabaja es un servidor y además estación de trabajo.
6 "Configuración DS"
 Esta es la opción si va a utilizar un "servidor de ficheros".
7 "Cliente"
 Esta la opción si ya utiliza un "servidor de ficheros”.

 

Los distintos modos
L o s  d i s t i n t o s  m o d o s  

Independiente
Si ha elegido esta opción en el "Asistente", después de hacer clic en el botón "Siguiente", aparecerá la siguiente
ventana.

4 En este campo se mostrará la trayectoria del directorio estándar de Archive. Se recomienda utilizar esta
trayectoria. Si desea especificar una trayectoria distinta, puede hacerlo escribiendo el nombre de la trayectoria
o localizando un lugar distinto con el botón "Examinar" (5).

Servidor PTP
Elija esta opción si la red en la que trabaja no tiene un "servidor de ficheros dedicado". Uno de los ordenadores de la
red se comporta como servidor.
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4 En este campo debe escribir la trayectoria al directorio de Archive o encontrar la ubicación utilizando el botón
"Examinar" (5) .

6 Si el directorio Archive está en la unidad C, debe especificar aquí cómo se comporta la unidad C en la red.

S Servidor/Estación de trabajo
 En este ordenador se lleva a cabo la configuración PTP. Contiene la carpeta "Archive" para las demás

estaciones de trabajo (C) y una versión de trabajo de Archive.
C Estación de trabajo 
W En las estaciones de trabajo se ejecuta la "Configuración de cliente" de Archive y la carpeta compartida (A) del

servidor (S) se utiliza como origen. 

Configuración DS
Se utiliza esta opción si la red tiene un "servidor de ficheros dedicados ", como por ejemplo un servidor NT. Las hojas
de trabajo se guardan centralmente en este servidor.
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4 En este campo debe escribir la trayectoria al directorio Archive o encontrar la ubicación utilizando el botón
Examinar (5).

S Servidor
C Estación de trabajo
W En una de las estaciones de trabajo se ejecuta la "Configuración DS" y el servidor (S) se especifica como el

origen para la carpeta "Archive" (A). Este ordenador es también un "cliente". En las demás estaciones de
trabajo, se ejecuta una "Configuración de cliente" de Archive y la carpeta compartida (A) del servidor (S) se
utiliza como origen. 

Configuración de cliente
Esta opción utilizará una unidad que ya contiene las carpetas y supone que la opción "Configuración DS" o
"Configuración PTP" ya ha sido ejecutada en un ordenador distinto.
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4 En este campo debe escribir la trayectoria al directorio Archive o localizar la ubicación utilizando el botón
Examinar (5).

Después de completar las configuraciones necesarias tendrá que hacer clic en el botón "Terminar" (2).

El entorno de trabajo
E l  e n t o r n o  d e  t r a b a j o  

Cuando haya abierto Archive  la pantalla mostrará lo siguiente. Si durante la configuración de EasySIGN ha elegido
instalar los ejemplos, estos se colocarán en Archive, en un cliente utilizado como ejemplo.
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1 El menú
 Todas las opciones del menú se comentan en detalle más adelante.
2 La barra de herramientas
 Aquí encontrará los comandos de menú utilizados con más frecuencia, a los que se accede directamente

mediante un botón.
3 Ventana de descripción general
 Aquí encontrará todos los clientes, representados en una estructura de árbol.
4 Ventana de información
 Aquí encontrará los datos de clientes o vistas de las hojas de trabajo de clientes.
5 Barra de estado

 

El menú
E l  m e n ú  

Cliente

Encontrará que este menú es el mismo que el que aparece al pulsar con el botón derecho del ratón en cada una de
las zonas de la estructura de árbol.

Nuevo (CTRL+N)
Dependiendo de lo que haya seleccionado en la estructura de árbol, se colocará un nuevo cliente en un determinado
nivel. Si ha seleccionado por ejemplo "raíz", podrá crear un grupo llamado "Clubes de fútbol". Si a continuación
selecciona la nueva carpeta "Clubes de fútbol" y hace clic otra vez en "Nuevo", el nuevo cliente/carpeta se añadirá
bajo "Clubes de fútbol". De esta forma puede crear categorías para todos los clientes por tipo de trabajo.

Eliminar (Supr)
Este comando elimina una carpeta seleccionada. Sin embargo, si aún hay hojas de trabajo en la carpeta de este
cliente, sólo podrá borrar el cliente después de haber borrado las hojas de trabajo.

Editar/Leer solamente
Cuando selecciona el submenú "Editar", podrá modificar los datos del cliente. En el momento que modifique los datos
del cliente la base de datos queda bloqueada para el resto de usuarios. Esto se hace para asegurar que dos personas
no puedan editar de forma simultánea los datos del cliente. Otro usuario podrá abrir hojas de trabajo, pero no podrá
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modificar los datos del cliente. Para desbloquear el registro nuevamente debe seleccionar el submenú "Leer
solamente". Si no se lleva a cabo ninguna opción después de cinco minutos, la base de datos se desbloquea
automáticamente y podrá ser utilizada por los demás usuarios.

Buscar
Este comando abre un cuadro de diálogo que permite buscar un cliente existente.

1 Buscar
 Aquí puede poner el criterio de búsqueda.
2 Consultar
 Aquí puede especificar en qué campos se va a buscar.
3 Resultado de la búsqueda
 Aquí se muestran los resultados de la búsqueda. Al hacer clic en alguna parte de esta lista, el archivo se

convertirá en un archivo activo.
4 Búsqueda
 Esta opción inicia la búsqueda.
5 Cerrar

Cerrar
Este comando cierra el programa.

Editar

Deshacer
Cuando se está en el modo de modificación, el registro actualmente editado se recupera de forma completa.

Eliminar
Este comando elimina las hojas de trabajo seleccionadas.

Seleccionar todo
Este comando selecciona todas las hojas de trabajo del cliente que han sido abiertas.

Invertir selección
Este comando invierte la selección ya realizada.

Cambiar nombre
Este comando permite cambiar el nombre del cliente seleccionado en la estructura de árbol.

Ver

Barra de herramientas
Muestra u oculta la barra de herramientas.

Barro de estado
Muestra u oculta la barra de estado.
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Datos del cliente
Activa los datos del cliente en el campo de información.

Iconos grandes
Muestra las hojas de trabajo disponibles en la ventana de información como iconos grandes con el nombre de archivo
correspondiente.

Iconos pequeños
Todas las hojas de trabajo aparecen con un icono pequeño.

Lista
Las hojas de trabajo se muestran como una lista.

Detalles
Se da información adicional sobre las hojas de trabajo, como la fecha en que se modificó la hoja de trabajo por
última vez.

Previsualización
Todas las hojas de trabajo se muestran como una ilustración de la hoja de trabajo.

Actualizar (F5)
Este comando actualiza la ventana.

Herramientas

Modo Asistente
Este comando abre el modo asistente como se describió anteriormente en la sección "Primera versión".

Copia de seguridad
Este menú le ofrece sugerencias sobre las copias de seguridad.

Ayuda
En este menú encontrará toda la ayuda necesaria y el manual digital.

Ventana de información
V e n t a n a  d e  i n f o r m a c i ó n  

En esta ventana encontrará todas las hojas de trabajo que pertenecen a un cliente en particular. Desde aquí puede
gestionar las hojas de trabajo.
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Podrá seleccionar varias hojas de trabajo al mismo tiempo utilizando la tecla Control para eliminar estas hojas de
trabajo, por ejemplo o para importarlas en EasySIGN. Si ha seleccionado una hoja de trabajo, podrá hacer clic en
ella una vez con el botón derecho del ratón para llamar al menú del botón derecho del ratón de la hoja de trabajo.
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En este menú desplegable oculto encontrará los siguientes comandos.

1 Abrir
 Este comando abrirá la hoja de trabajo seleccionada en EasySIGN. Si EasySIGN no está ya abierto, se abrirá

automáticamente. Esta función puede ser activada haciendo doble clic en la hoja de trabajo.
2 Importar
 Este comando importa la hoja de trabajo en la hoja de trabajo activa en EasySIGN.
3 Eliminar
 Este comando elimina las hojas de trabajo seleccionadas. Si ha eliminado de forma accidental una hoja de

trabajo que no quería eliminar, puede utilizar la papelera de reciclaje de Windows™ para recuperar el archivo.

Si Archive no encuentra el programa EasySIGN aparecerá un mensaje preguntándole si desea especificar la ubicación
del programa. Si elige "Sí", aparecerá un cuadro de diálogo que le permitirá localizar el programa.

Mover todos los archivos 

Si desea mover el archivo a otra unidad, cierre Archive 32 y mueva el directorio completo “Archive" a la nueva
ubicación. Reinicie Archive y se le pedirá que especifique la base de datos nuevamente. Especifique una nueva
ubicación y todas las referencias se adaptarán de forma automáticamente.

Arrastrar y soltar 

Desde Archive puede arrastrar un archivo al Explorar y viceversa. También podrá arrastrar un archivo directamente
desde Archive a EasySIGN; cuando lo suelte este archivo será abierto o importado.
En Archive puede cambiar copiar archivos de un cliente a otro arrastrándolos, si utiliza la tecla Mayúsculas durante el
arrastre podrá mover el archivo (o archivos).
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Archive a través de EasySIGN
A r c h i v e  a  t r a v é s  d e  E a s y S I G N

Podrá archivar sus hojas de trabajo mediante el menú "Archivo" de EasySIGN. Hay tres formas de hacerlo.

1 Archivar
 Cuando haya abierto una hoja de trabajo este comando guardará cualquier modificación.
2 Archivar como...
 Este comando abre un cuadro de diálogo y le pregunta si desea guardar un archivo o una hoja de trabajo

nueva con un nombre distinto o en un cliente diferente.
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En la lista que hay debajo (1) podrá ver los clientes en Archive y en (2)  podrá ver cierta información sobre el cliente
seleccionado. En el campo (3) podrá especificar el nombre de la hoja de trabajo y hacer clic en Aceptar. La hoja de
trabajo será guardada en la carpeta de cliente seleccionada. 

Clientes recientes
C l i e n t e s  r e c i e n t e s

Se ha agregado al menú "Archivo" una lista con los diez clientes más recientes. Si administra un gran número de
clientes con la ayuda de Archive, esta es una forma muy útil de evitar tener que buscar los clientes activos actuales
inspeccionando los registros o utilizando constantemente el comando de búsqueda.

Sugerencia de copia de seguridad
S u g e r e n c i a  d e  c o p i a  d e  s e g u r i d a d

La copia de seguridad en sí normalmente no es el problema, sin embargo, sí lo es a menudo saber cuándo hacer la
copia de seguridad y de qué. Archive proporciona una forma de determinar el momento en el que es necesaria una
copia de seguridad para los archivos de EasySIGN y Archive. Estos son normalmente todos los archivos clave de
EasySIGN y Archive que normalmente no deberían reemplazarse al reinstalar: archivos ejecutables agregados
manualmente, hojas, tablas de colores personales, etc.

Puede obtener acceso al cuadro de diálogo para esta operación a través de la opción Sugerencia de copia de
seguridad del menú "Ayuda ".
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1 Archivos de los que desea hacer una copia de seguridad 
 Proporciona una lista de todos los archivos de los que se va a hacer una copia de seguridad.
2 Mostrar sólo carpetas
 Al activar esta opción, sólo se mostrarán las carpetas que contengan los archivos de los que se va a hacer una

copia de seguridad.
3 Imprimir
 Este botón abre un archivo de texto con todos los archivos del cuadro de diálogo.
4 Cerrar
 Cierra el cuadro de diálogo.

Buscar hojas
B u s c a r  h o j a s

Este comando inicia una búsqueda de hojas en todas las unidades del disco duro y conexiones de red EasySIGN. La
selección realizada en el resultado de la búsqueda puede agregarse como un nuevo cliente. Puede iniciar esta
búsqueda a través del cuadro de diálogo que aparece al ejecutar el comando "Buscar hojas" del menú "Adicional".

Puede utilizar el botón "Cancelar" para suspender la búsqueda. Cuando haya terminado la búsqueda en todas las
unidades y conexiones de red se abrirá otro cuadro de diálogo en el que se mostrarán todas las carpetas que
contienen hojas de EasySIGN (nuevas y antiguas).
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En este cuadro de diálogo puede hacer una selección y agregar las nuevas elecciones como nuevos clientes a la base
de datos de Archive.

Mover clientes
M o v e r  c l i e n t e s

El campo situado a la izquierda de Archive permite mover clientes a una ubicación diferente de la base de datos. La
ubicación situada fuera de las hojas y carpetas de la unidad de disco duro no cambia después de mover un cliente.
No es posible copiar clientes a una ubicación diferente.



386 EasySIGN

Previsualizaciones
P r e v i s u a l i z a c i o n e s

Si desea que Archive no sólo muestre las hojas estándar, sino también las hojas que se pueden previsualizar en el
Explorador de Windows™, puede activar la opción de menú "Ver, Mostrar todas las previsualizaciones".

Renuncias

Renuncias
R e n u n c i a s

Copyright ©2012 NCD Holding b.v. Reservados todos los derechos.

Queda prohibida la reproducción y transmisión de este documento por cualquier medio y en cualquier
formato, ya sea impreso, microfilmado, grabado, en formato electrónico o de cualquier otro modo, así como
su almacenamiento en un sistema de recuperación o cualquier otro soporte, sin el consentimiento previo
por escrito de NCD Holding b.v.

El software descrito en esta publicación está protegido mediante licencia y únicamente podrá copiarse y
utilizarse de conformidad con las condiciones generales de NCD Holding b.v.

Disposiciones y garantías

La información contenida en esta publicación es exclusivamente para uso informativo y está sujeta a
cambios sin previo aviso. No podrá interpretarse como una obligación por parte de NCD Holding b.v.

ESTA PUBLICACIÓN ES EXCLUSIVAMENTE PARA USO INFORMATIVO SIN GARANTÍA ALGUNA, EXPLÍCITA NI
IMPLÍCITA, LO QUE INCLUYE SIN QUE SIRVA DE LIMITACIÓN LAS GARANTÍAS IMPLÍCITAS DE
COMERCIABILIDAD Y ADECUACIÓN PARA CUALQUIER PROPÓSITO CONCRETO.

NCD HOLDING B.V. NO ACEPTA NINGUNA RESPONSABILIDAD NI OBLIGACIÓN POR LOS ERRORES O LAS
AFIRMACIONES CONTENIDOS EN ESTA PUBLICACIÓN NI EN NINGUNO DE LOS DOCUMENTOS A LOS QUE SE
HAGA REFERENCIA EN ELLA.

LAS REFERENCIAS A EMPRESAS, SUS SERVICIOS Y PRODUCTOS SE REALIZAN SIN GARANTÍA ALGUNA,
EXPLÍCITA NI IMPLÍCITA. EN NINGÚN CASO SERÁ RESPONSABLE NUMERICAL NCD HOLDING B.V. POR
NINGÚN TIPO DE DAÑOS, YA SEAN ESPECIALES, CONSECUENTES, ACCIDENTALES O INDIRECTOS, LO QUE
INCLUYE, SIN QUE SIRVA DE LIMITACIÓN, LOS DAÑOS POR PÉRDIDA DE BENEFICIOS DE NEGOCIO, LA
INTERRUPCIÓN DE LA ACTIVIDAD COMERCIAL, LA PÉRDIDA DE INFORMACIÓN EMPRESARIAL, O CUALQUIER
OTRA PÉRDIDA ECONÓMICA, FINANCIERA O DEL TIPO QUE SEA QUE PUEDA DERIVARSE DEL USO O DE LA
INCAPACIDAD DE USO DEL SOFTWARE PROVOCADOS POR EL USO COMBINADO O EXCLUSIVO DE ESTA
PUBLICACIÓN.

Esta publicación puede contener imperfecciones técnicas o de otro tipo, así como errores tipográficos.
Periódicamente se agregan cambios a la información contenida en la presente; estos cambios se
incorporan a las nuevas ediciones de esta publicación. NCD Holding b.v. puede implementar cambios o
mejoras en los productos y los programas descritos en esta publicación en cualquier momento sin previo
aviso.

EasySIGN es una marca registrada o una marca comercial de NCD Holding b.v.
Todas las demás marcas y nombres de productos son marcas comerciales, marcas registradas o marcas de
servicios de sus respectivos propietarios.

Producto de Países Bajos.
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